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1 Einleitung 

1.1 Programmbeschreibung 

«IC Net 2.2» ist der Name der PC-Software zur Steuerung und 
Auswertung von Ionenchromatographie-Systemen mit Metrohm- 
und Bischoff-Geräten. Die vorliegende Version ist eine 32-Bit 
Applikation, die unter Windows 2000 und Windows XP läuft. 

Mit dem Programm «IC Net 2.2» können Systeme zur Aufnahme 
und Auswertung von Chromatogrammen erstellt werden. Zusätz-
lich können Zeitprogramme eingegeben werden, mit denen für 
jeden Programmschritt eine grosse Anzahl Gerätefunktionen aus-
gelöst werden können. Zudem ist es über eine "Remote“-Schnitt-
stelle via programmierbare Signale möglich, beliebige externe 
Geräte zu steuern.  

Die Bedienungssoftware erfüllt alle Anforderungen, die heute an 
eine moderne Integrationssoftware gestellt werden: Ein- oder 
Mehrpunktkalibrierung, interner oder externer Standard, wählbare 
Algorithmen für nichtlineare Kalibrierung, vielfältige Integrations-
modi mit wählbaren Parametern und Integrations-Ereignissen, 
verschiedene Verfahren zur Peakerkennung, Peakeditor, freie 
Skalierung, Übereinanderlegen mehrerer Chromatogramme, Ar-
beiten mit Probentabellen, Nachbearbeitung von Chromatogram-
men, leistungsfähiger und GLP-konformer Reportgenerator mit 
Ausgabeschnittstellen für Bildschirm, Drucker und externe Daten-
banken. 

«IC Net 2.2» kann so konfiguriert und betrieben werden, dass die 
Anforderungen der U.S. Food and Drug Administration (FDA) in 
Bezug auf Datensicherheit und Datenrückverfolgbarkeit gemäss 
21 CFR Part 11 erfüllt werden. Dazu sind im Programm Pass-
wortschutz, Anwenderverwaltung, elektronische Unterschriften, 
Audit Trail und datenbankmässige Verwaltung von Methoden und 
Resultaten integriert. Um «IC Net 2.2» gemäss 21 CFR Part 11 
nutzen zu können wird das Betriebssystem Windows 2000 oder 
Windows XP mit NTFS File-System benötigt. 
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1.2 Angaben zur Gebrauchsanweisung 

Die vorliegende Software-Gebrauchsanweisung 8.110.8261 
gibt einen umfassenden Überblick über die Bedienung des Pro-
gramms «IC Net». Die Gebrauchsanweisung weist folgenden Auf-
bau auf: 

Kapitel 1 Einführung 
Installation 

Kapitel 2 Wesentliche Punkte der Bedienung 
Programmelemente und -merkmale 

Kapitel 3 Software-Einstellungen 
Schriften, Sicherheitssystem, globale Einstellungen 

Kapitel 4 Systeme 
Erstellen von neuen Systemen,  
Interfaces, Geräte, Bestimmungen 

Kapitel 5 Interfaces 
Installation, Steuerung und Parametereinstellungen 
für Interfaces 

Kapitel 6 Geräte 
Installation, Steuerung und Parametereinstellungen 
für Geräte 

Kapitel 7 Methoden 
Methodenparameter, Integration, Kalibrierung, Ge-
haltsberechnung, Report 

Kapitel 8 Chromatogramme 
Chromatogrammdarstellung, Peak-Editor 

Kapitel 9 Probentabelle  
Abarbeitung von Probeserien, Tabellen-Editor 

Kapitel 10 Nachbearbeitung 
Nachbearbeitung von Chromatogrammen 

Kapitel 11 Anhang 
Softwarelizenz, Konformitätserklärung, Bestellbe-
zeichnungen, Index 

Um die gewünschte Information über die Geräte zu finden, benut-
zen Sie mit Vorteil entweder das Inhaltsverzeichnis oder den 
am Schluss aufgeführten Index. 

Diese Software-Gebrauchsanweisung beschreibt nur die Installa-
tion und Bedienung von Metrohm-Geräten. Für Details zur Be-
dienung von Bischoff-Geräten verweisen wir auf die On-line-Hilfe 
im Programm und die Bischoff-Gebrauchsanweisungen.  

Zusätzliche Publikationen zu ionenchromatographischen Analy-
sen können durch die zuständige Metrohm-Vertretung kostenlos 
angefordert werden. Die Metrohm-Monographie 8.732.2001 
"Ionenchromatographie" enthält neben einer Einführung in die 
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theoretischen Grundlagen auch allgemeine Hinweise zu Trenn-
säulen und Probenvorbereitung.  

Die IC-Applikationssammlung 8.732.2013 enthält alle Appli-
cation Notes zum Thema Ionenchromatographie. Durch Herun-
terladen der neuesten Applikationen aus dem Internet unter 
«www.metrohm.com» kann die Applikationssammlung jederzeit 
aktualisiert werden. Detaillierte Informationen zu den von Metrohm 
erhältlichen Trennsäulen und zu speziellen IC-Applikationen fin-
den Sie in den entsprechenden "Application Bulletins". 

1.3 Notation und Piktogramme 

In der vorliegenden Gebrauchsanweisung werden folgende Nota-
tionen und Piktogramme (Zeichen) verwendet: 

Range Menüpunkt, Parameter oder Eingabewert 

SYSTEM STATE Programmfenster 

<OK> Knopf, Schaltfläche 

[ Ctrl ] Taste 

 

Gefahr/Warnung 
Dieses Zeichen weist auf eine mögliche 
Lebens- oder Verletzungsgefahr für den 
Anwender und auf eine mögliche 
Beschädigung von Geräten oder Geräteteilen 
durch elektrische Spannungen hin. 

 

Gefahr/Warnung 
Dieses Zeichen weist auf eine mögliche Le-
bens- oder Verletzungsgefahr für den An-
wender und auf eine mögliche Beschädigung 
von Geräten oder Geräteteilen hin. 

 

Achtung 
Dieses Zeichen markiert wichtige Informatio-
nen. Lesen Sie zuerst die zugehörigen Hin-
weise, bevor Sie weiterfahren. 

 

Anmerkung 
Dieses Zeichen markiert zusätzliche Informa-
tionen und Ratschläge. 
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1.4 Installation 

1.4.1 Hardware-Voraussetzungen für den PC 

Computer Pentium III mit 450 MHz oder höher 
Betriebssystem Windows® 2000 und Windows® XP 
Benötigter Speicherplatz 12 MB für Programm-Files 

50 MB empfohlen für Daten-Files 
Arbeitsspeicher RAM 128 MB für Windows 2000 

256 MB für Windows® XP 
Grafikauflösung 800×600, besser 1024×768 oder 

mehr 
Drucker Alle vom Betriebssystem unterstützten 

Drucker 

 

1.4.2 Software-Installation 

Um «IC Net 2.2» gemäss 21 CFR Part 11 nutzen zu können 
wird das Betriebssystem Windows 2000 oder Windows XP mit 
NTFS File-System benötigt. 

 
Bei einem Update von IC Net 2.1 zu IC Net 2.2 gehen Sie bitte 
gemäss Kap. 1.4.3 vor. 

Installations-CD ins CD-Laufwerk legen. Im Start-Menü den Me-
nüpunkt Ausführen wählen und die Datei Setup.exe auf der Installati-
ons-CD öffnen. Befolgen Sie die Anweisungen des Setup-Pro-
gramms.  
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Um von einer IC Net Installation (ohne 21 CFR part 11 Einstel-
lungen) zu einer IC Net Compliant Installation (mit 21 CFR part 
11 Einstellungen) zu wechseln (und umgekehrt) muss immer 
die vorhergehende Installation entfernt werden! Achten Sie des-
halb auf den entsprechenden Dialog im Installationsprogramm. 

 

Die beiden Softwarepakete «IC Net 2.2» und «Autodatabase 
1.0» werden im gewünschten Verzeichnis installiert. Programm-
symbole werden im Programmordner, im Programmstartordner 
und auf dem Arbeitsplatz abgelegt. Zusätzlich zu den Programm-
dateien des Programms «IC Net» werden noch die folgenden Un-
terordner erstellt: 

Accounts Verzeichnis für die Benutzerdaten, für Zugriff 
gesperrt. 

Data Verzeichnis für Datenfiles (*.chw) und Batch re-
processing files (*.bar) mit einigen Beispielen. 

Devices Verzeichnis für Gerätetreiber (*.dev). 

Flog Verzeichnis für die Audit Trail-Files, für Zugriff 
gesperrt. 

Log Verzeichnis für Ausnahme-Files (*.exc), History 
files (*.hst) und Log files (*.log). 

Methods Verzeichnis für Methodenfiles (*.mtw) und Pro-
bentabellen-Files (*.que) mit einigen Beispielen. 

Reports Verzeichnis für Report- (*) und Grafikfiles 
(*.wmf). 

Services Verzeichnis für die Benutzerverwaltung. 

Systems Verzeichnis für Systemfiles (*.smt). 

 

1.4.3 Software-Update 

Bei einem Update von IC Net 2.1 zu IC Net 2.2 gehen Sie bitte wie 
folgt vor: 

1. Schalten Sie den PC ein und starten Sie das Betriebssystem. 

2. Falls Sie die mit IC Net 2.1 erstellten Chromatogramm-, Me-
thoden- und Systemdateien in IC Net 2.2 weiterverwenden 
wollen, machen Sie eine Sicherungskopie der Ordner Data, 
Methods und Systems in ein anderes Verzeichnis auf der Fest-
platte. 

3. Falls Sie die mit Autodatabase 1.0 erstellten Daten weiterver-
wenden wollen, machen Sie eine Sicherungskopie der Ordner 
Filters, Report templates und User database in ein anderes Ver-
zeichnis auf der Festplatte. 
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4. Deinstallieren Sie die Software IC Net 2.1: Wählen Sie <Start> / 
Einstellungen / Systemsteuerung. Doppelklicken Sie auf das 
Symbol Software. Wählen Sie aus der Liste Metrohm IC Net 2.1 
aus und klicken Sie auf <Hinzufügen/Entfernen>. Alle Pro-
grammdateien und Symbole werden entfernt. 

5. Löschen Sie den Ordner IC Net 2.1 im Programmordner. 

6. Installieren Sie die Software IC Net 2.2 (siehe Kap.1.4.2). 

7. Kopieren Sie die in der Sicherungskopie von IC Net 2.1 ge-
speicherten Dateien der Ordner Data, Methods und Systems in 
die entsprechenden neuen Ordner ..\IC Net 2.2\IC Net\Data, ..\IC 
Net 2.2\IC Net\Methods und ..\IC Net 2.2\IC Net\Systems. 

8. Kopieren Sie die in der Sicherungskopie von Autodatabase 
gespeicherten Dateien der Ordner Filters, Report templates und 
User database in die entsprechenden neuen Ordner..\IC Net 
2.2\Autodatabase\Filters, ..\IC Net 2.2\Autodatabase\Report templa-
tes und ..\IC Net 2.2\Autodatabase\User database. 

 
Der Ordner ..\IC Net 2.2\IC Net\Data ist gegen unerlaubten Zugriff 
und Manipulation geschützt, wenn IC Net 2.2 konfiguriert ist um 
nach 21 CFR Part 11 zu arbeiten. Um die Chromatogramme 
aus dem Data Ordner der Sicherheitskopie in den ..\IC Net 2.2\IC 
Net\Data Ordner zu kopieren starten Sie IC Net 2.2 und öffnen 
das Chromatogram open Fenster (siehe Kap. 8.2.1), wählen Sie 
den Data Ordner der Sicherheitskopie und kopieren Sie ihn in 
den ..\IC Net 2.2\IC Net\Data Ordner. 

 

1.4.4 Software-Deinstallation 

Wählen Sie <Start> / Einstellungen / Systemsteuerung. Doppelkli-
cken Sie auf das Symbol Software. Wählen Sie aus der Liste 
Metrohm IC Net 2.2 aus und klicken Sie auf <Hinzufügen/Entfernen>. 
Alle Programmdateien und Symbole werden entfernt. 

 

1.4.5 Demoversion 

Wird die «IC Net Software 2.2» auf einem PC installiert, ohne 
dass gleichzeitig IC-Komponenten installiert sind, so kann diese 
Software als Demoversion eingesetzt werden, welche auf die 
Ansicht und Nachberechnung von bereits aufgenommenen 
Chromatogrammen beschränkt ist. 

1.4.6 Registrierung 

Senden Sie bitte Ihre Registrierkarte 8.110.8207 so bald wie 
möglich ein, damit wir Sie als offiziellen Käufer eintragen können. 
Als registrierter Käufer erhalten Sie allfällige überarbeitete Pro-
grammversionen zu einem Vorzugspreis. 
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2 Grundlagen der Bedienung 

2.1 Programm starten und beenden 

2.1.1 Programm «IC Net» starten 

 

Programm starten 
Ein Doppelklick auf dieses Symbol oder die Datei ICNet.exe startet 
das Programm «IC Net 2.2». Es erscheint das IC Net Login-
Fenster:  

 

Geben Sie hier Ihren Benutzernamen und Ihr Passwort ein und 
drücken Sie auf <Log In>. 

 
Bei dem ersten Start des Programms nach der Softwareinstalla-
tion öffnet das Add User Fenster (siehe Kap. 3.2.1) und ein Be-
nutzer mit Administrator Zugriffsrechten wird erzeugt. Es wird 
empfohlen die weiteren Benutzer gleich nach der Installation 
anzulegen. Zum Erzeugen von Benutzern siehe Kap. 3.2. 

 

 
2.1.2 Programm «IC Net» beenden 

IC NET / File / Exit  (Alt+F4) 
Programm «IC Net 2.2» beenden. 

 Das Programm kann auch durch Klicken auf    in der rechten 
oberen Ecke des Hauptfensters beendet werden. 
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2.2 Begriffe 

Arbeitsplatz (Workplace) 
Der Arbeitsplatz (Workplace) enthält alle Interfaces und Geräte, 
die direkt an den seriellen PC-Schnittstellen angeschlossen sind, 
sowie alle Systeme, die an den Interfaces angeschlossen sind. 
Die Symbole all dieser aktiven Interfaces, Geräte und Systeme er-
scheinen auf der Symbolleiste. Sie können auch im Fenster 
Workplace angezeigt werden, das durch Wählen des Menüpunk-
tes Options / Devices setup geöffnet wird. 

Bestimmung (Determination) 
Um eine Bestimmung durchzuführen, muss ein für das Trenn-
problem geeignetes System ausgewählt werden. Das Resultat 
der Bestimmung ist ein Chromatogramm, in dem die Messdaten 
und Resultate der Bestimmung gespeichert sind (Details siehe 
Kap. 8).  

Chromatogramm 
Als Chromatogramm wird die grafische Darstellung der Elutions-
kurve (Signal vs. Zeit) bezeichnet, welche anschliessend an die 
chromatografische Trennung auf einer Trennsäule aufgenommen 
wird. 
Chromatogramme werden als Chromatogrammdateien (*.chw) 
im Verzeichnis Data gespeichert. Neben den Messdaten enthalten 
die Chromatogrammdateien auch die Methodenparameter und 
Systemeinstellungen, welche zur Datenaufnahme, -verarbeitung 
und Fernsteuerung verwendet wurden (Details siehe Kap. 8). 

Gerät (Device) 
Das Programm «IC Net» unterstützt die Fernbedienung von 
Metrohm- und Bischoff-Geräten. Jedes Gerät innerhalb eines 
Systems wird als Gerätefile (*.dev) im Verzeichnis Devices gespei-
chert. Alle Metrohm-Geräte beginnen mit Me*.dev und alle Bi-
schoff-Geräte beginnen mit Bi*.dev (Details siehe Kap. 6). 

Integration 
Unter Integration versteht man das Verfahren zur Bestimmung 
von Peakfläche und Peakhöhe mit Hilfe von approximierten Basis-
linien. Der im Programm eingebaute Integrations-Algorithmus 
wird durch die Integrationsparameter und die optional pro-
grammierbaren Integrations-Ereignisse beeinflusst, welche in 
der Methode definiert sind. Zusätzlich kann die Integration nach-
träglich mit Hilfe des Peak-Editors (siehe Kap. 8.4) manuell kor-
rigiert werden (Details siehe Kap. 7.4). 

Interface 
Das Programm «IC Net» unterstützt die Fernbedienung von Inter-
faces von Metrohm und Bischoff. Interfaces konvertieren Analog-
signale in Digitalsignale, welche vom PC verarbeitet werden kön-
nen. Sie werden als Gerätefiles (*.dev) im Verzeichnis Devices ge-



 2.2  Begriffe 
 

IC Net 2.2 9 

speichert. Alle Metrohm-Interfaces und Metrohm-Geräte be-
ginnen mit Me*.dev; alle Bischoff-Interfaces und Bischoff-
Geräte beginnen mit Bi*.dev (Details siehe Kap. 5). 

Kalibrierung (Calibration) 
Als Kalibrierung bezeichnet man das Verfahren, den Zusammen-
hang zwischen der für eine Komponente ermittelten Peakhöhe 
bzw. Peakfläche und ihrer Konzentration in der Probe zu ermitteln. 
Das Ergebnis der Kalibrierung ist eine Kalibrierfunktion (Kalib-
rierkurve), welche die Abhängigkeit zwischen Probenmenge und 
Auswertegrösse aufzeigt. 

Die Bestimmung der Kalibrierfunktion mit Hilfe von Bezugslösun-
gen kann als Ein-Punkt- oder als Mehr-Punkt-Kalibrierung 
durchgeführt werden. Als Kalibriermethode wird in der Ionenchro-
matographie vorwiegend die Externe Standardkalibrierung 
(absolute Kalibrierung) eingesetzt, die Kalibrierung mit Internem 
Standard (relative Kalibrierung) oder die Tabellierte Kalibrie-
rung sind aber ebenfalls möglich (Details siehe Kap. 7.5). 

Methode 
Eine Methode enthält alle Informationen, die zur Datenerfas-
sung, Integration, Peakauswertung und Resultatberech-
nung notwendig sind. Sie kann als Gerüst des Chromato-
gramms, also als Chromatogramm ohne Daten betrachtet wer-
den. Methoden werden als Methodendateien (*.mtw) im Ver-
zeichnis Methods gespeichert.  
Jedes System ist mit einer Methode verknüpft. Diese Methode 
wird Prozessmethode (Processing method) genannt und beim 
Start einer neuen Bestimmung automatisch geöffnet (Details sie-
he Kap. 7). 

Nachbearbeitung (Batch reprocessing)  
Unter Nachbearbeitung versteht man die nachträgliche Überar-
beitung einer Serie von Chromatogrammen, die in eine Nachbe-
arbeitungstabelle geladen wurden. Für die Überarbeitung anhand 
einer ausgewählten Methode können die Einstellungen für Kalib-
rierung, Integration, Passport, Aussehen und Report beliebig ver-
ändert werden (Details siehe Kap. 10). 

Probentabelle (Sample queue) 
Eine Probentabelle dient zur automatischen Abarbeitung von 
Probeserien, insbesondere in Verbindung mit einem Proben-
wechsler (Details siehe Kap. 9). 

System 
Der Begriff System bezeichnet die Kombination von Metrohm- 
und Bischoff-Geräten, die an ein Interface angeschlossen sind. 
Das System beinhaltet alle Geräteeinstellungen, ihre Zeitpro-
gramme, die Datenaufnahmeparameter und die Prozessmetho-
de, welche für eine spezifische Trennsäule und die damit auszu-
führende Bestimmung optimiert worden ist. Ein System wird dazu 
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benutzt, Einzelbestimmungen oder Bestimmungen mit Hilfe einer 
Probentabelle zu starten. Systeme werden als Systemdateien 
(*.smt) im Verzeichnis Systems gespeichert (Details siehe Kap. 4).  

2.3 Übersicht über die Programmfenster 

Das Programm «IC Net 2.2» besteht aus verschiedenen Fenstern, 
deren Funktionen miteinander verknüpft sind:  

IC NET Hauptfenster für Verwalten von Dateien, 
Drucken, Methodenerstellung, optionale 
Einstellungen, Login und Zugriffsrechte, 
Anordnung und Auswahl der Fenster. 

CHROMATOGRAM Fenster für die grafische Darstellung von 
laufenden oder aufgenommenen Chroma-
togrammen. 

SYSTEM Systemfenster für die manuelle Steuerung 
von Interfaces und Geräten. 

SYSTEM STATE Fenster zur Anzeige von Statusmeldungen. 

WATCH WINDOW Fenster zur Anzeige von Leitfähigkeit und 
Druck. 

QUEUE EDITOR Fenster zur Überarbeitung von Proben-
tabellen und Nachbearbeitungstabellen. 

2.4 Elemente des Hauptfensters 

Die Elemente des Hauptfensters IC NET sind die Menüleiste, die 
Symbolleiste und die Statusleiste, welche Hilfstexte und den ak-
tuellen Anwender anzeigt. 

 

Menüleiste

Symbolleiste

Statuszeile

Eingeloggter Anwender Hilfstexte, Erklärungen 
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2.5 Symbole des Hauptfensters 

Die folgenden Symbole werden im Hauptfenster angezeigt: 

 Chromatogramme öffnen 

 Chromatogramme speichern 

 Letzte Nachbearbeitungstabelle öffnen 

 Reporteinstellungen 

 Druckvorschau (Seitenansicht) 

 Chromatogramme an «Autodatabase» senden 

 Report drucken 

 Passport 

 Allgemeine Methodeneinstellungen 

 Integrationseinstellungen 

 Komponententabelle 

 Geöffnete Chromatogramme versetzt anordnen 

 Geöffnete Chromatogramme nebeneinander anord-
nen 

 Geöffnete Chromatogramme übereinander anordnen 

 Optische Erscheinung des Chromatogramms festle-
gen 

 Peakeditor-Modus ein-/ausschalten. 

 Chromatogramm ganz anzeigen 

 Hilfe 

 Zugang zum Programm blockieren 

 762 IC Interface 

 771 Compact Interface 

 Verbundenes System 

 Globale Zeitschaltuhr 
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2.6 Übersicht über die Dateitypen 

Die folgenden Dateitypen werden vom Programm «IC Net» gebil-
det:  
*.adb Autodatabase-Datei 

Enthält Chromatogramm- und Methodendaten aller Be-
stimmungen. 

*.bar Nachbearbeitungstabelle (Batch reprocessing file)  
Diese Binärdatei enthält die Daten der Nachbearbei-
tungstabelle. Die Datei *.bar wird automatisch im Ver-
zeichnis Data gespeichert. 

*.cal Kalibrierungsdatei 
Diese Binärdatei enthält Kalibrierdaten, welche mit IC 
Net / Method / Calibration / Export calibration exportiert 
werden können. Die Datei *.cal wird automatisch im Ver-
zeichnis Methods gespeichert. 

*.chw Chromatogrammdatei 
Diese Binärdatei enthält Messdaten und verwendete 
System- und Methodeneinstellungen einer Bestimmung. 
Die Datei *.chw wird automatisch im Verzeichnis Data 
gespeichert. 

*.exc Ausnahme-Datei 
Diese ASCII-Datei enthält Ausnahme vom normalen 
Programmablauf und Fehlermeldungen. Die Datei *.exc 
wird automatisch in einem der für jeden Tag verfügba-
ren Unterordner im Verzeichnis Log gespeichert. 

*.hst History-Datei 
Diese ASCII-Datei enthält den aufgezeichneten Verlauf 
von Befehlen und Programmaktionen. Die Datei *.hst 
wird automatisch in einem der für jeden Tag verfügba-
ren Unterordner im Verzeichnis Log gespeichert. 

*.log Log-Datei 
Diese ASCII-Datei enthält die Log-Datei der Datenkom-
munikation zwischen PC und Geräten. Die Datei *.log 
wird automatisch in einem der für jeden Tag verfügba-
ren Unterordner im Verzeichnis Log gespeichert. 

*.mtw Methodendatei 
Diese Binärdatei enthält die Datenverarbeitungsmetho-
de, welche mit einem System verknüpft werden kann. 
Die Datei *.mtw wird automatisch im Verzeichnis Methods 
gespeichert. 

*.que Probentabelle (Sample queue) 
Diese Binärdatei enthält die Daten der Probentabelle. 
Die Datei *.que wird automatisch im Verzeichnis Systems 
gespeichert. 
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*.rtt Reportvorlage 
Diese ASCII-Datei enthält die Reportvorlage. Die Datei 
*.rtt wird im Programmverzeichnis gespeichert. 

*.smt Systemdatei 
Diese ASCII-Datei enthält die Systemeinstellungen. Die 
Datei *.smt wird automatisch im Verzeichnis Systems ge-
speichert. 

*.dev Gerätedatei 
Diese ASCII-Datei enthält Gerätetreiber. Die Datei *.dev 
wird im Verzeichnis Devices gespeichert. 

2.7 Kontext-sensitive Menüs 
Viele Menüfunktionen der Programmfenster können auch durch 
Klicken mit der rechten Maustaste auf das gewünschte Fenster 
oder Element ausgewählt werden. Die dabei geöffneten Menüop-
tionen hängen vom ausgewählten aktiven Fenster oder Element 
ab. 

2.8 Funktionen von Tastatur und Maus 
Mit der Maus können die üblichen Funktionen zur Programmbe-
dienung wie Auswahl von Menüpunkten und Feldern ausgeführt 
werden. Zusätzlich dient sie auch zur Vergrösserung eines Chro-
matogramm-Ausschnittes (Zoomen). Dazu wird der Cursor der 
Maus auf die linke obere Ecke des zu vergrössernden Vierecks 
gebracht, die linke Maustaste gedrückt und der Cursor zur unte-
ren rechten Ecke des Vierecks gezogen. Nach dem Loslassen 
der linken Maustaste wird der ausgewählte Bereich auf die volle 
Fenstergrösse vergrössert. Ist der Cursor im Peakeditor-Modus 
aktiv, so kann dieser mit gedrückter rechter Maustaste bewegt 
werden. Auch die Tastatur kann zur Skalierung des Chroma-
togramms im Fenster verwendet werden, wie dies nachstehend 
beschrieben wird.  

Tastatur Kurzübersicht 
Cursor ist nicht aktiv:  
[ ↑ ]  Vergrössert die Empfindlichkeit der Y-Achse. 

[ ↓ ]  Reduziert die Empfindlichkeit der Y-Achse. 

[ → ]  Vergrössert das Chromatogramm in X-Richtung. 
[ ← ]  Verkleinert das Chromatogramm in X-Richtung. 
[ Ctrl ] + [ Home ]  Automatische Skalierung der X-Achse  

(zeigt alles in X-Richtung). 
[ Ctrl ] + [ End ]  Automatische Skalierung der Y-Achse  

(zeigt alles in Y-Richtung). 
[ PageUp ] Schiebt das Chromatogramm um 1/10 des Bildschirmes 

nach oben. 
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[ PageDown ] Schiebt das Chromatogramm um 1/10 des Bildschirmes 
nach unten. 

[ Shift ] + [ ↑ ] Vergrössert den Abstand zwischen den Kanälen eines 
Chromatogramms.  

[ Shift ] + [ ↓ ] Verringert den Abstand zwischen den Kanälen eines 
Chromatogramms. 

[ 0 (Zero) ]  Stellt den letzten Punkt eines Chromatogramms (lau-
fendes Chromatogramm) oder den tiefsten Punkt des 
Chromatogramms (abgeschlossenes Chromato-
gramm) auf Null. 

Nur Ausschnitt des Chromatogramms auf Bildschirm: 
[ Ctrl ] + [ → ]  Verschiebt das Fenster nach rechts (ohne die Skalie-

rung der X und Y Achse zu verändern). 
[ Ctrl ] + [ ← ]  Verschiebt das Fenster nach links (ohne die Skalierung 

der X und Y Achse zu verändern). 
[ Home ]  Zeigt den Anfang eines Chromatogramms (ohne Än-

derung der X und Y Skalierung). 
[ End ]  Zeigt das Ende eines Chromatogramms  

(ohne Änderung der X und Y Skalierung). 
[ 0  (Zero) ]  Stellt den niedrigsten Punkt im Fenster auf Null. 

Cursor ist aktiviert: 
[ 0  (Zero) ]  Setzt an der Stelle des Cursors auf Null. 
[ → ]  Bewegt den Cursor von links nach rechts. 
[ Shift ] + [ → ]  Bewegt den Cursor schnell von links nach rechts. 
[ ← ]  Bewegt den Cursor von rechts nach links. 
[ Shift ] + [ ← ]  Bewegt den Cursor schnell von rechts nach links. 
[ Home ]  Bewegt den Cursor an den Anfang des Fensters. 
[ End ]  Bewegt den Cursor zum Ende des Fensters. 
[ Shift ] + [ End ]  Setzt an der Stelle des Cursors den Anfang des Fens-

ters. 
[ Shift ] + [ Home ]  Setzt an der Stelle des Cursors das Ende des Fens-

ters. 

2.9 Hilfe 

Mit dem Symbol   , dem Knopf   , dem Menüpukt Help 
/ Contents oder der Taste [ F1 ] können Sie überall Hilfe für das 
aktuelle Thema anfordern. 

Grüne Texte  können Sie jeweils anklicken. So verzweigen Sie 
zu einem anderen Hilfethema. 

Violette Texte kennzeichnen Menüpunkte, Parameter oder 
Knöpfe im Programm. 

Blaue Texte kennzeichnen Titel und wichtige Informationen. 
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3 Softwareeinstellungen 

3.1 Schriften 

IC NET / Options / Fonts 
Diese Option ermöglicht ein Auswählen der Schriftarten, die von 
der Software verwendet werden.  

Font for dialogs... Auswahl der Schriftart für Dialog-Fenster.  
Grundeinstellung: MS Sans Serif/Normal/8 pt. 

Font for reports... Auswahl der Schriftart zur Ausgabe von Re-
ports auf dem Bildschirm oder Drucker. 
Grundeinstellung: Courier New/Normal/10 pt. 

Font for tables... Auswahl der Schriftart zur Präsentation von 
Tabellen auf dem Bildschirm.  
Grundeinstellung: MS Sans Serif/Fett/8 pt. 

Font for plots... Auswahl der Schriftart zur Beschriftung in 
Chromatogrammen und Kalibrierkurven. 
Grundeinstellung: Times New Roman/Fett/10 pt. 

Save fonts configuration 
Speichert die gewählte Schriftenkonfiguration. 

 
Um die Schriftenkonfiguration auf die Grundeinstel-
lungen zurückzusetzen, muss die Datei fonts.cfg im 
Programmverzeichnis gelöscht werden. 

 

3.2 Sicherheitssystem 

In Übereinstimmung mit den Anforderungen von GLP und 21 
CFR Part 11 verfügt das Programm «IC Net» über einen Pass-
wortschutz des Systems. Jedem Anwender ist ein Anwendername 
(User Name), Passwort (Password) und eine Zugriffsstufe (Access 
Level), die die möglichen Aktionen beschränkt, zugeordnet. 

IC Net / Options / Security öffnet die Anwenderverwaltung von IC 
Net. Wenn dieser Menüpunkt gewählt wird öffnet sich erst das 
Login-Fenster (siehe Kap. 2.1.1). 

Der Zugriff auf die Anwenderverwaltung ist entsprechend der 
Zugriffsstufe des Anwenders beschränkt, aus diesem Grund wer-
den unterschiedliche Fenster geöffnet. 
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Benutzer Fenster Ausführbare Aktionen 

Novice,  
Master 

New Password In diesem Fenster kann der An-
wender sein Passwort (Password) 
ändern. 

Administrator Security options In diesem Fenster können An-
wenderliste (User List) und Pass-
wort Optionen (Password Options) 
editiert werden, der Administrator 
kann sein Passwort ändern. 

 

3.2.1 Fenster Security Options 

 

IC NET / Options / Security 
Dieses Fenster enthält die Anwenderverwaltung 
und die Passwort Optionen. Es ist nur für An-
wender mit Administrator-Zugriffsrechten zu-
gänglich und besteht aus den beiden Registrier-
karten User List und Password Options. 

 
Das Fenster Security Options ist nur für Administrator An-
wender zugänglich. Wenn es keinen aktiven (siehe weiter un-
ten Status) Administrator mehr gibt, z.B. weil das Passwort ver-
gessen wurde, muss «IC Net» neu installiert werden um wieder 
Zugang zu haben. Deshalb wird dringend empfohlen zur Si-
cherheit einen zweiten Administrator zu erzeugen. Bewahren 
Sie dessen Passwort an einem sicheren Ort auf. 

 

User List 

 
Die Registrierkarte User List zeigt den Anwendernamen (User), 
den vollen Namen (Full Name), die Zugriffsstufe (Level) und den 
Status von jedem Anwender an. Die Liste kann anhand einer der 
vier Spalten alphabetisch sortiert werden, indem man einen Spal-
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tentitel anklickt. Ein Sternchen ( * ) im Titel zeigt das Sortierkriteri-
um an. 

<Add user> Der Anwenderliste einen neuen Anwender hin-
zufügen, öffnet das Fenster Add User. 

<Modify user> Einstellungen (Anwendername, voller Name, 
Zugriffstufe, Status) des angewählten Anwen-
ders ändern, öffnet das Fenster Modify User. 

<Password> Passwort des eingeloggten Administrators 
ändern, öffnet das Fenster New Password. 

Add/Modify User 

 
User Anwendername des Anwenders. 

Full Name Voller Name des Anwenders, dieser Name 
wird in der Statuszeile des Hauptfensters an-
gezeigt, während «IC Net» läuft. 

Level Zugriffsstufe des Anwenders. 
Novice Eingeschränkter Zugang zum Programm. Er-

laubt sind nur Start und Stopp von Bestim-
mungen mit bestehenden Systemen und Me-
thoden sowie die manuelle Steuerung von Ge-
räten. Systeme, Methoden und Chroma-
togramme können nicht überarbeitet werden. 

Master Zugang zu allen Programmfunktionen mit Aus-
nahme der globalen Einstellungen Global 
preferences, dem Fenster Workplace, den 
Hardwareeinstellungen von Geräten und Inter-
faces und dem Sicherheitssystem. 

Administrator Zugang zu allen Programmfunktionen. Diese 
Zugriffsstufe sollte nur beim Installieren des 
Sicherheitssystems oder bei Änderungen an 
den Hardwarekonfigurationen gewählt werden. 
Der Administrator kann Namen, Zugriffstufe 
und Status von Anwendern ändern. 
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Status Status des Anwenders. 
Active Der Anwender kann im Rahmen seiner 

Zugriffsstufe (Level) mit «IC Net» arbeiten. 

Inactive Der Anwender kann nicht mit «IC Net» arbei-
ten. Der Status des Anwenders wird auf Inacti-
ve gesetzt, wenn die Anzahl der fehlgeschla-
genen Login-Versuche, die bei Password Opti-
ons festgesetzte Grenze überschreitet. 
Der Anwenderstatus kann von einem Administ-
rator wieder auf Active gesetzt werden. 

Removed Der Anwender kann nicht mit «IC Net» arbei-
ten. Der Anwender ist von dem System ent-
fernt, er wird in der User List weiter aufgeführt. 
Der Anwenderstatus kann von einem Administ-
rator wieder auf Active gesetzt werden. 

 

Password Options 
Diese Registrierkarte erlaubt die Sicherheitseinstellungen für das 
Passwort und das Login zu setzen. 

 
 

Minimum Password Length 
Minimale Anzahl Zeichen des Passwortes. 
Bereich: 2...10, Standardwert 6. 

Maximum number of login attempts 
Wenn die Anzahl der fehlgeschlagenen Login-
Versuche diesen Wert überschreitet, wird der 
Anwender Inactive gesetzt. 
Bereich: 2...10, Standardwert 3. 

Password Validity 
Anzahl der Tage die das Passwort eines An-
wenders gültig bleibt. Wenn das Passwort ab-
gelaufen ist, wird der Anwender beim Login 
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aufgefordert sein Passwort zu wechseln. 
Bereich: 1...999, Standardwert 365. 

Automatic Logout After 
Nach der festgelegten Zeitspanne an Inaktivi-
tät (in Minuten) wird das System gesperrt, um 
es gegen unbefugten Zugriff zu schützen. 
Bereich: 1,...999, Standardwert 30. 

 

Der Anwendername und das Passwort werden bei jedem Pro-
grammstart abgefragt. Alle Methoden, Chromatogramme und 
Reports werden mit dem Anwendernamen gekennzeichnet. Ein 
Wechsel des Anwenders ist jederzeit mit dem Menüpunkt IC NET / 
Options / Lock system möglich. 

 

 

3.3 Audit Trail 

IC NET / Options / Audit Trail 

Das Audit Trail ist ein Teil des Sicherheitssystems. IC Net zeichnet 
alle Benutzer Logins und alle Aktionen, die elektronische Auf-
zeichnungen erzeugen, verändern oder löschen, automatisch auf. 
Das Audit Trail enthält jedes Ereignis mit Zeit, Datum und dem 
Benutzer, der es ausgeführt hat. 

Diese Option stellt die Audit Trail Aufzeichungen in dem Audit Trail 
Fenster dar. 

 
Das Audit Trail Fenster ist nur für Administratoren zugäng-
lich. 

 

Chromatogram Öffnet das Audit Trail Fenster, das alle Ände-
rungen anzeigt, die an einem Chroma-
togramm vorgenommen wurden. Es sind Da-
tum (Date), Zeit (Time), Benutzer (User), geän-
derte Eigenschaft des Chromatogramms 
(Item), der alte Wert der Eigenschaft (Old Va-
lue) und der neue Wert (New Value) aufgelistet. 
Diese Option ist nur verfügbar, wenn das inte-
ressierende Chromatogramm geöffnet ist und 
sich im aktiven Fenster von IC Net befindet. 

 
Die Änderungen an einem Chromatogramm werden erst beim 
speichern im Audit Trail nachgeführt. 

 

History Öffnet das Audit Trail Fenster, das alle Aktio-
nen anzeigt, die im IC Net window durchge-
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führt wurden. Es sind Datum (Date), Zeit 
(Time), Benutzer (User), der betroffene Pro-
grammteil (Item) und der Wert (Value) von je-
der Aktion aufgelistet. 
Werkzeug um z.B. die Login- und Benutzer-
History nachzuverfolgen. 

 

Audit Trail window 
Das Audit Trail Fenster stellt die Audit Trail Aufzeichnungen von 
IC Net oder den Chromatogrammen in einer Tabelle dar. Der 
einfache Zugang zu spezifischen Informationen wird durch ver-
schiedene Sortier- und Filterfunktionen des Audit Trail Fensters 
ermöglicht. Die Aufzeichnungen können nach einer der 
fünf/sechs Spalten der Tabelle durch klicken des Titels sortiert 
werden. Ein Stern ( * ) am Ende des Titels zeigt das Sortierkriteri-
um an. 

 

 Fenster Aktualisieren, nicht verfügbar im 
Chromatogramm Audit Trail. 

 Öffnet das Save Audit Trail As Fenster, um 
die Audit Trail Aufzeichnungen zu exportie-
ren. 

 Sortieren, öffnet das Sort Fenster. 

 Filtert die Tabelle nach Inhalt und Spalte ei-
nes ausgewählten Feldes. Diese Filteropti-
on kann mehrmals nacheinander ange-
wendet werden um die angezeigten Daten 
zu reduzieren. 

 Filter Zurücksetzen. 

 Öffnet die Hilfe. 
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Sort window 
Dieses Fenster bietet die Möglichkeit die Aufzeichnungsdaten 
des Audit Trail Fensters übersichtlich darzustellen. Die Spaltenti-
tel des Audit Trail Fensters können zu einer Sortierreihenfolge (Sort 
Sequence) kombiniert werden, nach der die Audit Trail Aufzeich-
nungen sortiert werden. 

 
Sort Sequence Sortierkriterien der Sortierreihenfolge, die 

Sortierkriterien werden in der Reihenfolge 
angewendet, wie sie in der Liste stehen. 

Available Sortierkriterien, die noch verfügbar sind. 

 Markiertes Sortierkriterium Auswählen. 

 Markiertes Sortierkriterium Entfernen. 
 

 

3.4 Globale Einstellungen 

IC NET / Options / Global preferences 

In diesem Fenster können allgemein gültige Programmein-
stellungen vorgenommen werden. Dieses Fenster ist nur zu-
gänglich für Anwender mit der Zugriffsstufe Administrator.  

Data file overwrite Überschreiben von Chromatogrammdatei-
en: 

Never Chromatogrammdateien können nicht 
überschrieben werden. Ein überarbeitetes 
Chromatogramm wird als neue Datei ge-
speichert, bei der die Nummer des Datei-
namens um +1 erhöht wird. 

Ask Der Anwender wird gefragt, ob das Chro-
matogramm überschrieben werden soll. 

Always Chromatogrammdateien werden immer oh-
ne Bestätigung überschrieben. 
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If method changed Speichern von Methodendateien: 
Don’t ask to save Die Methode wird nicht automatisch ge-

speichert. Sie kann nur mit File / Save / Me-
thod gespeichert werden. 

Ask to save Der Anwender wird gefragt, ob die Methode 
gespeichert werden soll. 

If disk method is newer 
Überschreiben von Methodendateien: 

Ask to overwrite Der Anwender wird gefragt, ob die Methode 
überschrieben werden soll. 

Overwrite without asking 
Methodendateien werden ohne Bestätigung 
überschrieben. 

User comments 
Änderungen an Methoden, Systemen, 
Chromatogrammen,... : 

Require Comment on changes 
Der Anwender muss eine Änderung kom-
mentieren. 

Opening chromatograms 
Öffnen von Chromatogrammen: 

Ignore last data directory 
Ist diese Option eingeschaltet, wird dasje-
nige Verzeichnis geöffnet, in dem das aktu-
ell ausgewählte Chromatogramm gespei-
chert ist. Ist diese Option ausgeschaltet, 
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wird dasjenige Verzeichnis geöffnet, in dem 
das zuletzt geöffnete Chromatogramm ge-
speichert ist. 

21 CFR Part 11 On Schaltet die 21 CFR Part 11 Einstellungen 
ein/aus. Ist automatisch aktiviert und kann 
nicht ausgeschaltet werden, wenn IC Net 
Compliant installiert wurde. Die folgenden 
Parameter werden automatisch gesetzt: 
Data file overwrite = Never 
If method changed = Ask to save 
If disk method is newer = Ask to overwrite 
User comments = Require Comment 
  on changes enabled 
GLP On = enabled 

GLP On Schaltet die GLP Einstellungen ein/aus. Die 
folgenden Parameter werden automatisch 
gesetzt: 
Data file overwrite =  Never 
If method changed =  Ask to save 
If disk method is newer =  Ask to overwrite 

System face 
Stacked recorder icons 

Ist diese Option eingeschaltet, erscheint 
im Systemfenster bei mehreren installierten 
Datenaufzeichnungsgeräten nur ein Symbol 
mit verschiedenen Registerkarten.  

OK, Apply buttons mean  
Save object to file Ist diese Option eingeschaltet, wird der 

Knopf <Apply> in den Systemeinstellungs-
fenstern ersetzt durch <Save>. Beim Klicken 
auf <Save> oder <OK> werden die System-
einstellungen gespeichert. 

Chromatogram units Einheiten für Chromatogramme: 
Flow Einheit für Flussrate: µL/min, mL/min 

Pressure Einheit für Druck: MPa, psi, bar, atm 

Print via print spooler Drucken via Druckerwarteschlange. Schal-
ten Sie diese Option aus, wenn beim Dru-
cken Probleme auftreten. 

<Default colors> Festlegen der Standardeinstellungen für die 
Farben der Chromatogrammfenster (Details 
siehe Kap. 8.3.1). 
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4 Systeme 

Der Begriff System bezeichnet die Kombination von Metrohm- 
und Bischoff-Geräten, die an ein Interface angeschlossen sind. 
Das System beinhaltet alle Geräteeinstellungen, ihre Zeitprogram-
me, die Datenaufnahmeparameter und die Prozessmethode, wel-
che für eine spezifische Trennsäule und die damit auszuführende 
Bestimmung optimiert worden ist. Ein System wird dazu benutzt, 
Einzelbestimmungen oder Bestimmungen mit Hilfe einer Proben-
tabelle zu starten. Systeme werden als Systemdateien (*.smt) im 
Verzeichnis Systems gespeichert.  

 
4.1 Systemerstellung 

4.1.1 Assistent zur Systemerstellung 

IC NET / File / New / System 
Das Fenster New system wizard und ein neues Systemfenster wer-
den geöffnet. Der Assistent New system wizard führt Sie Schritt für 
Schritt durch die Installationsroutine zur Erstellung eines neuen 
Systems. Mit <Next> wird zum nächsten Schritt bei der Systemin-
stallation umgeschaltet, mit <Back> zum vorhergehenden Schritt 
und mit <Finish> wird die Installation beendet. 

Der erste Schritt bei der Systeminstallation besteht darin, einen 
Namen für den neuen Systemordner innerhalb des Programm-
pfads ...\ICNet\Systems einzugeben. Für jede Gerätekombination 
sollte ein neuer Ordner erstellt werden. 

 

Nach dem Klicken auf <Next> erscheint das Fenster für das Hin-
zufügen von Interfaces zur Symbolleiste. Dieser Schritt kann über-
sprungen werden, falls das gewünschte Interface bereits auf der 
Symbolleiste vorhanden ist (siehe Kap. 5.1.2). Andernfalls muss 
das Interface aus der Gruppe Metrohm Interfaces oder Bischoff In-
terfaces ausgewählt werden. Nach der Wahl der seriellen 
Schnittstelle, an die das Interface angeschlossen ist, und nach 
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Klicken auf <Add to workplace> erscheint das Interface-Symbol auf 
der Symbolleiste (PC Boards erscheinen nicht auf der Symbolleis-
te). 

 

Nach Klicken auf <Next> erscheint das Fenster für das Hinzufügen 
von Geräten zum Systemfenster (siehe Kap. 6.1.1).  

 

Öffnen Sie für jedes Gerät, das mit «IC Net» gesteuert werden 
soll, die Gruppe, welche dieses Gerät enthält. Markieren Sie das 
gewünschte Gerät und wählen Sie die serielle Schnittstelle Serial 
port des Interfaces aus, an dem das Gerät angeschlossen ist. 
Nach Klicken auf <Add to system> wird das Gerätesymbol zum 
Systemfenster hinzugefügt. Falls erwünscht, kann ein zusätzlicher 
Daten-Recorder und eine Zeitschaltuhr aus der Gruppe More mo-
dules zum System hinzugefügt werden. 

Nach Klicken auf <Next> erscheint das Fenster zur Wahl der mit 
der Methode verknüpften Prozessmethode und der Datenquelle 
(Details siehe Kap. 6.1, 6.2). 
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Nach Klicken auf <Finish> wird der Anwender aufgefordert, das 
neue System als Systemdatei (*.smt) im neuen Systemordner ab-
zuspeichern. Das neue System ist nun bereit für den Start einer 
Bestimmung (siehe Kap. 4.3.3). 

4.1.2 Systemfenster 

Ein Systemfenster wird mit IC NET / File / Open / System und der 
Wahl der gewünschten Systemdatei geöffnet. Es enthält Symbole  
für Datenaufzeichner, Watch window (Bildschirm) und alle Ge-
räte, die mit dem Systemassistenten installiert wurden. 

 

 

4.1.3 Geräte zu einem bestehenden Fenster hinzufügen 

SYSTEM / Setup / New devices/ Install new device 
Neue Geräte hinzufügen zu offenem Systemfenster. Öffnen Sie 
für jedes Gerät, das zum System hinzugefügt werden soll, die 
Gruppe, welche dieses Gerät enthält. Markieren Sie das ge-
wünschte Gerät und wählen Sie die serielle Schnittstelle des Inter-
faces aus, an dem das Gerät angeschlossen ist. Nach Klicken 
auf <Add to system> wird das Gerätesymbol zum Systemfenster 
hinzugefügt. Falls erwünscht, kann ein zusätzlicher Datenauf-
zeichner und eine Zeitschaltuhr aus der Gruppe More modules 
zum System hinzugefügt werden. 

Watch window

Datenaufzeichner

Geräte
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4.2 Systemverwaltung 

Das Öffnen, Wechseln, Speichern und Schliessen von Systemen 
erfolgt mit den folgenden Menüpunkten: 

IC NET / File / Open / System 
Laden einer bestehenden Systemdatei (*.smt) aus dem Verzeich-
nis Systems und Öffnen des entsprechenden Systemfensters. Die 
Namen von Unterverzeichnis und Systemdatei werden in der Ti-
telleiste des Systemfensters angezeigt. Ein Stern ( * ) am Ende 
des Namens zeigt an, dass die Systemeinstellungen seit der letz-
ten Speicherung verändert wurden. 

SYSTEM / System / Open other 
Laden einer bestehenden Systemdatei (*.smt) aus dem ge-
wünschten Systemordner im Verzeichnis Systems und Öffnen ei-
nes neuen Systemfensters für Parametereinstellungen. Das alte 
System bleibt verbunden. 

SYSTEM / System / Change 
Öffnen des ausgewählten neuen Systems im gewünschten Sys-
temordner. Das aktuelle System wird getrennt und geschlossen, 
das neue System wird verbunden. 

SYSTEM / System / Save 
Einstellungen des gewählten Systems in einer Systemdatei 
(*.smt) im Verzeichnis Systems speichern. 

SYSTEM / System / Close 
Ausgewähltes System schliessen. 

System löschen 
Um ein bestehendes System zu löschen, muss die entsprechen-
de Datei *.smt im Systemordner gelöscht werden. 
 

4.3 Systemfunktionen 

4.3.1 System verbinden und trennen 

Für die manuelle Steuerung des Gerätes und das Starten von Be-
stimmungen muss das gewählte System mit dem Arbeitsplatz 
verbunden werden. Systeme werden wie folgt verbunden und ge-
trennt: 

SYSTEM / Control / Connect to workplace 
Gewähltes System mit dem Arbeitsplatz verbinden. Aus dem glei-
chen Systemordner kann gleichzeitig nur ein System verbunden 
sein. 

Gleichzeitig erscheint das Symbol    auf der Symbolleiste. 
Beim Klicken auf dieses Symbol wird das Systemfenster immer 
im Vordergrund angezeigt. 
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SYSTEM / Control / Disconnect from workplace 
Gewähltes System vom Arbeitsplatz trennen. Sobald das System 
getrennt ist, ist eine manuelle Steuerung des Gerätes nicht mehr 
möglich, hingegen können die übrigen Systemeinstellungen ge-
ändert und gespeichert werden. Die beiden Funktionen Start de-
termination und Startup hardware sind nur möglich, wenn kein an-
deres System aus dem gleichen Systemordner verbunden ist. In 
diesem Fall wird das System automatisch verbunden. 

 

 

4.3.2 Hardware starten/stoppen und Basislinie aufzeichnen 

SYSTEM / Control / Startup hardware (Measure Baseline) 
Mit diesem Menüpunkt werden die folgenden Aktionen automa-
tisch ausgeführt: 
• Senden der Systemstartwerte System startup values an die Ge-

räte. 
• Metrohm solvent delivery systems und Bischoff solvent delivery 

systems starten. 
• Metrohm additional modules und Bischoff additional modules star-

ten. 
• Bischoff detectors starten. 
• Metrohm Autosamplers und Bischoff Autosamplers auf Fernbe-

dienung umschalten. 
• Aufzeichnung des Messsignals starten, wobei die im verbun-

denen System definierte Methode verwendet wird. Das Mess-
signal wird unabhängig von der eingestellten Chroma-
togrammdauer Duration aufgezeichnet, bis entweder die Da-
tenaufnahme durch Start einer neuen Bestimmung mit Start de-
termination gestoppt wird oder die Datenaufzeichnung durch 
Klicken auf    im Chromatogrammfenster abgebrochen wird. 
In diesem Fall wird der Anwender gefragt, ob die aufgenom-
mene Basislinie gespeichert werden soll oder nicht. 

SYSTEM / Control / Shutdown hardware 
Mit diesem Menüpunkt werden die Geräte wie folgt gestoppt: 
• Metrohm solvent delivery systems und Bischoff solvent delivery 

systems stoppen. 
• Metrohm additional modules und Bischoff additional modules 

stoppen. 
• Bischoff detectors stoppen. 
• Metrohm Autosamplers und Bischoff Autosamplers auf manuelle 

Bedienung umstellen. 
• Laufende Bestimmung stoppen. 
• Aktive Probentabelle stoppen. 

SYSTEM / Control / Stop data acquisition 
Aufzeichnung der Basislinie stoppen. 
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4.3.3 Bestimmungen starten/stoppen 

SYSTEM / Control / Start determination 
Bestimmung mit den Einstellungen des gewählten Systems 
starten. Beim Start werden die im System gesetzten Startwerte 
System startup values an den Geräten gesetzt. Je nach Einstellung 
des Startmodus Start mode werden Zeitprogramm und Datenauf-
zeichnung entweder sofort gestartet (bei Start with determination) 
oder erst beim Umschalten des Injektionsventils in die Stellung 
"INJECT" (bei Start with inject). 

SYSTEM / Control / Stop determination 
Laufende Bestimmung stoppen. Datenaufzeichnung und Zeit-
programm werden sofort abgebrochen. Das aufgezeichnete 
Chromatogramm wird automatisch gespeichert, falls die Option 
Save chromatogram after the run unter Passport / Processing einge-
schaltet ist. 

Alternativ dazu kann die Bestimmung durch Klicken auf    im 
Chromatogrammfenster gestoppt werden. In diesem Fall wird der 
Anwender immer gefragt, ob er das Chromatogramm speichern 
will oder nicht. 

 
Falls die Option Auto restart eingeschaltet oder eine 
Probentabelle aktiv ist, wird eine neue Bestimmung 
unmittelbar nach Beendigung der laufenden Bestim-
mung gestartet. Falls Sie dies vermeiden wollen, schal-
ten Sie die Option Auto restart aus oder stoppen Sie die 
Probentabelle mit Pause. 

 
SYSTEM / Control / Stop data acquisition 

Datenaufzeichnung der laufenden Bestimmung sofort stoppen. 
Das aufgezeichnete Chromatogramm wird automatisch gespei-
chert, falls die Option Save chromatogram after the run unter Pass-
port / Processing eingeschaltet ist. Das Zeitprogramm läuft normal 
weiter. 

4.3.4 Optionen für Bestimmungen 

SYSTEM / Control / Auto restart 
Ist diese Option eingeschaltet, wird automatisch eine neue Be-
stimmung mit dem aktuellen System gestartet, sobald die vorher-
gehende Bestimmung nach Ablauf der Chromatogrammdauer 
oder durch manuellen Stopp beendet wurde. 

Die Option Auto restart ist nicht aktiv, wenn Bestimmungen mit Hilfe 
einer Probentabelle ausgeführt werden. 

SYSTEM / Control / Verify sample 
Ist diese Option eingeschaltet, wird beim Start einer Bestimmung 
automatisch das Fenster Edit sample description geöffnet, in dem 
die folgenden Informationen zur Probe eingegeben werden kön-
nen: 
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Ident Kennzeichnung für das Chromatogramm, 
die in der Titelzeile des Chromatogramm-
fensters und als zusätzliche, kurze Informa-
tion im Fenster Chromatogram open ange-
zeigt wird. 

Calibration level Kalibrierpunkt (0 = Probe; 1…n = Kalibrier-
lösungen). 

Info 1 / Info 2 Informationen zur Probe. 

Volume Injektionsvolumen in µL. 
Dilution Verdünnung der Probe. 
Vial number Position der Probe auf dem Probenwechs-

ler. 

Amount Probenmenge. Ist dieser Wert für Probe (s) 
und Kalibrierlösungen (c) verschieden, so 
werden die Konzentrationen der Kompo-
nenten in der Probe wie folgt berechnet: 

 Cs = Cc • Amounts / Amountc 
Internal standard amount 

Konzentration des internen Standards. 

Date/time when... Datum und Zeit der Probenahme (ohne 
Eingabe wird hier automatisch Datum und 
Zeit beim Start der Bestimmung eingefügt). 

Die Option Verify sample ist nicht aktiv, wenn Bestimmungen mit 
Hilfe einer Probentabelle ausgeführt werden. 
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4.4 Systemeinstellungen 

4.4.1 Systemfenster verändern 

SYSTEM / Setup / Drag icons 
Ist diese Option eingeschaltet, so können die Systemsymbole im 
Systemfenster verkleinert, vergrössert und verschoben werden. 
Zusätzlich kann auch die Grösse des Systemfensters selbst ver-
ändert werden. 
Um die Grösse des Symbols oder Fensters zu ändern, muss der 
Cursor zum gewünschten Objekt bewegt werden, bis    er-
scheint. Stellen Sie nun mit gedrückter linker Maustaste die ge-
wünschte Grösse ein. 
Um ein Symbol zu verschieben, muss der Cursor zum ge-
wünschten Objekt bewegt werden, bis    erscheint. Verschieben 
Sie das Symbol nun mit gedrückter linker Maustaste an die ge-
wünschte Stelle. 

4.4.2 Messwertanzeige einschalten 

SYSTEM / Setup / Watch window 
Ist diese Option eingeschaltet, so wird beim Start einer Bestim-
mung oder Basislinienaufzeichnung automatisch das Fenster 
WATCH WINDOW mit der Anzeige von Leitfähigkeit und Druck ge-
öffnet (siehe Kap. 6.2). 

4.4.3 Startmodus festlegen 

SYSTEM / Setup / Start mode 
Es öffnet sich das Fenster Start mode, in dem der Startmodus für 
Zeitprogramm und Datenaufzeichnung festgelegt sind. 

 
Das Fenster enthält die beiden folgenden Felder: 
Start with determination 

Das Zeitprogramm des geladenen Objekts 
oder die Datenaufzeichnung (RECORDER) 
werden gestartet, sobald die Bestimmung 
gestartet wird. 
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Start with inject Das Zeitprogramm des geladenen Objekts 
oder die Datenaufzeichnung (RECORDER) 
werden gestartet, sobald die Probe inji-
ziert wird. 

Die Objekte können mit Hilfe der Knöpfe    oder    von ei-
nem Feld ins andere verschoben werden. 

 

4.4.4 Neue Geräte installieren 

SYSTEM / Setup / New devices/ Install new device 
Neue Geräte in offenes Systemfenster hinzufügen. Öffnen Sie 
für jedes Gerät, das zum System hinzugefügt werden soll, die 
Gruppe, welche dieses Gerät enthält. Markieren Sie das ge-
wünschte Gerät und wählen Sie die serielle Schnittstelle des Inter-
faces aus, an dem das Gerät angeschlossen ist. Nach Klicken 
auf <Add to system> wird das Gerätesymbol zum Systemfenster 
hinzugefügt. Falls erwünscht, kann ein zusätzlicher Datenauf-
zeichner und eine Zeitschaltuhr aus der Gruppe More modules 
zum System hinzugefügt werden. 

 

4.4.5 Bestehende Geräte installieren 

SYSTEM / Setup / New devices/ Link to existing device 
Geräte, die bereits in der Symbolleiste vorhanden 
sind, zum offenen Systemfenster hinzufügen. 
Dies wird vor allem dazu benutzt, den 761 Com-
pact IC oder die 762 IC Interface events hinzuzufü-
gen. Wählen Sie für jedes Gerät, das zum Sys-
tem hinzugefügt werden soll, das Gerät aus und 
klicken Sie auf <OK>. 

 

4.4.6 Systemparameter ausdrucken 

SYSTEM / Setup / Parameters / Print 
Ein Report der Systemparameter wird als *.rtf-Datei erstellt und 
mit dem Programm «Microsoft Word» geöffnet. Diese Datei kann 
gedruckt, gespeichert oder in andere Programme exportiert wer-
den. Der Systemreport umfasst die folgenden Elemente: 

STARTUP HARDWARE 
Name der mit dem System verknüpften Methode 
Hauptmesskanal 
Konfigurationseinstellungen für die Geräte 
Systemstartwerte 

START WITH DETERMINATION 
Objekte, die im Fenster Start mode definiert sind. 
Die Zeitprogramme werden gedruckt, falls die 
Programme eingeschaltet ("enabled") sind. 
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START WITH INJECT  
Objekte, die im Fenster Start mode definiert sind. 
Die Zeitprogramme werden gedruckt, falls die 
Programme eingeschaltet ("enabled") sind. 

 

4.4.7 Systemparameter anzeigen 

SYSTEM / Setup / Parameters / Startup hardware 
Angezeigt werden der Name der Methode, die mit dem System 
verknüpft ist, der Hauptmesskanal, die Konfigurationseinstellun-
gen für die Geräte und die Systemstartwerte. 

SYSTEM / Setup / Parameters / Start with determination 
Angezeigt werden die Objekte, die im Fenster Start mode definiert 
sind. Die Zeitprogramme werden angezeigt, falls die Programme 
eingeschaltet ("enabled") sind. 

SYSTEM / Setup / Parameters / Start with inject 
Angezeigt werden die Objekte, die im Fenster Start mode definiert 
sind. Die Zeitprogramme werden angezeigt, falls die Programme 
eingeschaltet ("enabled") sind. 
 

4.4.8 Links 

SYSTEM / Setup / Links 
Angezeigt werden alle Geräte des Systems (inklusive Watch win-
dow und Daten-Recorder). 

 

4.5 Systemstatusfenster 

 

Das Fenster SYSTEM STATE wird automatisch geöffnet, sobald ein 
System verbunden wird. Es zeigt Status- und Fehlermeldungen 
an. Meldungen mit ["Gerätename"] betreffen ein bestimmtes Gerät, 
Meldungen mit ["Ordnername"] (Name des Ordners, der die Sys-
temdatei enthält) das geladene System. Es können die folgenden 
Meldungen erscheinen: 

4.5.1 Statusmeldungen 

Checking on-line Verbindung zwischen PC und Gerät wird 
geprüft. 

On-line Verbindung zwischen PC und Gerät ok. 

UploadStartupValues Hardware- oder Systemstartwerte wurden 
im Gerät geladen. 
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Initialisation Hardware- oder Systeminitialisierung. 

Ready Gerät ist bereit. 

Starting Programm oder Datenaufnahme wird ge-
startet. 

Running Laufendes Programm oder laufende Datenauf-
nahme. 

Running program  
(xxx min left) 

Zeitprogramm läuft  
(in Klammern: verbleibende Zeit). 

Waiting for INJECT Warten auf "INJECT" um Zeitprogramm 
und/oder Datenaufnahme zu starten. 

INJECT done Injektionsventil wurde auf "INJECT" umge-
schaltet. 

Stopping Bestimmung wurde gestoppt. 

Finished Programm oder Datenaufnahme wurden 
beendet. 

SHUTDOWN System wurde abgeschaltet. 

 
4.5.2 Fehlermeldungen 

Detection of hard- 
ware failed 

Unterbrochene Verbindung zwischen PC 
und Gerät oder Gerät ausgeschaltet (Ver-
bindungskabel kontrollieren oder Gerät ein-
schalten). 

 
4.5.3 Fehlermeldungen für 761 Compact IC 

LEAK DETECTED Der Leckdetektor hat ein Leck festgestellt 
(Verbindungen kontrollieren). 

E1 Falsche Programmchecksumme (Metrohm-
Service benachrichtigen). 

E2 RAM defekt (Metrohm-Service benachrich-
tigen). 

E200 Ungültige Gerätejustierung (Metrohm-Ser-
vice benachrichtigen). 

E237 Speicherung der Konfigurationswerte miss-
glückt (letzte Aktion wiederholen; wenn der 
Fehler wieder auftritt, Metrohm-Service be-
nachrichtigen). 

E238 Speicherung der Gerätenummer missglückt 
(letzte Aktion wiederholen; wenn der Fehler 
wieder auftritt, Metrohm-Service benach-
richtigen). 
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E240 EEPROM defekt (Metrohm-Service benach-
richtigen). 

E258 Speicherung der Setup-Werte missglückt 
(letzte Aktion wiederholen; wenn der Fehler 
wieder auftritt, Metrohm-Service benach-
richtigen). 

E295 Speicherung von Werten missglückt (letzte 
Aktion wiederholen; wenn der Fehler wieder 
auftritt, Metrohm-Service benachrichtigen). 

E296 Gerät gestoppt (Gerät wieder starten; wenn 
der Fehler wieder auftritt, Metrohm-Service 
benachrichtigen). 

E297 Speicherung von Remotewerten missglückt 
(letzte Aktion wiederholen; wenn der Fehler 
wieder auftritt, Metrohm-Service benach-
richtigen). 

E298 Speicherung der Flusskorrektur missglückt 
(letzte Aktion wiederholen; wenn der Fehler 
wieder auftritt, Metrohm-Service benach-
richtigen). 

E299 Speicherung der Bremszeiten missglückt 
(letzte Aktion wiederholen; wenn der Fehler 
wieder auftritt, Metrohm-Service benach-
richtigen). 

E300 Hochdruckpumpe defekt (Pumpe wieder 
einschalten; wenn der Fehler wieder auftritt, 
Metrohm-Service benachrichtigen). 

E301 Injektionsventil blockiert (Injektionsventil 
überprüfen; wenn der Fehler wieder auftritt, 
Metrohm-Service benachrichtigen). 

E302 Suppressormodul blockiert (Suppressor 
überprüfen; wenn der Fehler wieder auftritt, 
Metrohm-Service benachrichtigen). 

E303 Speicherung der Wartungsdaten miss-
glückt (letzte Aktion wiederholen; wenn der 
Fehler wieder auftritt, Metrohm-Service be-
nachrichtigen). 
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5 Interfaces 

Das Programm «IC Net» unterstützt die Fernbedienung von Inter-
faces von Metrohm und Bischoff. Interfaces konvertieren Analog-
signale in Digitalsignale, welche vom PC verarbeitet werden kön-
nen. Sie werden als Gerätefiles (*.dev) im Verzeichnis Devices ge-
speichert. Alle Metrohm-Interfaces und Metrohm-Geräte be-
ginnen mit Me*.dev; alle Bischoff-Interfaces und Bischoff-
Geräte beginnen mit Bi*.dev. 

 

5.1 Interface-Installation 

5.1.1 Interfaces mit Systemassistent hinzufügen 

IC NET / File / New / System 
Das Fenster New system wizard und ein neues Systemfenster wer-
den geöffnet. Der Assistent New system wizard führt Sie Schritt für 
Schritt durch die Installationsroutine zur Erstellung eines neuen 
Systems. Mit <Next> wird zum nächsten Schritt bei der Systemin-
stallation umgeschaltet, mit <Back> zum vorhergehenden Schritt 
und mit <Finish> wird die Installation beendet. 

Der erste Schritt bei der Systeminstallation besteht darin, einen 
Namen für den neuen Systemordner innerhalb des Programm-
pfads ...\ICNet\Systems einzugeben. Für jede Gerätekombination 
sollte ein neuer Ordner erstellt werden. 

 

Nach dem Klicken auf <Next> erscheint das Fenster für das Hin-
zufügen von Interfaces zur Symbolleiste. Das gewünschte Inter-
face muss aus den Gruppen Metrohm Interfaces oder Bischoff In-
terfaces ausgewählt werden. Nach der Wahl der seriellen Schnitt-
stelle, an die das Interface angeschlossen ist, und nach Klicken 
auf <Add to workplace> erscheint das Interface-Symbol auf der 
Symbolleiste (PC Boards erscheinen nicht auf der Symbolleiste). 
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Für Details zu den anderen Schritten des System-Assistenten (In-
stallation von Geräten, Prozessmethode und Datenquelle) siehe 
Kap. 4.1.1.  

5.1.2 Interfaces im Fenster "Workplace" hinzufügen 

IC NET / Options / Devices setup 
Öffnet das Fenster WORKPLACE, in dem alle bereits installierten 
Interfaces und Geräte angezeigt werden. Dieses Fenster ist nur 
zugänglich für Anwender mit der Zugriffsstufe Administrator. 

 

Klicken Sie auf <Install device> um das Fenster Adding interfaces to 
your workplace zu öffnen und gehen Sie gemäss Kap. 5.1.1 vor. 

5.1.3 Interfaces löschen 

IC NET / Options / Devices setup 
Öffnet das Fenster WORKPLACE, in dem alle bereits installierten 
Interfaces und Geräte angezeigt werden. Dieses Fenster ist nur 
zugänglich für Anwender mit der Zugriffsstufe Administrator. Wäh-
len Sie das gewünschte Interface aus und klicken Sie auf <Delete 
device> um das Interface zu löschen. 
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5.2 762 IC Interface 

5.2.1 Allgemeines zum 762 IC Interface 

Das 762 IC Interface von Metrohm ist als Einsystemversion 
(2.762.0010) oder als Zweisystemversion (2.762.0020) erhältlich. 
Jedes System kann eine komplette IC- oder HPLC-Anlage steu-
ern und enthält die folgenden Teile: 
• Zwei 24-bit Analog/Digital-Konverter (ADC) für die gleichzei-

tige Aufnahme von zwei Analogsignalen von zwei verschiede-
nen Detektoren (z.B. Leitfähigkeitsdetektion und UV-Detektion). 

• Eine externe Starteingangsleitung (external start input). 

• Ein Startknopf auf der Gerätevorderseite. 

• RS232-Anschlüsse für die Steuerung von bis zu 8 Geräten. 

• Sieben Ereignis-Ausgangsleitungen (Event output lines). 

Das 762 IC Interface wird normalerweise mit dem Verbindungs-
kabel 6.2134.100 an eine PC-COM-Schnittstelle angeschlossen. 

Für weitere Informationen zum 762 IC Interface siehe Gebrauch-
sanweisung 762. 

 
5.2.2 762-Gerätesymbol auf der Symbolleiste 

 

Das 762-Gerätesymbol ist auf der Symbolleiste verfügbar, wenn 
ein 762 IC Interface mit Hilfe des Systemassistenten oder mit 
der Option <Install device> im Fenster WORKPLACE (siehe Kap. 
5.1.2) installiert wurde. Beim Klicken auf dieses Symbol öffnet 
sich das Fenster 762 IC Interface für Parametereinstellungen. 
 

5.2.3 762-Gerätesymbole im Systemfenster 

  

Die beiden Gerätesymbole 762 System 1 und 762 System 2 sind im 
Systemfenster verfügbar, wenn 762 System [1] oder 762 System [2] 
mit der Option Install existing devices (siehe Kap. 6.1.3) installiert 
wurden. 

Beim Klicken mit der rechten Maustaste auf dieses Gerätesymbol 
erscheinen die folgenden Menüpunkte: 
Open Fenster 762 System [#] für Programmierung der Ereig-

nisausgangsleitungen öffnen (dieses Fenster kann 
auch durch Doppelklick auf das Gerätesymbol geöff-
net werden). 

Unlink 762-Gerätesymbol im Systemfenster löschen. 



 5.2  762 IC Interface 
 

IC Net 2.2 39 

5.2.4 Fenster "762 IC Interface" 

762-Gerätesymbol / Open 
Die Wahl dieses Menüpunktes mit der rechten Maustaste oder 
das Anklicken des 762-Gerätesymbols auf der Symbolleiste öffnet 
das Fenster 762 IC Interface für Parametereinstellungen. Es be-
steht aus den drei Registerkarten Init, RS settings und Links. 

Init 
Die Registerkarte Init des Fensters 762 IC Interface enthält die Pa-
rameter zur Datenaufnahme für das 762 IC Interface. 

 

Label Optionale Bezeichnung für das Interface 
mit maximal 8 Zeichen. 

ROM version Nummer der Geräteprogrammversion. 

Measuring per second Anzahl der pro Sekunde gemessenen Da-
tenpunkte. 
Auswahl: 10, 20, 30, 50, 60 points/s 

Range Bereich für AD-Konverter.  
Beispiel: konvertiert ± 2500 mV zu 224 Bits 
Auswahl: 2500, 1250, 625, 312.5, 156.25, 
78.125, 39.062 mV 

Second press on RUN/STOP means 'stop' when measuring 
Ist diese Option eingeschaltet, wird die 
laufende Datenaufnahme durch Drücken 
des RUN/STOP-Knopfs auf der Gerätevor-
derseite des 762 IC Interfaces gestoppt 
(identisch mit Stop determination). 
Ist diese Option ausgeschaltet, wird die 
laufende Datenaufnahme durch Drücken 
des RUN/STOP-Knopfs auf der Gerätevor-



5  Interfaces 
 

IC Net 2.2 40 

derseite des 762 IC Interfaces nicht ge-
stoppt. 

<ASK> Aktuelle Parameter vom 762 IC Interface 
abfragen. 

<SET> Aktuelle Parameter an das 762 IC Interface 
senden. 

 

RS settings 
Die Registerkarte RS settings des Fensters 762 IC Interface enthält 
RS232-Parameter für das 762 IC Interface. 

 

Baud Rate Baudrate des Gerätes. 
Auswahl: 1200...115200 
Initialwert: 115200 

Parity Parität. 
Auswahl: None, Even, Odd 
Initialwert: None 

Handshake Software-Handshake-Modus ein-
/ausschalten. 
Auswahl: Swchar, none 
Initialwert: SWchar 

FIFO size Zwischenspeicher in Byte. 
Auswahl: 1...16 
Initialwert: 16 

<ASK> Aktuelle Parameter vom 762 IC Interface 
abfragen. 

<SET> Aktuelle Parameter an das 762 IC Interface 
senden. 
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Links 
Mit der Registerkarte Links des Fensters 762 IC Interface kann die 
COM-Schnittstelle (serielle RS232-Schnittstelle) gewechselt oder 
deren Einstellungen geändert werden. 

 

Alias Name des Interfaces oder Gerätes. 

COM # Beim Klicken dieses Eintrags mit der rech-
ten Maustaste erscheint das folgende Me-
nü: 

Put on desktop Möglichkeit zum Einstellen der Parameter 
für die COM-Schnittstelle und zum Auf-
zeichnen des Datenverkehrs (Details siehe 
On-line-Hilfe). 

Change Möglichkeit zum Wechseln der COM-
Schnittstelle. Es öffnet sich das folgende 
Fenster, in dem die COM-Schnittstelle 
durch Klicken auf die gewünschte Schnitt-
stelle gewechselt werden kann. 

 

 
5.2.5 762 Ereignisausgangsleitungen 

762 System [#] icon / Open 
Durch Wahl dieses Menüpunktes mit der rechten Maustaste oder 
durch Doppelklick auf das 762-Gerätesymbol im Systemfenster 
öffnet sich das Fenster 762 System [#], das aus den Registerkarten 
Program für das Zeitprogramm und Events setup für die Einstellung 
der sieben Ereignisausgangsleitungen besteht. 
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Zeitprogramm 
Auf der Registerkarte Program im Fenster 762 System [#] kann ein 
benutzerspezifisches Zeitprogramm für die Ereignisausgangslei-
tungen des 762 IC Interfaces eingegeben werden. Dieses Pro-
gramm wird je nach Einstellung im Fenster Start mode (siehe 
Kap. 4.4.3) entweder beim Start der Bestimmung (Start with de-
termination) oder bei der Injektion der Probe (Start with inject) au-
tomatisch gestartet. 

 

Die Registerkarte Program enthält die beiden folgenden Untersei-
ten: 

Program Hauptprogramm mit allen Programmschrit-
ten. 

Events configuration Möglichkeit zum Erstellen von benutzerspe-
zifischen Ereignisbefehlen. 

Program 
Auf der Unterseite Program können Programmschritte eingegeben 
werden, die Zeit, Befehl und Befehlsparameter umfassen. 

Zeit (1. Spalte) Zeitpunkt für Ausführung des Befehls. 
Eingabebereich: 0.0 ... 999.9 min 
Wird keine Zeit eingegeben, so wird der Be-
fehl gleichzeitig mit dem letzten Befehl aus-
geführt, der einen Zeiteintrag aufweist. 

Befehl (2. Spalte) Programmbefehl (siehe unten). 
Zusätzlich zu den vordefinierten Befehlen 
können auch benutzerspezifische Ereignis-
befehle eingefügt werden, die auf der Un-
terseite Events configuration definiert wur-
den. 

Parameter (3. Spalte) Parameter für Programmbefehl (s. u.). 

ENABLED Programm für Programmstart aktivieren (ein 
nicht aktiviertes Programm wird nicht ge-
startet). 
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<Add> Neuen Programmbefehl hinzufügen. 
<Delete> Ausgewählten Programmbefehl löschen. 
<Verify> Zeitprogramm überprüfen (im Fehlerfall er-

scheinen Fehlermeldungen). 
 

Liste der Programmbefehle 
Die folgenden Programmbefehle können auf der Unterseite Pro-
gram in das Zeitprogramm eingefügt werden: 

Befehl Parametereintrag Bedeutung 

Events 0, 1, p, * Ereignisausgangsleitungen 1...7 
auf die gewünschten Werte setzen. 
Der Wert für Leitung 1 kann direkt 
eingeben werden, bei den Leitun-
gen 2…8 muss vor der Eingabe 
zuerst der Cursor vor die gewünsch-
te Leitung bewegt werden. 

Program END, RESET Das Programmflag END kann dazu 
benutzt werden, ein Programm zu 
beenden, speziell wenn die Pro-
grammzeit länger sein soll als die 
unter Duration definierte Dauer der 
Datenaufnahme. Zusätzliche Schrit-
te nach diesem Flag sind nicht er-
laubt. Das Programmflag RESET 
dient zum Rücksetzen der Parame-
ter auf die Systemstartwerte. 

 
Events configuration 

Auf der Unterseite Events configuration können benutzerspezifi-
sche Ereignisbefehle definiert werden, welche nach Aktivieren mit 
<Activate> in ein Zeitprogramm eingefügt werden können. 

 

Name (1. Spalte) Benutzerdefinierter Name für Ereignisbefehl 
(z.B. Start_766). 
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Befehl (2. Spalte) Setzen der Ereignisausgangsleitungen 
1…7. 
Auswahl: 
 0 (Leitung aus, inaktiv, offen) 
 1 (Leitung ein, aktiv, 0 V) 
 p (Puls, Pulslänge 150 ms) 
 * (Zustand nicht verändern) 
Der Wert für Leitung 1 kann direkt eingeben 
werden, bei den Leitungen 2…8 muss vor 
der Eingabe zuerst der Cursor vor die ge-
wünschte Leitung bewegt werden. 

<Add> Neuen Ereignisbefehl hinzufügen. 
<Delete> Ausgewählten Ereignisbefehl löschen. 
<Activate> Ereignisbefehle für das Einfügen im Zeit-

programm aktivieren. 
 

 
Events setup 

Die Registerkarte Events setup des Fensters 762 System [#] enthält 
die Startwerte für die sieben Ereignisausgangsleitungen von 
System 1 oder System 2 des 762 IC Interfaces. Diese Startwerte 
werden jedes Mal gesetzt, wenn das System verbunden oder eine 
Bestimmung gestartet wird.  

 

Jede Ereignisausgangsleitung kann auf einen der folgenden Wer-
te gesetzt werden: 

0 Leitung aus, inaktiv (offen) 

1 Leitung ein, aktiv (0 V) 

Für weitere technische Spezifikationen siehe Gebrauchsanwei-
sung 762.  
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5.3 771 Compact Interface 

5.3.1 Allgemeines zum 771 Compact Interface 

Das 771 Compact Interface von Metrohm ist ein Zweikanal-
Analog/Digitalwandler für die gleichzeitige oder zeitverschobene 
Aufnahme von zwei Analogsignalen von zwei verschiedenen De-
tektoren und enthält die folgenden Teile: 
• Zwei 24-bit Analog/Digital-Konverter (ADC) für die gleichzei-

tige Aufnahme von zwei Analogsignalen von zwei verschiede-
nen Detektoren (z.B. Leitfähigkeits- und UV-Detektion). 

• Zwei externe Starteingangsleitungen (external start input). 

Das 771 Compact Interface wird normalerweise mit dem Verbin-
dungskabel 6.2134.100 an eine PC-COM-Schnittstelle ange-
schlossen. Das Kabel 6.2128.170 dient zum Anschluss des Ana-
logausgangs vom 732 IC Detector (oder einem anderen Detektor) 
und zum Start der Datenaufnahme durch Kontaktschluss vom 
733 IC Separation Center. 

Für weitere Informationen zum 771 Compact Interface siehe 
Gebrauchsanweisung 771. 
 

5.3.2 771 Gerätesymbol auf der Symbolleiste 

 

Das 771-Gerätesymbol ist auf der Symbolleiste verfügbar, wenn 
ein 771 Compact Interface mit Hilfe des Systemassistenten 
oder mit der Option <Install device> im Fenster WORKPLACE (siehe 
Kap. 5.1.2) installiert wurde. Beim Klicken auf dieses Gerätesym-
bol öffnet sich das Fenster 771 Compact Interface für Parameter-
einstellungen. 
 

5.3.3 Fenster "771 Compact Interface" 

771-Gerätesymbol / Open 
Die Wahl dieses Menüpunktes mit der rechten Maustaste oder 
das Anklicken des 771-Gerätesymbols auf der Symbolleiste öffnet 
das Fenster 771 IC Interface für Parametereinstellungen. Es be-
steht aus den drei Registerkarten Init, RS settings und Links. 

Init 
Die Registerkarte Init des Fensters 771 Compact Interface enthält 
die Parameter zur Datenaufnahme. 
Label Optionale Bezeichnung für das Interface 

mit maximal 8 Zeichen. 
ROM version Nummer der Geräteprogrammversion. 
Measuring per second Anzahl der pro Sekunde gemessenen Da-

tenpunkte. 
Auswahl: 10, 20, 30, 50, 60 points/s 
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Range Bereich für AD-Konverter.  
Beispiel: konvertiert ± 2500 mV zu 224 Bits 
Auswahl: 2500, 1250, 625, 312.5, 156.25, 
78.125, 39.062 mV 

<ASK> Aktuelle Parameter vom 771 Compact Inter-
face abfragen. 

<SET> Aktuelle Parameter an das 771 Compact 
Interface senden. 

RS settings 
Die Registerkarte RS settings des Fensters 771 Compact Interface 
enthält RS232-Parameter für das 771 Compact Interface. 

 

Baudrate Baudrate des Gerätes. 
Auswahl: 1200...115200 
Initialwert: 57600 

Parity Parität. 
Auswahl: None, Even, Odd 
Initialwert: None 

Handshake Software-Handshake-Modus ein-
/ausschalten. 
Auswahl: Swchar, none 
Initialwert: SWchar 
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<ASK> Aktuelle Parameter vom 771 Compact Inter-
face abfragen. 

<SET> Aktuelle Parameter an das 771 Compact In-
terface senden. 

Links 
Mit der Registerkarte Links des Fensters 771 IC Interface kann die 
COM-Schnittstelle (serielle RS232-Schnittstelle) gewechselt oder 
deren Einstellungen geändert werden (Details siehe Kap. 5.2.4 
Links). 

 

 

5.4 Metrohm PC Board 
Das Metrohm PC Board 2.714.0310 ist ein Zweikanal- Analog/ 
Digital-Konverter (ADC) für die gleichzeitige Aufnahme von 
zwei Analogsignalen von zwei verschiedenen Detektoren (z.B. 
Leitfähigkeitsdetektion und UV-Detektion). 

Ein oder zwei PC Boards können im selben PC installiert werden, 
wobei PC Board 1 das erste Interface und PC Board 2 das 
zweite Interface kennzeichnen. Die beiden Interfaces unterschei-
den sich dabei nur in verschiedenen Schaltereinstellungen auf 
dem Board. Als Nachfolgeprogramm für das frühere «IC Metroda-
ta for Windows» dient das Programm «IC Net» dazu, die beiden 
PC Boards zu betreiben. 

Das Kabel 6.2128.140 dient zur Anschluss des Analogausgangs 
vom 732 IC Detector (oder einem anderen Detektor) und zum 
Start der Datenaufnahme durch Kontaktschluss vom 733 IC Se-
paration Center. 

Ein Metrohm PC Board wird mit Hilfe des Systemassistenten 
oder mit der Option <Install device> im Fenster WORKPLACE (siehe 
Kap. 5.1.2) installiert. Da auf der Symbolleiste kein Symbol für das 
PC Board vorhanden ist, erscheint das PC Board nur im Fenster 
Workplace, das mit Options / Devices setup geöffnet wird. Durch 
Doppelklick auf MeBoard1 oder MeBoard2 öffnet sich das Fenster 
MeBoard# mit den folgenden Registerkarten: 

Device settings Manuelle Kontrolle und Systemstartwerte 
für PC Board (es wird empfohlen, keinen 
dieser Parameter zu ändern!). 

Links Fenster für Wahl und Einstellung der COM-
Schnittstelle (es wird empfohlen, keinen 
dieser Parameter zu ändern!). 

Für weitere Informationen zum Metrohm PC Board siehe On-line-
Hilfe und Gebrauchsanweisung zu «IC Metrodata for Win-
dows». 
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5.5 Globale Zeitschaltuhr 

5.5.1 Zeitschaltuhrsymbol 

 
Die globale Zeitschaltuhr dient zur Programmierung von System-
aktionen, die täglich oder einmalig zu einer gewünschten Zeit au-
tomatisch gestartet werden sollen. Das Zeitschaltuhrsymbol ist 
auf der Symbolleiste verfügbar, wenn ein Timer mit Hilfe des Sys-
temassistenten oder mit der Option <Install device> im Fenster 
WORKPLACE (siehe Kap. 5.1.2) installiert wurde. Beim Klicken auf 
dieses Gerätesymbol öffnet sich das Fenster Timer für Parame-
tereinstellungen. 

 

 

5.5.2 Zeitschaltuhrprogramm 

Das Fenster Timer enthält das benutzerdefinierte Programm für 
Systemaktionen auf der Registerkarte Scheduled tasks setup, die 
automatisch zu einem bestimmten Zeitpunkt gestartet werden 
sollen. Auf der Registerkarte Links kann unter Alias ein benutzer-
definierter Name für die Zeitschaltuhr eingegeben werden. In der 
Titelzeile des Fensters Timer erscheint die aktuelle Zeit in Ta-
ge:Stunden:Minuten:Sekunden, die bis zum automatischen Start 
der nächsten Aktion noch verbleibt. 

 

<New task> Neue Aktion zum Zeitprogramm hinzufügen. 
<Daily> Bei der Wahl dieser Option öffnet sich ein Un-

terfenster, in dem der Tag für den Start der Ak-
tion ausgewählt werden kann.  

<Once> Bei der Wahl dieser Option öffnet sich ein Un-
terfenster, in dem Tag und Zeitpunkt für den 
Start der Aktion ausgewählt werden können. 
Nach der Wahl des gewünschten Programm-
befehls muss die Systemdatei im Ordner Sys-
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tems ausgewählt werden, auf die der Pro-
grammbefehl angewendet werden soll. 

<Add subtask> Neue Unteraktion für die ausgewählte tägliche 
Aktion hinzufügen. Zeit und Programmbefehl 
für diese Unteraktion müssen im geöffneten 
Unterfenster eingegeben werden, die System-
datei, auf die der Programmbefehl angewen-
det werden soll, muss im Ordner Systems aus-
gewählt werden. 

<Del> Ausgewählte Aktion löschen. 

Die folgenden Programmbefehle können für benutzerdefinierte 
Ereignisse im Fenster Timer program eingegeben werden: 
Open Ausgewähltes System öffnen. 
Close Ausgewähltes System schliessen und vom 

Arbeitsplatz trennen. 
Startup Hardware des ausgewählten Systems starten 

(Startup hardware). 
Start Bestimmung mit dem ausgewählten System 

starten (Start determination). 
Stop Bestimmung mit dem ausgewählten System 

stoppen (Stop determination). 
Shutdown Hardware des ausgewählten Systems aus-

schalten (Shutdown hardware). 
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6 Geräte 

Das Programm «IC Net» unterstützt die Fernbedienung von 
Metrohm- und Bischoff-Geräten. Sie werden als Gerätedateien 
(*.dev) im Verzeichnis Devices gespeichert. Alle Metrohm-Geräte 
beginnen mit Me*.dev und alle Bischoff-Geräte beginnen mit 
Bi*.dev. 

 

 
6.1 Geräteinstallation 

 

6.1.1 Geräte bei der Systemerstellung hinzufügen 

IC NET / File / New / System 
Das Fenster New system wizard und ein neues Systemfenster wer-
den geöffnet. Der Assistent New system wizard führt Sie Schritt für 
Schritt durch die Installationsroutine zur Erstellung eines neuen 
Systems. Mit <Next> wird zum nächsten Schritt bei der Systemin-
stallation umgeschaltet, mit <Back> zum vorhergehenden Schritt 
und mit <Finish> wird die Installation beendet. 

Der erste Schritt bei der Systeminstallation besteht darin, einen 
Namen für den neuen Systemordner innerhalb des Programm-
pfads ...\ICNet\Systems einzugeben. Für jede Gerätekombination 
sollte ein neuer Ordner erstellt werden. 

 

Nach dem Klicken auf <Next> erscheint das Fenster für das Hin-
zufügen von Interfaces zur Symbolleiste (Details siehe Kap. 4.1.1). 

Nach dem Klicken auf <Next> erscheint das Fenster für das Hin-
zufügen von Geräten zum Systemfenster.  
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Öffnen Sie für jedes Gerät, das mit «IC Net» gesteuert werden 
soll, die entsprechende Gruppe, die dieses Gerät enthält. Wählen 
Sie das Gerät und die serielle Schnittstelle Serial port des Inter-
faces, an dem das Gerät angeschlossen ist. Nach Klicken auf 
<Add to system> erscheint das Gerätesymbol im Systemfenster. 
Falls erwünscht, kann ein zusätzlicher Datenaufzeichner und eine 
Zeitschaltuhr aus der Gruppe More modules zum System hinzuge-
fügt werden. Für Details zu den anderen Schritten des System-
Assistenten (Prozessmethode und Datenquelle) siehe Kap. 4.1.1. 

6.1.2 Neue Geräte im Systemfenster hinzufügen 

SYSTEM / Setup / New devices/ Install new device 
Neue Geräte mit dem Assistenten New system wizard ins geöffne-
te Systemfenster hinzufügen (siehe oben). Öffnen Sie für jedes 
Gerät, das mit «IC Net» gesteuert werden soll, die entsprechende 
Gruppe, die dieses Gerät enthält. Wählen Sie das Gerät und die 
serielle Schnittstelle des Interfaces, an dem das Gerät ange-
schlossen ist. Nach Klicken auf <Add to system> erscheint das Ge-
rätesymbol im Systemfenster. Falls erwünscht, kann ein zusätzli-
cher Datenaufzeichner und eine Zeitschaltuhr aus der Gruppe Mo-
re modules zum System hinzugefügt werden. 

6.1.3 Bereits vorhandene Geräte im Systemfenster hinzufügen 

SYSTEM / Setup / New devices/ Link to existing device 
Geräte, die bereits auf der Symbolleiste vorhanden sind, im ge-
öffneten Systemfenster hinzufügen. Dies wird meistens dazu be-
nutzt, die Objekte 762 IC Interface events hinzuzufügen. Wählen Sie 
das Gerät, das zum System hinzugefügt werden soll, aus und kli-
cken Sie auf <OK>. 

6.1.4 Geräte löschen 

Icon / Unlink 
Geräte in einem Systemfenster können gelöscht werden, indem 
mit der rechten Maustaste auf das Gerätesymbol geklickt und der 
Menüpunkt Unlink gewählt wird. 
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6.2 Messwertanzeige (Watch window) 

6.2.1 Symbol für Watch window 

 

Das Bildschirmsymbol ist eines der Elemente, das immer in ei-
nem neuen Systemfenster vorhanden ist. Falls das System ver-
bunden ist und mit der rechten Maustaste auf das PC-Symbol 
geklickt wird, erscheinen die folgenden Menüpunkte: 

Open Fenster WATCH WINDOW für Anzeige der  
aktuellen Messwerte für Leitfähigkeit und 
Druck öffnen (dieses Fenster kann auch 
durch Doppelklick auf das Bildschirmsym-
bol geöffnet werden).  

Unlink Bildschirmsymbol WATCH WINDOW aus 
dem Systemfenster löschen (wird nicht 
empfohlen). 

6.2.2 Einstellungen für Watch window 

Watch window icon / Open 
Im Fenster WATCH WINDOW werden die aktuellen Parameter der 
zum verbundenen System gehörenden Interfaces und Geräte an-
gezeigt. Mit SYSTEM / Setup / Watch window (siehe Kap. 4.4.2) kann 
dieses Fenster bei jedem Start einer Bestimmung oder Basisli-
nienaufzeichnung automatisch geöffnet werden. 

Das Fenster WATCH WINDOW kann manuell konfiguriert werden, 
indem der graue Rahmen innerhalb des Fenster mit der rechten 
Maustaste angeklickt wird. Dabei öffnet sich das folgende Menü: 

Manual arrange Möglichkeit zur Auswahl der Parameter, die 
angezeigt werden sollen oder zum Umstel-
len der Reihenfolge der angezeigten Para-
meter. Diese Option öffnet das Fenster Data 
source für die Auswahl der im Watch win-
dow anzuzeigenden Parameter. Im Feld 
Connected erscheinen die Parameter, die 
angezeigt werden, im Feld Available dieje-
nigen, die nicht angezeigt werden. Mit Hilfe 

der Knöpfe    oder    können die Pa-
rameter von einem Feld ins andere ver-
schoben werden. 

Auto arrange Automatische Anordnung aller wichtiger Pa-
rameter. 



 6.2  Messwertanzeige (Watch window) 
 

IC Net 2.2 53 

Die Farbeinstellungen der Felder im Watch window und im 
Fenster SYSTEM STATE können durch Klicken auf das Feld mit 
der rechten Maustaste und Wählen der folgenden Menüpunkte 
geändert werden: 

Choose color / Foreground / Out of range 
Farbeinstellung für Zahlen bei Messwerten 
ausserhalb des zulässigen Bereichs ("Over-
flow" oder ausserhalb der Grenzwerte). 

Choose color / Foreground / In range 
Farbeinstellung für Zahlen bei Messwerten 
innerhalb des normalen Bereichs. 

Choose color / Foreground / Active 
Farbeinstellung für Zeichen im Fenster  
SYSTEM STATE bei laufenden Aktionen. 

Choose color / Foreground / Passive 
Farbeinstellung für Zeichen im Fenster  
SYSTEM STATE bei beendeten Aktionen. 

Choose color / Background / Out of range 
Farbeinstellung für Feldhintergrund bei 
Messwerten ausserhalb des zulässigen  
Bereichs ("Overflow" oder ausserhalb der 
Grenzwerte). 

Choose color / Background / In range 
Farbeinstellung für Feldhintergrund bei 
Messwerten innerhalb des normalen  
Bereichs. 

Choose color / Background / Active 
Farbeinstellung für Feldhintergrund im 
Fenster SYSTEM STATE bei laufenden  
Aktionen. 

Choose color / Background / Passive 
Farbeinstellung für Feldhintergrund im 
Fenster SYSTEM STATE bei beendeten  
Aktionen. 

Die für diese Felder gewählten Farbeinstellungen gelten auch für 
die Messwert-Anzeigefelder auf den Registerkarten Control der In-
terfaces und Geräte. 
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6.3 732 IC Detector 

6.3.1 Allgemeines zum 732 IC Detector 

Der 732 IC Detector von Metrohm ist ein Leitfähigkeitsdetektor 
für die Ionenchromatographie. Der dazugehörige thermostatisier-
bare Detektorblock kann für die Aufnahme von Chromatogram-
men mit und ohne chemische Suppression verwendet werden 
und wird normalerweise im 733 IC Separation Center installiert. 
Erhältlich sind die beiden folgenden Versionen: 

• 2.732.0010 IC Detector mit Standard-Detektorblock 

• 2.732.0110 IC Detector mit metallfreiem Detektorblock 

Der 732 IC Detector, der normalerweise über die Gerätetastatur 
bedient wird, kann vollständig mit dem Programm «IC Net» ge-
steuert werden. Dazu wird der 732 IC Detector mit Hilfe des Ka-
bels 6.2134.080 oder 6.2134.090 am 762 IC Interface ange-
schlossen. Beispiele für Zusammenschaltungen mit dem 732 IC 
Detector finden sich in der Gebrauchsanweisung 762. 

 
Um den 732 IC Detector mit «IC Net» zu betreiben, müssen die 
RS-Parameter mit Hilfe der Taste [ CONFIG ] auf dem 732 IC De-
tector wie folgt eingestellt werden: 
 >CONFIG/RS settings/handshake: Swchar

>CONFIG/RS settings/RS control: on 

 
Für weitere Informationen zum 732 IC Detector siehe Gebrauch-
sanweisung 732/733. 

 

 

6.3.2 Symbol für 732 IC Detector  

 

Das 732-Gerätesymbol ist im Systemfenster verfügbar, wenn ein 
732 IC Detector mit Hilfe des Systemassistenten New system wizard 
oder mit der Option Setup/New devices/Install new device installiert 
wurde (siehe Kap. 6.1.2). 

Falls das System verbunden ist und das 732-Gerätesymbol mit 
der rechten Maustaste angeklickt wird, erscheint das folgende 
Menü: 

Open Fenster 732 IC Detector für Parametereinstellungen öff-
nen (dieses Fenster kann auch durch Doppelklick auf 
das Gerätesymbol geöffnet werden). 

Unlink 732-Gerätesymbol im Systemfenster löschen. 
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6.3.3 Fenster "732 IC Detector" 

732-Gerätesymbol / Open 
Die Wahl dieses Menüpunktes mit der rechten Maustaste oder ein 
Doppelklick auf das 732-Gerätesymbol öffnet das Fenster 732 IC 
Detector für Parametereinstellungen. Es besteht aus den vier Re-
gisterkarten Display, Method parameter, Program und Links. 

Display 
Die Registerkarte Display des Fensters 732 IC Detector ist nur bei 
einem verbundenem System verfügbar. Sie zeigt die aktuellen 
Messwerte und Parametereinstellungen des 732 IC Detectors. 

 

Conductivity Anzeige des aktuellen Messwertes für die 
Leitfähigkeit (Autozero-Wert) in µS/cm. Die-
ses Feld ist für das WATCH WINDOW ver-
fügbar. Die Farben wechseln dabei zu den 
Einstellungen für Out of range, falls der 
Messwert mehr als 80% ausserhalb des 
Full-Scale-Bereichs liegt. 

abs. Cond. Anzeige des aktuellen Messwertes für die 
absolute Leitfähigkeit in µS/cm. Dieses Feld 
ist für das WATCH WINDOW verfügbar. Die 
Farben wechseln dabei zu den Einstellun-
gen für Out of range, falls der Messwert 
≥ 110% des Messbereichs Range beträgt. 
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Ion Anzeige der Ioneneinstellung: 
Anion:  polarity = +, temperature coeff. = 2.5 
Cation: polarity = –, temperature coeff. = 1.5 

Range Anzeige des Messbereichs in µS/cm. 
Full scale Anzeige des Full-Scale-Bereichs in µS/cm. 
Cell const. Anzeige der Zellkonstante der Leitfähig-

keitsmesszelle in /cm. 
Thermostat Anzeige der Temperatur innerhalb des De-

tektorblocks. 
Offset Anzeige des Nullpunktversatzes. 
Damping Anzeige der elektronischen Dämpfung des 

Analogausgangs. 

Zero <ON> Auslösung der Autozero-Funktion. 
Zero <OFF> Ausschalten der Autozero-Funktion. 

<Ask all> Alle angezeigten Werte aktualisieren. 

<Import in method parameters> 
Angezeigte Parameter in Registerkarte Me-
thod parameter kopieren. 

Method parameter 
Die Registerkarte Method parameter des Fensters 732 IC Detector 
enthält die Methodenstartparameter für das Gerät. Diese Werte 
werden am 732 IC Detector gesetzt, wenn sie manuell mit <SET> 
geschickt werden oder wenn Start determination und Startup hard-
ware gewählt wird. 
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Range Messbereich in µS/cm  
Auswahl: 100, 200, 500 µS/cm und  
1, 2, 5, 10 mS/cm 

Full scale Der Full-Scale-Bereich (Arbeitsbereich) be-
stimmt die gewünschte Empfindlichkeit für 
den Analogausgang. Die möglichen Werte 
für den Full-Scale-Bereich in µS/cm hängen 
vom eingestellten Messbereich Range ab. 

Ion Kombination von Polarität und Temperatur-
koeffizient: 

Anion polarity = +, temperature coeff. = 2.5 
Cation polarity = –, temperature coeff. = 1.5 

Custom Unabhängige Wahl von Polarity und Tempe-
rature coeff. 

Polarity Polarität des Analogausgangssignals: 
+ Positive Polarität (z.B. für Anionen) 
– Negative Polarität (z.B. für Kationen) 

Temperature coeff. Automatische Umrechnung der bei der Ar-
beitstemperatur der Messzelle gemessenen 
Leitfähigkeit auf die Referenztemperatur 
20°C. 
Auswahl: 1.5, 2.5 %/°C 

Cell constant Zellkonstante der Leitfähigkeitsmesszelle in 
/cm. 
Bereich: 13 ... 21 /cm 

Thermostat Arbeitstemperatur der Leitfähigkeitsmess-
zelle innerhalb des Detektorblocks. 
Auswahl: 25, 30, 35, 40, 45 °C und off 

Offset Versatz des Nullpunkts der Leitfähigkeit. 
Auswahl: 0, 10, 50 %fs 

Damping Elektronische Dämpfung des Analogaus-
gangssignals. 
Auswahl: on, off 

<SET> Aktuelle Parameter sofort zum 732 IC De-
tector schicken. Die Parameter werden erst 
in der Systemdatei (*.smt) gespeichert, 
wenn die Datei gesichert wird. 

Für weitere Informationen zu den Parametern für den 732 IC De-
tector siehe Gebrauchsanweisung 732/733. 

Zeitprogramm 
Auf der Registerkarte Program im Fenster 732 IC Detector kann ein 
benutzerspezifisches Zeitprogramm eingegeben werden. Dieses 
Programm wird je nach Einstellung im Fenster Start mode (siehe 
Kap. 4.4.3) entweder beim Start der Bestimmung (Start with de-
termination) oder bei der Injektion der Probe (Start with inject) au-
tomatisch gestartet. 
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Die Registerkarte Program enthält die beiden folgenden Untersei-
ten: 
Program Hauptprogramm mit allen Programmschrit-

ten. 
Remote configuration Möglichkeit zum Erstellen von benutzerspe-

zifischen Remotebefehlen. 

Program 
Auf der Unterseite Program können Programmschritte eingegeben 
werden, die Zeit, Befehl und Befehlsparameter umfassen. 

Zeit (1. Spalte) Zeitpunkt für Ausführung des Befehls. 
Eingabebereich: 0.0 ... 999.9 min 
Wird keine Zeit eingegeben, so wird der Be-
fehl gleichzeitig mit dem letzten Befehl aus-
geführt, der einen Zeiteintrag aufweist. 

Befehl (2. Spalte) Programmbefehl (siehe unten). 
Zusätzlich zu den vordefinierten Befehlen 
können auch benutzerspezifische Remote-
befehle eingefügt werden, die auf der Un-
terseite Remote configuration definiert wur-
den. 

Parameter (3. Spalte) Parameter für Programmbefehl (s.u.). 

ENABLED Programm für Programmstart aktivieren (ein 
nicht aktiviertes Programm wird nicht ge-
startet). 

Will be executed by Auswahl, ob das Zeitprogramm via PC oder 
732 unit ausgeführt werden soll. 

<Add> Neuen Programmbefehl hinzufügen. 
<Delete> Ausgewählten Programmbefehl löschen. 
<Verify> Zeitprogramm überprüfen (im Fehlerfall er-

scheinen Fehlermeldungen). 
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Liste der Programmbefehle 
Die folgenden Programmbefehle können auf der Unterseite Pro-
gram in das Zeitprogramm eingefügt werden: 

Befehl  Parametereintrag Bedeutung 

Remote 0, 1, * Setzen der Remoteausgangsleitun-
gen 1...8 auf die gewünschten Werte. 
Der Wert für Leitung 1 kann direkt 
eingeben werden, bei den Leitungen 
2…8 muss vor der Eingabe zuerst 
der Cursor vor die gewünschte Lei-
tung bewegt werden. 

Flag reset, end Programmflag setzen. Das Pro-
grammflag end kann dazu benutzt 
werden, ein Programm zu beenden, 
speziell wenn die Programmzeit län-
ger sein soll als die unter Duration 
definierte Dauer der Datenaufnahme. 
Zusätzliche Schritte nach diesem 
Flag sind nicht erlaubt. Das Pro-
grammflag reset dient zum Rückset-
zen der Parameter auf die System-
startwerte. 

Range 100, 200, 5000 µS/cm
1, 2, 5, 10 mS/cm 

Messbereich auf ausgewählten Wert 
setzen. 

FS 0.05 µS/cm ...  
10 mS/cm 

Full-Scale-Bereich auf ausgewählten 
Wert setzen (hängt von der Einstel-
lung für Range ab). 

Zero on, off Autozero ein-/ausschalten. 

Polarity +, – Polarität des Ausgangssignals neu 
setzen. 

Mark  Markierungssignal auslösen. 

ValveA fill, inject Injektionsventils A auf "inject" oder 
"fill" umschalten. 

ValveB fill, inject Injektionsventils B auf "inject" oder 
"fill" umschalten. 

Suppressor  Suppressormodul in nächste Positi-
on weiterschalten. 

PumpRS on, off Die am 732 IC Detector angeschlos-
sene Hochdruckpumpe ein-/aus-
schalten. 

Flow 0.01 ... 5 mL/min Flussrate der Hochdruckpumpe auf 
den gewünschten Wert setzen. 
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Befehl  Parametereintrag Bedeutung 

Pmax 0.0 ... 25.0 MPa Maximalen Abschaltdruck für die am 
732 IC Detector angeschlossene 
Hochdruckpumpe auf den ge-
wünschten Wert setzen. 

Pmin 0.0 ... 25.0 MPa Minimalen Abschaltdruck für die am 
732 IC Detector angeschlossene 
Hochdruckpumpe auf den ge-
wünschten Wert setzen. 

 
Remote configuration 

Auf der Unterseite Remote configuration können benutzerspezifi-
sche Remotebefehle definiert werden, welche nach Aktivieren mit 
<Activate> in ein Zeitprogramm eingefügt werden können. 

 

Name (1. Spalte) Benutzerdefinierter Name für Remotebefehl 
(z.B. Start_766). 

Remotebefehl (2. Spalte) 
Setzen der Remoteausgangsleitungen 
1…8. 
 0 (Leitung aus, inaktiv, offen) 
 1 (Leitung ein, aktiv, 0 V) 
 * (Zustand nicht verändern) 
Der Wert für Leitung 1 kann direkt eingeben 
werden, bei den Leitungen 2…8 muss vor 
der Eingabe zuerst der Cursor vor die ge-
wünschte Leitung bewegt werden. 

<Add> Neuen Remotebefehl hinzufügen. 
<Delete> Ausgewählten Remotebefehl löschen. 
<Activate> Remotebefehle für das Einfügen im Zeit-

programm aktivieren. 

Links 
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Die Registerkarte Links im Fenster 732 IC Detector dient zur Wahl 
und Einstellung der COM-Schnittstelle (Details siehe Kap. 5.2.4 
Links). 

6.4 761 Compact IC 

6.4.1 Allgemeines zum 761 Compact IC 

Das 761 Compact IC von Metrohm ist ein PC-gesteuertes Sys-
tem für ionenchromatographische Analysen, von dem die beiden 
folgenden Versionen erhältlich sind: 

• 2.761.0010 Compact IC ohne Suppressormodul 
• 2.761.0020 Compact IC mit Suppressormodul 

Alle Bestandteile des 761 Compact IC wie Injektionsventil, Hoch-
druckpumpe, Leitfähigkeitsdetektor, Suppressormodul und 
Schlauchquetschpumpe werden normalerweise vollständig via 
PC-Programm «761 Compact IC» gesteuert. Das 761 Compact 
IC kann aber auch via PC-Programm «IC Net» betrieben werden. 
Dieses Programm erlaubt es zudem, mehr als ein 761 Compact 
IC mit einem PC zu betreiben. 

Das 761 Compact IC wird normalerweise mit dem Verbindungs-
kabel 6.2134.100 an eine PC-COM-Schnittstelle angeschlossen. 

Für weitere Informationen zum 761 Compact IC siehe 
Gebrauchsanweisung 761. 

 

6.4.2 761-Gerätesymbol 

   

System getrennt System verbunden System verbunden 
 Injektionsventil in  Injektionsventil in  
 Position "INJECT" Position "FILL"  

Das 761-Gerätesymbol ist im Systemfenster verfügbar, wenn das 
Gerät 761 Compact IC mit der Option Install existing devices (siehe 
Kap. 6.1.3) installiert wurde. Falls das System verbunden ist, ent-
hält das 761-Gerätesymbol zwei Knöpfe für die manuelle Steue-
rung des Injektionsventils am 761 Compact IC: 
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<Inject> Injektionsventil in Stellung "Inject" umschalten. 

<Fill> Injektionsventil in Stellung "Fill" umschalten. 

Beim Klicken mit der rechten Maustaste auf das 761-Geräte-
symbol erscheinen die folgenden Menüpunkte: 

Open Fenster 761 Compact IC für Parametereinstellun-
gen öffnen (kann auch durch Doppelklick auf das 
Gerätesymbol geöffnet werden). 

Hardware Öffnen des Fensters für Hardwareeinstellungen. 

Diagnostics Öffnen des Diagnosefensters (nur für Service-
techniker). 

Unlink 761-Gerätesymbol im Systemfenster löschen. 

 

6.4.3 Fenster "761 Compact IC" 

761-Gerätesymbol / Open 
Die Wahl dieses Menüpunktes mit der rechten Maustaste oder ein 
Doppelklick auf das Gerätesymbol auf der Symbolleiste öffnet 
das Fenster 761 Compact IC für Parametereinstellungen. Es enthält 
die Registerkarten Control, Initial, Program, Configuration und Links. 

Control 
Die Registerkarte Control im Fenster 761 Compact IC ist nur für ein 
verbundenes System verfügbar. Es erlaubt die manuelle 
Steuerung der Gerätefunktionen des 761 Compact IC und das 
Setzen von Startwerten, die an das Gerät gesendet werden. 
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Conductivity, µS/cm Anzeige der aktuell gemessenen Leitfähig-
keit. 

Pressure, MPa Anzeige des aktuell gemessenen Drucks. 
Die Farbeinstellungen der beiden Anzeige-
felder können durch Klicken auf das Feld 
mit der rechten Maustaste geändert werden 
(siehe Kap. 6.2.2). 

Actual values Anzeige der aktuellen Geräteparameter. 
Flow, mL/min Anzeige der aktuellen Flussrate der Hoch-

druckpumpe. 
Pressure max, MPa Anzeige des maximalen Abschaltdrucks für 

die Hochdruckpumpe. 
Pressure min, MPa Anzeige des minimalen Abschaltdrucks für 

die Hochdruckpumpe. 
Full scale, µS/cm Anzeige des gewählten Full-Scale-Bereichs. 
Remote lines Anzeige des aktuellen Zustands der  

Remoteausgangsleitungen. 

Valve Injektionsventil. 
<Inject> Injektionsventil in Position "INJECT" um-

schalten. 
<Fill> Injektionsventil in Position "FILL" umschal-

ten. 

Suppressor Suppressormodul. 
<Step> Suppressormodul in die nächste Position 

weiterschalten. 
Im Feld neben <Step> wird die Zeit seit dem 
letzten Weiterschalten angezeigt. 

IC pump Hochdruckpumpe. 
<On> Hochdruckpumpe einschalten. 
<Off> Hochdruckpumpe ausschalten. 

Peristaltic Schlauchpumpe. 
<On> Schlauchpumpe einschalten. 
<Off> Schlauchpumpe ausschalten. 

System startup values Die Systemstartwerte werden beim Verbin-
den des Systems, beim Start einer Bestim-
mung oder beim manuellen Senden mit 
<Send to unit> am Compact IC 761 gesetzt. 

Flow, mL/min Startwert für Flussrate der Hochdruckpumpe. 
Eingabebereich: 0.20 ... 2.50 mL/min 

Pressure max, MPa Startwert für maximalen Abschaltdruck für 
die Hochdruckpumpe. Dieser Wert wird 
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auch ohne Verbindung zum PC überwacht.  
Eingabebereich: 0.0 ... 25.0 MPa 

Pressure min, MPa Startwert für minimalen Abschaltdruck für 
die Hochdruckpumpe. Dieser Wert wird 
auch ohne Verbindung zum PC überwacht. 
Eingabebereich: 0.0 ... 25.0 MPa 

Full scale, µS/cm Startwert für Full-Scale-Bereich. 
Auswahl: 50, 250, 1000 µS/cm 

Remote lines Startwerte für Zustand der Remoteaus-
gangsleitungen 1…8. 
Auswahl: 0, 1 

Initial 
Die Registerkarte Initial im Fenster 761 Compact IC für das Setzen 
von Systemstartwerten erscheint nur bei einem getrennten Sys-
tem. 

 
Flow, mL/min Startwert für Flussrate der Hochdruckpum-

pe. 
Eingabebereich: 0.20 ... 2.50 mL/min 

Pressure max, MPa Startwert für maximalen Abschaltdruck für 
die Hochdruckpumpe. 
Eingabebereich: 0.0 ... 25.0 MPa 

Pressure min, MPa Startwert für minimalen Abschaltdruck für 
die Hochdruckpumpe. 
Eingabebereich: 0.0 ... 25.0 MPa 

Full scale, µS/cm Startwert für Full-Scale-Bereich. 
Auswahl: 50, 250, 1000 µS/cm 

Remote lines Startwerte für Zustand der Remoteaus-
gangsleitungen 1…8. 
Auswahl: 0, 1 

Zeitprogramm 
Auf der Registerkarte Program im Fenster 761 Compact IC kann ein 
benutzerspezifisches Zeitprogramm für die Remoteausgangslei-
tungen am 761 Compact IC eingegeben werden. Dieses Pro-
gramm wird je nach Einstellung im Fenster Start mode (siehe 
Kap. 4.4.3) entweder beim Start der Bestimmung (Start with de-
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termination) oder bei der Injektion der Probe (Start with inject) au-
tomatisch gestartet. 

 

Die Registerkarte Program enthält die beiden folgenden Untersei-
ten: 

Program Hauptprogramm mit allen Programm-
schritten. 

Remote configuration Möglichkeit zum Erstellen von benutzer-
spezifischen Remotebefehlen. 

Program 
Auf der Unterseite Program können Programmschritte eingegeben 
werden, die Zeit, Befehl und Befehlsparameter umfassen. 

Zeit (1. Spalte) Zeitpunkt für Ausführung des Befehls. 
Eingabebereich: 0.0 ... 999.9 min 
Wird keine Zeit eingegeben, so wird der Be-
fehl gleichzeitig mit dem letzten Befehl aus-
geführt, der einen Zeiteintrag aufweist. 

Befehl (2. Spalte) Programmbefehl (siehe unten). 
Zusätzlich zu den vordefinierten Befehlen 
können auch benutzerspezifische Remote-
befehle eingefügt werden, die auf der Un-
terseite Remote configuration definiert wur-
den. 

Parameter (3. Spalte) Parameter für Programmbefehl (siehe un-
ten). 

ENABLED Programm für Programmstart aktivieren (ein 
nicht aktiviertes Programm wird nicht ge-
startet). 

<Add> Neuen Programmbefehl hinzufügen. 

<Delete> Ausgewählten Programmbefehl löschen. 
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<Verify> Zeitprogramm überprüfen (im Fehlerfall er-
scheinen Fehlermeldungen). 

Liste der Programmbefehle 
Die folgenden Programmbefehle können auf der Unterseite Pro-
gram in das Zeitprogramm eingefügt werden: 

Befehl  Parametereintrag Bedeutung 

Valve Inject, Fill Injektionsventil in Position "IN-
JECT" oder "FILL" umschalten. 

FullScale 50, 250, 1000 
µS/cm 

Full-Scale-Bereich auf den ge-
wünschten Wert setzen. 

ICPump on, off Hochdruckpumpe ein- oder aus-
schalten. 

Flow 0.2 ... 2.5 mL/min Flussrate der Hochdruckpumpe 
auf den gewünschten Wert setzen. 

Pmax 0.0 ... 25.0 MPa Maximalen Abschaltdruck für 
Hochdruckpumpe auf den ge-
wünschten Wert setzen. 

Pmin 0.0 ... 25.0 MPa Minimalen Abschaltdruck für 
Hochdruckpumpe auf den ge-
wünschten Wert setzen. 

Remote 0, 1, *, p Remoteausgangsleitungen 1...8 
auf die gewünschten Werte setzen. 
Der Wert für Leitung 1 kann direkt 
eingegeben werden, bei den Lei-
tungen 2…8 muss vor der Eingabe 
zuerst der Cursor vor die ge-
wünschte Leitung bewegt werden 

Program END, RESET Das Programmflag END kann dazu 
benutzt werden, ein Programm zu 
beenden, speziell wenn die Pro-
grammzeit länger sein soll als die 
unter Duration definierte Dauer der 
Datenaufnahme. Zusätzliche 
Schritte nach diesem Flag sind 
nicht erlaubt. Das Programmflag 
RESET dient zum Rücksetzen der 
Parameter auf die Systemstartwer-
te. 

Suppressor  Suppressormodul in nächste Po-
sition weiterschalten. 

Peristaltic on, off Schlauchpumpe ein- oder aus-
schalten. 
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Remote configuration 
Auf der Unterseite Remote configuration können benutzerspezifi-
sche Remotebefehle definiert werden, welche nach Aktivierung 
mit <Activate> in ein Zeitprogramm eingefügt werden können. 

 

Name (1. Spalte) Benutzerdefinierter Name für Remotebefehl 
(z.B. Start_766). 

Remotebefehl (2. Spalte) 
Setzen der Remoteausgangsleitungen 1…8. 
 0 (Leitung aus, inaktiv, offen) 
 1 (Leitung ein, aktiv, 0 V) 
 p (Ausgabe eines Pulses) 
 * (Zustand nicht verändern) 
Der Wert für Leitung 1 kann direkt eingeben 
werden, bei den Leitungen 2…8 muss vor 
der Eingabe zuerst der Cursor vor die ge-
wünschte Leitung bewegt werden. 

<Add> Neuen Remotebefehl hinzufügen. 
<Delete> Ausgewählten Remotebefehl löschen. 
<Activate> Remotebefehle für das Einfügen im Zeit-

programm aktivieren. 
 

Configuration 
Die Registerkarte Configuration enthält Konfigurationseinstellun-
gen für den Compact IC 761. 
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761 unit version Wahl der Gerätevariante: 
761.0010 = 761 Compact IC ohne Suppr. 
761.0020 = 761 Compact IC mit Suppressor 

Suppressor Suppressormodul: 
Autostep with Automatisches Weiterschalten in die nächs-

te Position beim Umschalten des Injektions-
ventils in die Stellung Fill oder Inject. 

Use peristaltic pump Wird diese Option ausgeschaltet, so wird 
die Schlauchpumpe bei Startup hardware 
oder beim Start einer Bestimmung nicht 
gestartet. 

Polarity Wahl der Polarität für das Ausgangssignal: 
+ positive Polarität (für Anionen) 
– negative Polarität (für Kationen) 

Measure channel Anzeige der im Fenster Data source gewähl-
ten Datenquelle (siehe Kap. 6.19.2). 

Links 
Die Registerkarte Links im Fenster 761 Compact IC dient zur Wahl 
und Einstellung der COM-Schnittstelle (Details siehe Kap. 5.2.4 
Links). 
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6.4.4 Hardwareeinstellungen 

Die Wahl des Menüpunktes Hardware beim Klicken mit der rech-
ten Maustaste auf das 761-Gerätesymbol öffnet das Fenster für 
die Hardwareeinstellungen, das aus den drei Seiten Hardware, 
Outputs und Alarm stops besteht. 

Hardware 
Die Registerkarte Hardware im Fenster für die Hardwareeinstellun-
gen enthält allgemein gültige Einstellungen, die beim Einschalten 
des Gerätes automatisch gesetzt werden. 

 

Remote lines after power on 
Die Ausgangsleitungen 1… 8 werden nach 
dem Einschalten des Gerätes oder nach ei-
nem Notstopp mit Shutdown hardware auf 
die hier definierten Werte gesetzt. 
Auswahl:  0, 1 

Thermostat Betriebstemperatur der Leitfähigkeitsmess-
zelle. 
Auswahl: 25, 30, 35, 40, 45 °C, off 

 
Die Thermostatierung funktioniert nur dann, wenn die 
Umgebungstemperatur mindestens 5 °C tiefer ist als 
die Betriebstemperatur. Normalerweise dauert es et-
wa 30…60 min, bis die Betriebstemperatur mit einer 
Temperaturstabilität von ± 0.01 °C erreicht ist. 

Flow correction Korrekturfaktor zur Berücksichtigung der 
Abweichung der angezeigten von der tat-
sächlichen Flussrate der Hochdruckpumpe. 
Bereich:  0.9 ... 1.09 

Der Korrekturfaktor wird durch Messen der 
tatsächlichen Flussrate mit Hilfe eines 
Messzylinders wie folgt ermittelt: 
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Flow correction =   
Angezeigte Flussrate 

Gemessene Flussrate

Cell constant Zellkonstante der Leitfähigkeitsmesszelle 
für korrekte Anzeige der absoluten Leitfä-
higkeit. Geben Sie in diesem Feld den auf 
dem Detektorblock aufgedruckten Wert ein. 
Bereich:  0.1 ... 99.9 /cm 

Um die Zellkonstante selber zu ermitteln, 
muss eine Kalibrierlösung mit bekannter 
Leitfähigkeit durch das IC-System gepumpt 
werden. Beobachten Sie die angezeigte 
Leitfähigkeit und ändern Sie die Zellkon-
stante, bis die korrekte Leitfähigkeit ange-
zeigt wird. 

<Break times> Möglichkeit zum Ändern der Bremszeiten 
für das Injektionsventil Valve und das 
Suppressormodul Suppressor.  

 

Ändern Sie diese Werte nur in Absprache 
mit dem Metrohm-Service. 

 
Outputs 

Auf der Registerkarte Outputs wird die automatische Ausgabe von 
Remoteausgangssignalen für bestimmte Ereignisse definiert. 

 

Event Ereignisse für automatische Remotesignal-
ausgabe:  
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Inject Umschalten des Injektionsventils in die Po-
sition "INJECT". 

Fill Umschalten des Injektionsventils in die Po-
sition "FILL". 

Suppressor step Weiterschalten des Suppressormoduls in 
die nächste Position. 

Pump stop (P max/min) 
Pumpe gestoppt wegen Verletzung der 
Druckgrenzwerte. 

Hardware error Hardwarefehler am Compact IC 761 (Hoch-
druckpumpe, Injektionsventil oder Suppres-
sor arbeiten nicht richtig). 

Alarm leak detector Leck im Innenraum. 

Remote line Setzen der Ausgangsleitungen 1…8. 
Auswahl: 0 (Leitung aus, inaktiv, offen) 
 1 (Leitung ein, aktiv, 0 V) 
 p  (Ausgabe eines Pulses) 
 * (Zustand nicht verändern) 

PowerOn values Anzeige der auf der Seite Hardware gesetz-
ten Werte für die Remoteausgangsleitun-
gen beim Einschalten des Gerätes. 

Pulse length Pulslänge in ms. 
 
 

Alarm stops 
Auf der Registerkarte Alarm stops werden die Ereignisse definiert, 
bei denen das Gerät sofort gestoppt werden soll. Bei einem 
Alarmstopp werden Hochdruck- und Schlauchpumpe sofort ge-
stoppt, die Bestimmung und die Abarbeitung einer aktiven Pro-
bentabelle werden abgebrochen. 

 

Event Ereignisse für Alarmstopp:  
Pump stop Pumpe gestoppt wegen Verletzung der 

Druckgrenzwerte. 
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Hardware error Hardwarefehler am Compact IC 761 (Hoch-
druckpumpe, Injektionsventil oder Suppres-
sor arbeiten nicht richtig). 

Leak Leck im Innenraum. Diese Information wird 
auch im Gerät selbst gespeichert, d.h. dass 
das Gerät bei einem Leck auch ohne Ver-
bindung zum PC automatisch gestoppt 
wird. 

Power on Stromunterbruch am 761 Compact IC. 
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6.5 817 Bioscan 

6.5.1 Allgemeines zum 817 Bioscan 

Der 817 Bioscan von Metrohm ist ein gepulster, amperometri-
scher Detektor, der in einem modularen IC-System verwendet 
werden kann. Mit diesem Gerät lassen sich vor allem Kohlenhyd-
rat-Analysen durchführen, es können aber auch Alkohole (Polyal-
kohole), Zuckeralkohole sowie andere oxidierbare Substanzen 
bestimmt werden. 
Der 817 Bioscan wird vollständig via PC-Programm «IC Net» ge-
steuert. Er wird normalerweise mit einem Kabel 6.2134.080 oder 
6.2134.090 und dem Adapter 6.2125.150 direkt an eine PC-COM-
Schnittstelle angeschlossen. 
Für weitere Informationen zum 817 Bioscan siehe Gebrauchs-
anweisung 817. 

6.5.2 817-Gerätesymbol 

 
Das 817-Gerätesymbol ist im Systemfenster verfügbar, wenn ein 
817 Bioscan mit Hilfe des Systemassistenten New system wizard 
oder mit der Option Setup/New devices/Install new device installiert 
wurde (siehe Kap. 6.1.2). 

Falls das System verbunden ist und das 817-Gerätesymbol mit 
der rechten Maustaste angeklickt wird, erscheint das folgende 
Menü: 
Open Fenster 817 Bioscan für Parametereinstellungen öffnen 

(dieses Fenster kann auch durch Doppelklick auf das 
Gerätesymbol geöffnet werden). 

Unlink 817-Gerätesymbol im Systemfenster löschen. 

6.5.3 Fenster "817 Bioscan" 

817-Gerätesymbol / Open 
Die Wahl dieses Menüpunktes mit der rechten Maustaste oder ein 
Doppelklick auf das 817-Gerätesymbol öffnet das Fenster 817 Bi-
oscan für Parametereinstellungen. Es besteht aus den vier Regis-
terkarten Manual, Method parameters, Program und Links. 

Manual 
Die Registerkarte Manual im Fenster 817 Bioscan ist nur für ein 
verbundenes System verfügbar. 
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Mode Wahl des Detektor-Modus: 
DC Im Modus DC wird eine konstante Span-

nung an die Arbeitselektrode angelegt. Die 
Substanzen werden dabei gemäss ihren 
elektrochemischen Eigenschaften oxidiert 
oder reduziert. 

Pulse Der Modus Pulse arbeitet mit drei unter-
schiedlichen Arbeitsspannungen, die zyk-
lisch angelegt werden. Dadurch wird die 
Elektrodenoberfläche nach jedem Sweep 
von anhaftenden Reaktionsprodukten be-
freit und eine neue, aktivierte Oberfläche für 
die nächste Messung erzeugt. 

Scan Der Modus Scan ermöglicht die Aufnahme 
von Strom/Spannungskurven. 

Cell Manuelle Steuerung der amperometrischen 
Detektorzelle: 

<On> Detektorzelle einschalten. 
<Off> Detektorzelle ausschalten. 

Oven Manuelle Steuerung der Säulenraumhei-
zung: 

<On> Heizung einschalten. 
<Off> Heizung ausschalten. 
Temperature Temperatur des Säulenraumofens. 

Bereich: 15 ... 60 °C 

Control Manuelle Kontrolle der 4 Kontrollleitungen. 
<Set> Kontrollleitungen in den gewünschten Zu-

stand setzen. 
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Aux1, Aux2, Cont1, Cont2 
Setzen der 4 Kontrollleitungen. 
Auswahl: 0, 1, * 

Valve Manuelles Umschalten des Injektionsventils 
an der 812 Valve Unit: 

<Fill> Injektionsventil in Position "Fill" umschalten 
(Kontrollleitung Cont1 wird auf 0 gesetzt). 

<Inject> Injektionsventil in Position "Inject" umschal-
ten (Kontrollleitung Cont1 wird auf 1 ge-
setzt). 

Analog output Manuelles Nullsetzen des Analogaus-
gangssignals. 

<Zero> Autozero-Funktion auslösen. 

Actual Anzeige der aktuellen Werte. 
Mode Anzeige des aktuellen Detektor-Modus. 
Cell Anzeige des aktuellen Zellen-Zustands. 
Oven Anzeige des aktuellen Heizungs-Zustands. 
Control Anzeige des aktuellen Zustands der Kon-

trollleitungen. 
 
 

DC-mode 
Auf der Unterseite DC mode der Registerkarte Method parameters 
im Fenster 817 Bioscan können Parameter für den DC-Modus ge-
setzt werden. Dieses Fenster ist nur zugänglich, wenn auf der 
Registerkarte Manual die Option DC für Mode gewählt wurde. 
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Method data 
Cell potential Elektrisches Potential in V, das an die am-

perometrische Detektorzelle angelegt wird. 
Bereich: -2 ... +2 V. 

Oven Säulenraumheizung ein-/ausschalten und 
Arbeitstemperatur einstellen. 
Bereich: 15 ... 60 °C 

Range Wahl des Messbereichs: 
 pA 10 ... 5000 pA. 
 nA 0.1 ... 50 nA. 
 µA 0.01 ... 5 µA. 

Full scale Der Full-Scale-Bereich (Arbeitsbereich) 
setzt die gewünschte Empfindlichkeit für 
den Analogausgang. Die möglichen Einga-
bewerte hängen von der Voreinstellung für 
den Messbereich Range ab. 

Filter Elektronische Dämpfung für das Analog-
ausgangssignal. 
Auswahl: 0.1, 0.2, 0.5, 1, 2, 5 s 

Offset Nullpunktversatz für das Analogausgangs-
signal. 
Auswahl: -50 ... +50 % (in Schritten von 10 %) 

Actual 
Cell potential Anzeige des aktuellen Zellpotentials in V 
Oven Anzeige des aktuellen Heizungszustands. 
Range Anzeige des aktuellen Messbereichs. 
Full scale Anzeige des aktuellen Full-Scale-Bereichs. 
Filter Anzeige der aktuellen Filterkonstante. 
Offset Anzeige des aktuellen Nullpunktversatzes. 

<Set> Aktuelle Parameter sofort zum 817 Bioscan 
schicken. Die Parameter werden erst in der 
Systemdatei (*.smt) gespeichert, wenn die 
Datei gesichert wird. 

Pulse mode 
Auf der Unterseite Pulse mode der Registerkarte Method parameters 
im Fenster 817 Bioscan können Parameter für den Puls-Modus 
gesetzt werden. Dieses Fenster ist nur zugänglich, wenn auf der 
Registerkarte Manual die Option Pulse für Mode gewählt wurde. 

Method data 
Cell Definition von drei Arbeitspotentialen, die 

zyklisch an die amperometrische Detektor-
zelle angelegt werden. Die gesetzten 
Potentiale werden grafisch angezeigt, falls 
die Option Method über dem Grafikfenster 
ausgewählt ist. 
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E1, E2, E3 Arbeitspotentiale. 
Bereich: -2 ... +2 V. 

t1, t2, t3 Zeitdauer, während der die Arbeitspotentia-
le angelegt werden. 
Bereich: 0.01 ... 2 s 

Sample time Messzeit am Ende des Arbeitspotentials E1. 
Auswahl: 20, 40, 60, 80, 100 ms 

Oven Säulenraumheizung ein-/ausschalten und 
Arbeitstemperatur einstellen. 
Bereich: 15 ... 60 °C 

Range Wahl des Messbereichs: 
 pA 10 ... 5000 pA. 
 nA 0.1 ... 50 nA. 
 µA 0.01 ... 5 µA. 

Full scale Der Full-Scale-Bereich (Arbeitsbereich) 
setzt die gewünschte Empfindlichkeit für 
den Analogausgang. Die möglichen Einga-
bewerte hängen von der Voreinstellung für 
den Messbereich Range ab. 

Offset Nullpunktversatz für das Analogausgangs-
signal. 
Auswahl: -50 ... +50 % (in Schritten von 10 %) 



6  Geräte 
 

IC Net 2.2 78 

Actual 
E1, E2, E3 Anzeige der aktuellen Arbeitspotentiale in V. 
t1, t2, t3 Anzeige der aktuellen Zeitdauer für die ein-

zelnen Arbeitspotentiale in s. 
Sample time Anzeige der aktuellen Messzeit in ms. 
Oven Anzeige des aktuellen Heizungszustands. 
Range Anzeige des aktuellen Messbereichs. 
Full scale Anzeige des aktuellen Full-Scale-Bereichs. 
Offset Anzeige des aktuellen Nullpunktversatzes. 

Cycle potentials Grafische Anzeige des Potentialverlaufs. 
Method Anzeige der unter Method data eingestellten 

Arbeitspotentiale. 
Actual Anzeige der aktuellen Arbeitspotentiale. 

<Set> Aktuelle Parameter sofort zum 817 Bioscan 
schicken. Die Parameter werden erst in der 
Systemdatei (*.smt) gespeichert, wenn die 
Datei gesichert wird. 

Scan mode 
Auf der Unterseite Scan mode der Registerkarte Method parameters 
im Fenster 817 Bioscan können Parameter für den Scan-Modus 
gesetzt und die resultierenden Kurven dargestellt werden. Dieses 
Fenster ist nur zugänglich, wenn auf der Registerkarte Manual die 
Option Scan für Mode gewählt wurde. 

Parameters 
Method data 

Cell potential Eingabe des Start- und Endpotentials für 
einen benutzerdefinierten Potentialsweep, 
der an die amperometrische Detektorzelle 
angelegt wird. 

E1 Startpotential für den Sweep. 
Bereich: -2 ... +2 V. 

E2 Endpotential für den Sweep. 
Bereich: -2 ... +2 V. 

Scan cycle Definition des Scanzyklus: 
 full doppelter Durchlauf E1 ... E2 ... E1 
 half einfacher Durchlauf E1 ... E2 
Auswahl: full, half 

Scan rate Definition der Scanrate in mV/s. 
Auswahl: 1, 2, 5, 10, 20, 50 mV/s 

Oven Säulenraumheizung ein-/ausschalten und 
Arbeitstemperatur einstellen. 
Bereich: 15 ... 60 °C 

Range Wahl des Messbereichs: 
 pA 10 ... 5000 pA. 
 nA 0.1 ... 50 nA. 
 µA 0.01 ... 5 µA. 
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Full scale Der Full-Scale-Bereich (Arbeitsbereich) 
setzt die gewünschte Empfindlichkeit für 
den Analogausgang. Die möglichen Einga-
bewerte hängen von der Voreinstellung für 
den Messbereich Range ab. 

Offset Nullpunktversatz für das Analogausgangs-
signal. 
Auswahl: -50 ... +50 % (in Schritten von 10 %) 

Actual 
E1, E2 Anzeige des aktuellen Start- und Endpoten-

tials in V. 
Scan cycle Anzeige des aktuellen Scanzyklus. 
Scan rate Anzeige der aktuellen Scanrate in mV/s. 
Oven Anzeige des aktuellen Heizungszustands. 
Range Anzeige des aktuellen Messbereichs. 
Full scale Anzeige des aktuellen Full-Scale-Bereichs. 
Offset Anzeige des aktuellen Nullpunktversatzes. 

<Set> Aktuelle Parameter sofort zum 817 Bioscan 
schicken. Die Parameter werden erst in der 
Systemdatei (*.smt) gespeichert, wenn die 
Datei gesichert wird. 
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Operations 

 

Caption Möglichkeit zur Eingabe eines Titels, der 
oben im Grafikfenster eingetragen wird. 

<Add date & time> Das aktuelle Datum und die aktuelle Zeit 
werden zum Titel im Feld Caption hinzuge-
fügt. 

State Anzeige des aktuellen Status. 
<Start> Sweep starten. 
<Stop> Sweep stoppen. 

<Copy to clipboard> Inhalt des Grafikfensters in die Zwischenab-
lage kopieren. 

 

 

Links 
Die Registerkarte Links im Fenster 817 Bioscan dient zur Wahl und 
Einstellung der COM-Schnittstelle (Details siehe Kap. 5.2.4 Links). 
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6.6 733 IC Separation Center 

6.6.1 Allgemeines zum 733 IC Separation Center 

Das 733 IC Separation Center von Metrohm ist ein thermisch 
und elektronisch isolierter Nassteil, der Injektoren, Trennsäulen, 
Detektoren, Suppressormodul und Pulsdämpfer aufnimmt. Es 
wird am 732 IC Detector angeschlossen und von diesem gesteu-
ert. Erhältlich sind die folgenden Versionen: 
• 2.733.0010 IC Separation Center mit 1 Injektor 

• 2.733.0120 IC Separation Center mit 2 Injektoren, metallfrei 

• 2.733.0130 IC Separation Center mit 1 Injektor und 1 Sup-
pressormodul, metallfrei 

Das 733 IC Separation Center, das normalerweise via 732 IC De-
tector betrieben wird, kann vollständig mit dem Programm «IC 
Net» gesteuert werden. 

Das 733 IC Separation Center mit 1 Injektionsventil wird norma-
lerweise mit dem Kabel 6.2125.090 am 732 IC Detector ange-
schlossen. Für den Betrieb eines 733 IC Separation Centers mit 2 
unabhängigen Trennsäulen und 2 Injektionsventilen werden 
zwei 732 IC Detektoren benötigt. Jeder dieser Detektoren wird mit 
einem Kabel 6.2125.090 am 733 IC Separation Center ange-
schlossen. Für den Betrieb eines Zweiventilsystems mit «IC Net» 
müssen zwei 732 Gerätesymbole und zwei 733 Gerätesymbole (ei-
nes für Ventil A und eines für Ventil B) im Systemfenster installiert 
werden. Um das 733 IC Separation Center in ein System zu instal-
lieren muss das 733 IC Separation Center ausgewählt werden, der 
genaue Typ wird automatisch erkannt. 

Wenn das Separation Center an das 762 IC Interface ange-
schlossen ist, wird für jede Event line ein Kabel 6.2115.070 benö-
tigt. Die Anzahl hängt von der Art des Separation Centers ab, 
beim 733.0130 IC Separation Center werden z.B. drei Event lines 
benötigt um das Ventil (fill,inject) und den Suppressor (step) zu 
steuern. In diesem Fall muss das entsprechende 733.0XX0 Separa-
tion Center ausgewählt werden um das 733 IC Separation Center 
in ein System zu installieren. 

Für weitere Informationen zum 733 IC Separation Center siehe 
Gebrauchsanweisung 732/733. Beispiele für Zusammenschal-
tungen mit dem 733 IC Separation Center, dem 732 IC Detector 
und dem 762 IC Interface finden sich in der Gebrauchsanwei-
sung 762. 
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6.6.2 Symbol für 733 IC Separation Center 

 
Das 733-Gerätesymbol ist im Systemfenster verfügbar, wenn ein 
733 IC Separation Center mit Hilfe des Systemassistenten New sys-
tem wizard oder mit der Option Setup/New devices/Install new device 
installiert wurde (siehe Kap. 6.1.2). 

Falls das System verbunden ist und das 732-Gerätesymbol mit 
der rechten Maustaste angeklickt wird, erscheint das folgende 
Menü: 
Open Fenster 733 IC Separation Center für Parametereinstel-

lungen öffnen (dieses Fenster kann auch durch Dop-
pelklick auf das Gerätesymbol geöffnet werden). 

Unlink 733-Gerätesymbol im Systemfenster löschen. 

6.6.3 Fenster "733 IC Separation Center" 

733-Gerätesymbol / Open 
Die Wahl dieses Menüpunktes mit der rechten Maustaste oder ein 
Doppelklick auf das 733-Gerätesymbol öffnet das Fenster 733 IC 
Separation Center für Parametereinstellungen. Es besteht aus den 
drei Registerkarten Manual, Program und Links. 

Manual 
Die Registerkarte Manual des Fensters 733 IC Separation Center ist 
nur bei einem verbundenem System verfügbar. Je nach Geräte-
typ erscheinen unterschiedliche Parameter und Knöpfe für die 
manuelle Bedienung. 
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733 IC Separation Center angeschlossen 733.0130 Separation Center angeschlossen 
an 732 an 762 

 

Configuration Anzeige der aktuellen Gerätekonfiguration. 
valve A 733 IC Separation Center mit 1 Injektor. 
valve A + valve B 733 IC Separation Center mit 2 Injektoren. 
valve A + suppressor 

733 IC Separation Center mit 1 Injektor und 
1 Suppressormodul. 

Valve A  
fill/inject Anzeige der aktuellen Ventilstellung.* 
<FILL> Ventil A in Position "fill" umschalten. 
<INJECT> Ventil A in Position "inject" umschalten. 

Valve B  
fill/inject Anzeige der aktuellen Ventilstellung.* 
<FILL> Ventil B in Position "fill" umschalten. 
<INJECT> Ventil B in Position "inject" umschalten. 

Suppressor  
in position Anzeige der aktuellen Suppressorstellung.* 
<STEP> Suppressormodul in nächste Stellung um-

schalten. 

Auto Step * 
fill, inject, off Anzeige des Status der automatischen Aus-

lösung von "Step". 
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Entry field Automatisches Weiterschalten des Sup-
pressormoduls nach jedem "fill" oder "inject" 
von Ventil A. 
Auswahl: fill, inject, off 

* nur beim 733 IC Separation Center, das an den 732 angeschlos-
sen ist, verfügbar 

 

Zeitprogramm 
Die Registerkarte Program ist nur für ein 733.0XX0 Separation Cen-
ter, das an ein 762 IC Interface angeschlossen ist, verfügbar. 
Ein 733 IC Seperation Center, das an den 732 IC Detector 
angeschlossen ist, wird über dessen Zeitprogramm gesteuert. 

Auf der Registerkarte Program im Fenster 733.0XX0 IC Separation 
Center kann ein benutzerspezifisches Zeitprogramm eingegeben 
werden. Dieses Programm wird je nach Einstellung im Fenster 
Start mode (siehe Kap. 4.4.3) entweder beim Start der Bestim-
mung (Start with determination) oder bei der Injektion der Probe 
(Start with inject) automatisch gestartet 

 
Zeit (1. Spalte) Zeitpunkt für Ausführung des Befehls. 

Bereich: 0.0 ... 999.9 min 
Wird keine Zeit eingegeben, so wird der Be-
fehl zusammen mit dem letzten Befehl mit 
Zeitangabe ausgeführt. 

Befehl (2. Spalte) Programmbefehl (siehe unten). 
Parameter (3. Spalte) Parameter für Programmbefehl (s. u.). 
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ENABLED Programm für Programmstart aktivieren (ein 
nicht aktiviertes Programm wird nicht ge-
startet). 

<Add> Neuen Programmbefehl hinzufügen. 
<Delete> Ausgewählten Programmbefehl löschen. 
<Verify> Zeitprogramm überprüfen (im Fehlerfall er-

scheinen Fehlermeldungen). 

 

Liste der Programmbefehle 
Die folgenden Programmbefehle können auf der Registerkarte 
Program in das Zeitprogramm eingefügt werden: 

Befehl  Parametereintrag Bedeutung 

ValveA fill, inject Injektionsventil A in die Position 
“fill” oder “inject” umschalten. 

ValveB fill, inject Injektionsventil B in die Position 
“fill” oder “inject” umschalten. 

Step  Suppressor in die nächste Positi-
on weiterdrehen. 

 

Links 
Die Registerkarte Links im Fenster 733 IC Separation Center dient 
zur Wahl und Einstellung der COM-Schnittstelle (Details siehe 
Kap. 5.2.4 Links) bzw. der Event line(s). 

 

6.7 709 IC Pump 

6.7.1 Allgemeines zur 709 IC Pump 

Die 709 IC Pump von Metrohm ist eine serielle Doppelkolben-
Hochdruckpumpe für die Ionenchromatographie. Erhältlich sind 
die beiden folgenden Versionen: 

• 2.709.0010 IC Pump (Standardversion) 
• 2.709.0110 IC Pump (metallfreie Version) 

Die 709 IC Pump, die normalerweise via 732 IC Detector betrie-
ben wird, kann vollständig mit dem Programm «IC Net» gesteuert 
werden. Sie kann entweder mit dem Kabel 6.2125.060 am 732 IC 
Detector, mit dem Kabel 6.2134.080 oder 6.2134.090 am 762 IC 
Interface oder mit dem Kabel 6.2134.040 oder 6.2134.100 an ei-
ner freien PC-COM-Schnittstelle angeschlossen werden. Falls die 
709 IC Pump direkt am 732 IC Detector angeschlossen wird, 
muss bei der Installation Isocratic pump 709 for 732, falls sie direkt 
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am 762 IC Interface angeschlossen wird, muss Isocratic pump 709 
ausgewählt werden.  

Beispiele für Zusammenschaltungen mit der 709 IC Pump finden 
sich in der Gebrauchsanweisung 762. 

 
Die Kabelverbindung zwischen 709 IC Pump und 732 IC Detec-
tor, 762 IC Interface oder PC muss vor dem Einschalten des Ge-
rätes hergestellt werden. Um die 709 IC Pump mit «IC Net» zu 
betreiben, muss die externe Kontrolle mit Hilfe der Taste [ Ext. ] 
eingeschaltet werden. 

 
Für weitere Informationen zur 709 IC Pump siehe Gebrauchs-
anweisung 709. 

6.7.2 Symbol für 709 IC Pump 

 

Das 733-Gerätesymbol ist im Systemfenster verfügbar, wenn eine 
Isocratic pump 709 oder eine Isocratic pump 709 for 732 mit Hilfe des 
Systemassistenten New system wizard oder mit der Option  
Setup/New devices/Install new device installiert wurde (siehe Kap. 
6.1.2). 

Falls das System verbunden ist und das 709-Gerätesymbol mit 
der rechten Maustaste angeklickt wird, erscheint das folgende 
Menü: 

Open Fenster 709 IC Pump für Parametereinstellungen öffnen 
(dieses Fenster kann auch durch Doppelklick auf das 
Gerätesymbol geöffnet werden). 

Unlink 709-Gerätesymbol im Systemfenster löschen. 

 

6.7.3 Fenster "709 IC Pump" 

709-Gerätesymbol / Open 
Die Wahl dieses Menüpunktes mit der rechten Maustaste oder ein 
Doppelklick auf das 709-Gerätesymbol öffnet das Fenster 709 IC 
Pump für Parametereinstellungen und manuelle Bedienung. Es 
besteht aus den drei Registerkarten Settings, Links und Advanced. 

Settings 
Die Registerkarte Settings im Fenster 709 IC Pump ist nur bei ei-
nem verbundenem System verfügbar.  
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Pressure Anzeige des aktuellen Drucks in MPa. Die-

ses Feld ist auch für das WATCH WINDOW 
verfügbar. 

Flow Anzeige der aktuellen Flussrate in mL/min. 
Dieses Feld ist auch für das WATCH WIN-
DOW verfügbar. 

New flow Neue Flussrate eingeben mit Scrollbar, 
durch Eingabe eines Wertes oder Ändern 
des Wertes mit den Auf- und Ab-Pfeilen. 
Bereich: 0.01 ... 5.00 mL/min 

Min/Max pressure Die minimalen und maximalen Druckgrenz-
werte für die 709 IC Pump können in Schrit-
ten von 0.1 MPa eingegeben werden. 
Bereich: 0.0 ... 50.0 MPa. 

 Der eingestellte maximale Grenzwert sollte 
zwischen 5 und 10 MPa über dem jeweili-
gen Arbeitsdruck liegen oder dem maximal 
zulässigen Arbeitsdruck für die verwendete 
Trennsäule entsprechen. Überschreitet die 
Pumpe während des Betriebs den vorgege-
benen Grenzwert, so wird sie sofort ausge-
schaltet. Gleichzeitig ändern sich die Far-
ben für das Feld Pressure im Fenster 709 IC 
Pump und im WATCH WINDOW auf die für 
Out of range definierten Werte. 

 Der eingestellte minimale Grenzwert sollte 
ausreichend weit unter dem jeweiligen 
Arbeitsdruck liegen. Unterschreitet die 
Pumpe während des Betriebs den vorge-
gebenen Grenzwert während mehreren No-
ckenumdrehungen infolge Lecks oder un-
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terbrochenem Eluentenfluss, so wird die 
Pumpe automatisch ausgeschaltet. Gleich-
zeitig ändern sich die Farben für das Feld 
Pressure im Fenster 709 IC Pump und im 
WATCH WINDOW auf die für Out of range de-
finierten Werte. 

<Set> Aktuelle Parameter sofort zur 709 IC Pump 
schicken. Die Parameter werden erst in der 
Systemdatei (*.smt) gespeichert, wenn die 
Datei gesichert wird. 

<Start> 709 IC Pump starten. 
<Stop> 709 IC Pump stoppen. 

 

 

Links 
Die Registerkarte Links im Fenster 709 IC Pump dient zur Wahl und 
Einstellung der COM-Schnittstelle (Details siehe Kap. 5.2.4 Links). 

Advanced 
Die Registerkarte Advanced im Fenster 709 IC Pump ist nur bei ei-
nem verbundenem System verfügbar.  

 

Correction factor Korrekturfaktor für die Korrektur der ange-
zeigten Flussrate auf die mit Hilfe eines 
Messzylinders bestimmte aktuelle Flussra-
te. 
Bereich: 0.90 ... 1.10 

<Ask> Aktuellen Wert für Correction factor lesen. 
<Set> Aktuellen Wert für Correction factor an die 

709 IC Pump senden. Dieser Parameter 
wird erst in der Systemdatei (*.smt) gespei-
chert, wenn die Datei gesichert wird. 

 

 



 6.8  Metrohm solvent delivery unit 
 

IC Net 2.2 89 

6.8 Metrohm solvent delivery unit 

6.8.1 Allgemeines zur Metrohm SDU 

Als Metrohm SDU (Solvent Delivery Unit) wird ein System be-
zeichnet, das für die Hochdruck-Grandientenmischung von bis zu 
vier Eluenten benutzt werden kann, wobei für jeden Eluenten eine 
709 IC Pump benötigt wird. Jede 709 IC Pump muss mit Hilfe ei-
nes Kabels 6.2134.080 oder 6.2134.090 am 762 IC Interface an-
geschlossen werden. Beispiele für Zusammenschaltungen mit 
der 709 IC Pump finden sich in der Gebrauchsanweisung 762.  

Die Auslasskapillaren der Pumpen müssen an eine geeignete 
Mischkammer angeschlossen werden, von der die Zuleitung zum 
Injektionsventil am 733 IC Separation Center führt. 

Für weitere Informationen zur 709 IC Pump siehe Gebrauchs-
anweisung 709. 

6.8.2 Symbol für Metrohm SDU 

 

Das SDU-Gerätesymbol ist im Systemfenster verfügbar, wenn ei-
ne SDU (Solvent Delivery Unit) mit Hilfe des Systemassistenten 
New system wizard oder mit der Option Setup/New devices/Install 
new device installiert wurde (siehe Kap. 6.1.2). Das SDU-Geräte-
symbol besteht je nach installiertem Typ aus einem bis vier Sym-
bolen für die 709 IC Pump, die übereinander angeordnet sind. 

Falls das System verbunden ist und das SDU-Symbol mit der 
rechten Maustaste angeklickt wird, erscheint das folgende Menü: 
Open Fenster SDU für Parametereinstellungen öffnen (dieses 

Fenster kann auch durch Doppelklick auf das Geräte-
symbol geöffnet werden). 

Unlink SDU-Gerätesymbol im Systemfenster löschen. 

6.8.3 Fenster "Metrohm SDU" 

SDU-Gerätesymbol / Open 
Die Wahl dieses Menüpunktes mit der rechten Maustaste oder ein 
Doppelklick auf das SDU-Gerätesymbol öffnet das Fenster Pump 
control system für Parametereinstellungen und manuelle Bedie-
nung. Es besteht aus den vier Registerkarten Manual, Program, In-
terfaces und Links. 

Manual 
Die Registerkarte Manual des Fensters Metrohm SDU ist nur bei ei-
nem verbundenem System verfügbar.  
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Pressure Anzeige des aktuellen Drucks in MPa. Die-

ses Feld ist auch für das WATCH WINDOW 
verfügbar. 

Flow Anzeige der aktuellen Flussrate in mL/min. 
Dieses Feld ist auch für das WATCH WIN-
DOW verfügbar. 

New flow Eine neue Flussrate kann durch Bewegen 
des Scrollbars, durch Eingabe eines Wertes 
oder Ändern des Wertes mit den Auf- und 
Ab-Pfeilen gesetzt werden. 
Bereich: 0.01 ... 20.00 mL/min (abhängig von 
der Anzahl Pumpen) 

Min/Max pressure Die minimalen und maximalen Druckgrenz-
werte für die einzelnen Pumpen können in 
Schritten von 0.1 MPa eingegeben werden. 
Bereich: 0.0 ... 50.0 MPa. 

%B Individuelle Flussrate für Pumpe B in Pro-
zent der totalen Flussrate. 
Bereich: 0 ... 100 % 

%C Individuelle Flussrate für Pumpe C in Pro-
zent der totalen Flussrate.  
Bereich: 0 ... 100 % 

%D Individuelle Flussrate für Pumpe D in Pro-
zent der totalen Flussrate.  
Bereich: 0 ... 100 % 

Stop after Stoppzeit für alle Pumpen.  
Bereich: 0 ... 99999 min 
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<Set> Aktuelle Parameter sofort zum Pumpenkon-
trollsystem schicken. Die Parameter werden 
erst in der Systemdatei (*.smt) gespeichert, 
wenn die Datei gesichert wird. 

<Start> Alle Pumpen starten. 
<Stop> Alle Pumpen stoppen. 

 

Programm 
Die Registerkarte Program des Fensters SDU enthält ein Zeitpro-
gramm für das Pumpenkontrollsystem, mit dem Eluentgradienten 
definiert werden können.  

 
Flow Gesamtfluss des Pumpenkontrollsystems in 

mL/min. Dieser Wert ist auch für das 
WATCH WINDOW verfügbar. Dieses Feld ist 
nur editierbar, wenn die Option Show flow 
column eingeschaltet ist. 
Bereich: 0.01 ... 20.00 mL/min (abhängig von 
der Anzahl Pumpen) 

Stop pumps after the run 
Die Pumpen werden nach der Bestimmung 
gestoppt. 

Program table 
Number Zeilennummer (nur Anzeige). 
Time Zeitpunkt für Änderung der Flussrate 

und/oder des Gradientenverhältnisses. 
Bereich: 0.0 ... 99999 min 

Flow Gesamtfluss des Pumpenkontrollsystems in 
mL/min.  
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Bereich: 0.01 ... 20.00 mL/min (abhängig von 
der Anzahl Pumpen) 

%B Individuelle Flussrate für Pumpe B in Pro-
zent der totalen Flussrate. 
Bereich: 0 ... 100 % 

%C Individuelle Flussrate für Pumpe C in Pro-
zent der totalen Flussrate.  
Bereich: 0 ... 100 % 

%D Individuelle Flussrate für Pumpe D in Pro-
zent der totalen Flussrate.  
Bereich: 0 ... 100 % 

Enabled Programm für Programmstart aktivieren (ein 
nicht aktiviertes Programm wird nicht ge-
startet). 

Show flow column Kolonne Flow in der Programmtabelle an-
zeigen. 

<Add> Neue Zeile zum Zeitprogramm hinzufügen. 
<Delete> Ausgewählte Zeile löschen. 
<Start> Alle Pumpen starten. 

Interfaces 
Die Registerkarte Interfaces des Fensters SDU ist nur bei einem 
verbundenem System verfügbar.  

 
Number of eluents Anzahl der für die Gradientenmischung be-

nutzten Eluenten. 

Pumps Liste der für die Gradientenmischung benutz-
ten Pumpen. Ein Klick auf <A>, <B>, <C> oder 
<D> öffnet das Fenster 709 IC Pump für Para-
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metereinstellungen und manuelle Steuerung 
der ausgewählten Pumpe. 

Pressure checking Auswahl der Pumpe, deren Druck mit Hilfe 
der Grenzwerte Min/Max pressure überprüft 
wird. 

Links 
Die Registerkarte Links im Fenster Metrohm SDU dient zur Wahl 
und Einstellung der COM-Schnittstelle (Details siehe Kap. 5.2.4 
Links). 
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6.9 752 Pump Unit 

6.9.1 Allgemeines zur 752 Pump Unit 

Die 752 Pump Unit von Metrohm ist eine Zweikanal-Schlauch-
quetschpumpe, die normalerweise für die Förderung von Rege-
nierungs- und Spüllösung zum Suppressormodul im 733 IC 
Separation Center verwendet wird.  

Die 752 Pump Unit, die normalerweise manuell über die Geräte-
tastatur oder automatisch via 732 IC Detector bedient wird, kann 
vollständig mit dem Programm «IC Net» gesteuert werden. Dazu 
wird sie mit Hilfe des optionalen Kabels 6.2128.180 an eine der 
"Event line"-Verbindungen am 762 IC Interface angeschlossen. 
Beispiele für Zusammenschaltungen mit der 752 Pump Unit fin-
den sich in der Gebrauchsanweisung 762. 

 
Um die 752 Pump Unit mit «IC Net» zu betreiben, muss die ex-
terne Kontrolle mit der Taste [ Remote ] eingeschaltet werden. 

Für weitere Informationen zur 752 Pump Unit siehe Gebrauchs-
anweisung 752. 
 

6.9.2 Symbol für 752 Pump Unit 

 

Das 752-Gerätesymbol ist im Systemfenster verfügbar, wenn eine 
752 Pump Unit mit Hilfe des Systemassistenten New system wizard 
oder mit der Option Setup/New devices/Install new device installiert 
wurde (siehe Kap. 6.1.2). 

Falls das System verbunden ist und das 752-Gerätesymbol mit 
der rechten Maustaste angeklickt wird, erscheint das folgende 
Menü: 

Open Fenster 752 Pump Unit für Parametereinstellungen öff-
nen (dieses Fenster kann auch durch Doppelklick auf 
das Gerätesymbol geöffnet werden). 

Unlink 752-Gerätesymbol im Systemfenster löschen. 
 

6.9.3 Fenster "752 Pump Unit" 

752-Gerätesymbol / Open 
Die Wahl dieses Menüpunktes mit der rechten Maustaste oder ein 
Doppelklick auf das 752-Gerätesymbol öffnet das Fenster 752 
Pump Unit für Parametereinstellungen. Es besteht aus den drei 
Registerkarten Manual, Program und Links. 
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Manual 
Die Registerkarte Manual im Fenster 752 Pump Unit ist nur bei ei-
nem verbundenem System verfügbar. 

 

Pump 
<On> Pumpe starten. 
<Off> Pumpe stoppen. 

Start pump with startup hardware 
Automatischer Pumpenstart mit Startup 
hardware. 

 

 
 

Zeitprogramm 
Auf der Registerkarte Program im Fenster 752 Pump Unit kann ein 
benutzerspezifisches Zeitprogramm eingegeben werden. Dieses 
Programm wird je nach Einstellung im Fenster Start mode (siehe 
Kap. 4.4.3) entweder beim Start der Bestimmung (Start with de-
termination) oder bei der Injektion der Probe (Start with inject) au-
tomatisch gestartet. 

 

Zeit (1. Spalte) Zeitpunkt für Ausführung des Befehls. 
Bereich: 0.0 ... 999.9 min 
Wird keine Zeit eingegeben, so wird der Be-
fehl zusammen mit dem letzten Befehl mit 
Zeitangabe ausgeführt. 

Befehl (2. Spalte) Programmbefehl (siehe unten). 
Parameter (3. Spalte) Parameter für Programmbefehl (s. u.). 
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ENABLED Programm für Programmstart aktivieren (ein 
nicht aktiviertes Programm wird nicht ge-
startet). 

<Add> Neuen Programmbefehl hinzufügen. 
<Delete> Ausgewählten Programmbefehl löschen. 
<Verify> Zeitprogramm überprüfen (im Fehlerfall er-

scheinen Fehlermeldungen). 

 

Liste der Programmbefehle 
Die folgenden Programmbefehle können auf der Registerkarte 
Program in das Zeitprogramm eingefügt werden: 

Befehl  Parametereintrag Bedeutung 

Program RESET, END Programmflag setzen. Das Pro-
grammflag END kann dazu be-
nutzt werden, ein Programm zu 
beenden, speziell wenn die Pro-
grammzeit länger sein soll als die 
unter Duration definierte Dauer der 
Datenaufnahme. Zusätzliche 
Schritte nach diesem Flag sind 
nicht erlaubt. Das Programmflag 
RESET dient zum Rücksetzen der 
Parameter auf die Systemstart-
werte. 

Pump on, off Pumpe ein-/ausschalten. 
 

 
Links 

Die Registerkarte Links im Fenster 752 Pump Unit dient zur Wahl 
der Event line. 
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6.10 753 Suppressor Module 

6.10.1 Allgemeines zum 753 Suppressor Module 

Das 753 Suppressor Module von Metrohm besteht aus einem 
Steuergerät mit einer Zweikanalschlauchquetschpumpe und ei-
nem Block, der das eigentliche Suppressormodul enthält.  

Das 753 Suppressor Module, das normalerweise manuell über 
die Gerätetastatur oder automatisch via 732 IC Detector bedient 
wird, kann vollständig mit dem Programm «IC Net» gesteuert 
werden. Dazu wird das 753 Suppressor Module mit Hilfe von zwei 
optionalen Kabeln 6.2128.180 an zwei der "Event line"-Verbindun-
gen am 762 IC Interface angeschlossen. Beispiele für Zusam-
menschaltungen mit dem 753 Suppressor Module finden sich in 
der Gebrauchsanweisung 762. 

 
Um das 753 Suppressor Module mit «IC Net» zu betreiben, 
muss die externe Kontrolle mit der Taste [ Remote ] 
eingeschaltet werden. 

Für weitere Informationen zum 753 Suppressor Module siehe Ge-
brauchsanweisung 753. 

6.10.2 Symbol für 753 Suppressor Module 

 

Das 753-Gerätesymbol ist im Systemfenster verfügbar, wenn ein 
753 Suppressor Module mit Hilfe des Systemassistenten New sys-
tem wizard oder mit der Option Setup/New devices/Install new device 
installiert wurde (siehe Kap. 6.1.2). 

Falls das System verbunden ist und das 753-Gerätesymbol mit 
der rechten Maustaste angeklickt wird, erscheint das folgende 
Menü: 

Open Fenster 753 Suppressor Module für Parametereinstel-
lungen öffnen (dieses Fenster kann auch durch Dop-
pelklick auf das Gerätesymbol geöffnet werden). 

Unlink 753-Gerätesymbol im Systemfenster löschen. 

 
6.10.3 Fenster "753 Suppressor Module" 

753-Gerätesymbol / Open 
Die Wahl dieses Menüpunktes mit der rechten Maustaste oder ein 
Doppelklick auf das 753-Gerätesymbol öffnet das Fenster 753 
Suppressor Module für Parametereinstellungen. Es besteht aus 
den drei Registerkarten Manual, Program und Links. 
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Manual 
Die Registerkarte Manual im Fenster 753 Suppressor Module ist nur 
bei einem verbundenem System verfügbar. 

 

Pump 
<On> Pumpe starten. 
<Off> Pumpe stoppen. 

Suppressor 
<Step> Suppressor in die nächste Position weiter-

schalten. Die Zeit seit der letzten Umschal-
tung wird im Feld neben <Step> angezeigt. 

Start pump with startup hardware 
Automatischer Pumpenstart mit Startup 
hardware. 

 
 
 

Zeitprogramm 
Auf der Registerkarte Program im Fenster 753 Suppressor Module 
kann ein benutzerspezifisches Zeitprogramm eingegeben wer-
den. Dieses Programm wird je nach Einstellung im Fenster Start 
mode (siehe Kap. 4.4.3) entweder beim Start der Bestimmung 
(Start with determination) oder bei der Injektion der Probe (Start 
with inject) automatisch gestartet. 
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Zeit (1. Spalte) Zeitpunkt für Ausführung des Befehls. 
Bereich: 0.0 ... 999.9 min 
Wird keine Zeit eingegeben, so wird der Be-
fehl zusammen mit dem letzten Befehl mit 
Zeitangabe ausgeführt. 

Befehl (2. Spalte) Programmbefehl (siehe unten). 
Parameter (3. Spalte) Parameter für Programmbefehl (s.u.). 

ENABLED Programm für Programmstart aktivieren (ein 
nicht aktiviertes Programm wird nicht ge-
startet). 

<Add> Neuen Programmbefehl hinzufügen. 
<Delete> Ausgewählten Programmbefehl löschen. 
<Verify> Zeitprogramm überprüfen (im Fehlerfall er-

scheinen Fehlermeldungen). 

 

 

Liste der Programmbefehle 
Die folgenden Programmbefehle können auf der Registerkarte 
Program in das Zeitprogramm eingefügt werden: 

Befehl  Parametereintrag Bedeutung 

Program RESET, END Programmflag setzen. Das Pro-
grammflag END kann dazu be-
nutzt werden, ein Programm zu 
beenden, speziell wenn die Pro-
grammzeit länger sein soll als die 
unter Duration definierte Dauer der 
Datenaufnahme. Zusätzliche 
Schritte nach diesem Flag sind 
nicht erlaubt. Das Programmflag 
RESET dient zum Rücksetzen der 
Parameter auf die Systemstart-
werte. 

Pump on, off Pumpe ein-/ausschalten. 

Step  Suppressor in die nächste Positi-
on weiterschalten. 

 

 
Links 

Die Registerkarte Links im Fenster 753 Suppressor Module dient zur 
Wahl der beiden Event lines. 
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6.11 754 Dialysis Unit 

6.11.1 Allgemeines zur 754 Dialysis Unit 

Die 754 Dialysis Unit von Metrohm ist ein Gerät für die Online-
Dialyse von Proben vor der Probeninjektion.  

Die 754 Dialysis Unit, die normalerweise manuell über die Geräte-
tastatur oder automatisch via 732 IC Detector bedient wird, kann 
vollständig mit dem Programm «IC Net» gesteuert werden. Dazu 
wird die 754 Dialysis Unit mit Hilfe des optionalen Kabels 
6.2128.180 an einer "Event line"-Verbindung am 762 IC Interface 
angeschlossen. Beispiele für Zusammenschaltungen mit der 754 
Dialysis Unit finden sich in der Gebrauchsanweisung 762. 

 
Um die 754 Dialysis Unit mit «IC Net» zu betreiben, muss die 
externe Kontrolle mit der Taste [ Remote ] eingeschaltet wer-
den. 

Für weitere Informationen zur 754 Dialysis Unit siehe Gebrauch-
sanweisung 754. 

 

6.11.2 Symbol für 754 Dialysis Unit 

 

Das 754-Gerätesymbol ist im Systemfenster verfügbar, wenn eine 
754 Dialysis Unit mit Hilfe des Systemassistenten New system wi-
zard oder mit der Option Setup/New devices/Install new device instal-
liert wurde (siehe Kap. 6.1.2). 

Falls das System verbunden ist und das 754-Gerätesymbol mit 
der rechten Maustaste angeklickt wird, erscheint das folgende 
Menü: 

Open Fenster 754 Dialysis Unit für Parametereinstellungen 
öffnen (dieses Fenster kann auch durch Doppelklick 
auf das Gerätesymbol geöffnet werden). 

Unlink 754-Gerätesymbol im Systemfenster löschen. 

 

6.11.3 Fenster "754 Dialysis Unit" 

754-Gerätesymbol / Open 
Die Wahl dieses Menüpunktes mit der rechten Maustaste oder ein 
Doppelklick auf das 754-Gerätesymbol öffnet das Fenster 754 Dia-
lysis Unit für Parametereinstellungen. Es besteht aus den drei Re-
gisterkarten Manual, Program und Links. 
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Manual 
Die Registerkarte Manual im Fenster 754 Dialysis Unit ist nur bei ei-
nem verbundenem System verfügbar. 

 

Pump 
<On> Pumpe starten. 
<Off> Pumpe stoppen. 

Start pump with startup hardware 
Automatischer Pumpenstart mit Startup 
hardware. 

 
 
 
 

Zeitprogramm 
Auf der Registerkarte Program im Fenster 754 Dialysis Unit kann ein 
benutzerspezifisches Zeitprogramm eingegeben werden. Dieses 
Programm wird je nach Einstellung im Fenster Start mode (siehe 
Kap. 4.4.3) entweder beim Start der Bestimmung (Start with de-
termination) oder bei der Injektion der Probe (Start with inject) au-
tomatisch gestartet. 

 

Zeit (1. Spalte) Zeitpunkt für Ausführung des Befehls. 
Bereich: 0.0 ... 999.9 min 
Wird keine Zeit eingegeben, so wird der Be-
fehl zusammen mit dem letzten Befehl mit 
Zeitangabe ausgeführt. 

Befehl (2. Spalte) Programmbefehl (siehe unten). 
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Parameter (3. Spalte) Parameter für Programmbefehl (s.u.). 

ENABLED Programm für Programmstart aktivieren (ein 
nicht aktiviertes Programm wird nicht ge-
startet). 

<Add> Neuen Programmbefehl hinzufügen. 
<Delete> Ausgewählten Programmbefehl löschen. 
<Verify> Zeitprogramm überprüfen (im Fehlerfall er-

scheinen Fehlermeldungen). 

 

 

Liste der Programmbefehle 
Die folgenden Programmbefehle können auf der Registerkarte 
Program in das Zeitprogramm eingefügt werden: 

Befehl  Parametereintrag Bedeutung 

Program RESET, END Programmflag setzen. Das Pro-
grammflag END kann dazu be-
nutzt werden, ein Programm zu 
beenden, speziell wenn die Pro-
grammzeit länger sein soll als die 
unter Duration definierte Dauer der 
Datenaufnahme. Zusätzliche 
Schritte nach diesem Flag sind 
nicht erlaubt. Das Programmflag 
RESET dient zum Rücksetzen der 
Parameter auf die Systemstart-
werte. 

Pump on, off Pumpe ein-/ausschalten. 
 

 
Links 

Die Registerkarte Links im Fenster 754 Dialysis Unit dient zur Wahl 
der Event line. 
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6.12 793 Sample Prep Module 

6.12.1 Allgemeines zum 793 Sample Prep Module 

Das 793 Sample Prep Module von Metrohm besteht aus einem 
Steuergerät mit einer Zweikanalschlauchquetschpumpe und ei-
nem Block, der das eigentliche Probenvorbereitungsmodul ent-
hält.  

Das 793 Sample Prep Module, das normalerweise manuell über 
die Gerätetastatur oder automatisch via 732 IC Detector bedient 
wird, kann vollständig mit dem Programm «IC Net» gesteuert 
werden. Dazu wird das 793 Sample Prep Module mit Hilfe von 
zwei optionalen Kabeln 6.2128.180 an zwei der "Event line"-
Verbindungen am 762 IC Interface angeschlossen. Beispiele für 
Zusammenschaltungen mit dem 793 Sample Prep Module finden 
sich in der Gebrauchsanweisung 762. 

 
Um das 793 Sample Prep Module mit «IC Net» zu betreiben, 
muss die externe Kontrolle mit der Taste [ Remote ] 
eingeschaltet werden. 

Für weitere Informationen zum 793 Sample Prep Module siehe 
Gebrauchsanweisung 793. 

6.12.2 Symbol für 793 Sample Prep Module 

 

Das 793-Gerätesymbol ist im Systemfenster verfügbar, wenn ein 
793 Sample Prep Module mit Hilfe des Systemassistenten New sys-
tem wizard oder mit der Option Setup/New devices/Install new device 
installiert wurde (siehe Kap. 6.1.2). 

Falls das System verbunden ist und das 793-Symbol mit der 
rechten Maustaste angeklickt wird, erscheint das folgende Menü: 

Open Fenster 793 Sample Prep Module für Parametereinstel-
lungen öffnen (dieses Fenster kann auch durch Dop-
pelklick auf das Gerätesymbol geöffnet werden). 

Unlink 793-Gerätesymbol im Systemfenster löschen. 

 
6.12.3 Fenster "793 Sample Prep Module" 

793-Gerätesymbol / Open 
Die Wahl dieses Menüpunktes mit der rechten Maustaste oder ein 
Doppelklick auf das 793-Gerätesymbol öffnet das Fenster 793 
Sample Prep Module für Parametereinstellungen. Es besteht aus 
den drei Registerkarten Manual, Program und Links. 
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Manual 
Die Registerkarte Manual im Fenster 793 Sample Prep Module ist nur 
bei einem verbundenem System verfügbar. 

 

Pump 
<On> Pumpe starten. 
<Off> Pumpe stoppen. 

Actuator 
<Step> Probenvorbereitungsmodul in die nächste 

Position weiterschalten. Die Zeit seit der 
letzten Umschaltung wird im Feld neben 
<Step> angezeigt. 

Start pump with startup hardware 
Automatischer Pumpenstart mit Startup 
hardware. 

 
 
 

Zeitprogramm 
Auf der Registerkarte Program im Fenster 793 Sample Prep Module 
kann ein benutzerspezifisches Zeitprogramm eingegeben wer-
den. Dieses Programm wird je nach Einstellung im Fenster Start 
mode (siehe Kap. 4.4.3) entweder beim Start der Bestimmung 
(Start with determination) oder bei der Injektion der Probe (Start 
with inject) automatisch gestartet. 
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Zeit (1. Spalte) Zeitpunkt für Ausführung des Befehls. 
Bereich: 0.0 ... 999.9 min 
Wird keine Zeit eingegeben, so wird der Be-
fehl zusammen mit dem letzten Befehl mit 
Zeitangabe ausgeführt. 

Befehl (2. Spalte) Programmbefehl (siehe unten). 
Parameter (3. Spalte) Parameter für Programmbefehl (s.u.). 

ENABLED Programm für Programmstart aktivieren (ein 
nicht aktiviertes Programm wird nicht ge-
startet). 

<Add> Neuen Programmbefehl hinzufügen. 
<Delete> Ausgewählten Programmbefehl löschen. 
<Verify> Zeitprogramm überprüfen (im Fehlerfall er-

scheinen Fehlermeldungen). 

 

 

Liste der Programmbefehle 
Die folgenden Programmbefehle können auf der Registerkarte 
Program in das Zeitprogramm eingefügt werden: 

Befehl  Parametereintrag Bedeutung 

Program RESET, END Programmflag setzen. Das Pro-
grammflag END kann dazu be-
nutzt werden, ein Programm zu 
beenden, speziell wenn die Pro-
grammzeit länger sein soll als die 
unter Duration definierte Dauer der 
Datenaufnahme. Zusätzliche 
Schritte nach diesem Flag sind 
nicht erlaubt. Das Programmflag 
RESET dient zum Rücksetzen der 
Parameter auf die Systemstart-
werte. 

Pump on, off Pumpe ein-/ausschalten. 

Step  Probenvorbereitungsmodul in die 
nächste Position weiterschalten. 

 

 
Links 

Die Registerkarte Links im Fenster 793 Suppressor Module dient zur 
Wahl der beiden Event lines. 
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6.13 812 Valve Unit 

6.13.1 Allgemeines zur 812 Valve Unit 

Die 812 Valve Unit von Metrohm ist ein Steuergerät mit einem 
oder zwei eingebauten Injektionsventilen, von dem die beiden fol-
genden Versionen erhältlich sind: 

• 2.812.0010 IC Valve Unit mit 1 Injektor 

• 2.812.0020 IC Valve Unit mit 2 Injektoren 

Die 812 Valve Unit, die normalerweise manuell über die Geräte-
tastatur oder automatisch via 732 IC Detector bedient wird, kann 
vollständig mit dem Programm «IC Net» gesteuert werden. Dazu 
wird die 812 Valve Unit mit Hilfe von zwei optionalen Kabeln 
6.2128.100 an zwei der "Event line"-Verbindungen am 762 IC In-
terface angeschlossen. Beispiele für Zusammenschaltungen mit 
der 812 Valve Unit finden sich in der Gebrauchsanweisung 762. 

Für weitere Informationen zur 812 Valve Unit siehe Ge-
brauchsanweisung 812. 

 

 

 

6.13.2 Symbol für 812 Valve Unit 

  

2.812.0010 Valve Unit 
mit 1 Injektor 

2.812.0020 Valve Unit 
mit 2 Injektoren 

Das 812-Gerätesymbol ist im Systemfenster verfügbar, wenn eine 
812 Valve Unit mit Hilfe des Systemassistenten New system wizard 
oder mit der Option Setup/New devices/Install new device installiert 
wurde (siehe Kap. 6.1.2). 

Falls das System verbunden ist und das 812-Gerätesymbol mit 
der rechten Maustaste angeklickt wird, erscheint das folgende 
Menü: 

Open Fenster 812 Valve Unit für Parametereinstellungen öff-
nen (dieses Fenster kann auch durch Doppelklick auf 
das Gerätesymbol geöffnet werden). 

Unlink 812-Gerätesymbol im Systemfenster löschen. 
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6.13.3 Fenster "812 Valve Unit" 

812-Gerätesymbol / Open 
Die Wahl dieses Menüpunktes mit der rechten Maustaste oder ein 
Doppelklick auf das 812-Gerätesymbol öffnet das Fenster 812 
Valve Unit für Parametereinstellungen. Es besteht aus den drei 
Registerkarten Manual, Program und Links. 

Manual 
Die Registerkarte Manual im Fenster 812 Valve Unit ist nur bei ei-
nem verbundenem System verfügbar. 

 

Valve A 
<Fill> Ventil A in Stellung "FILL" umschalten. 
<Inject> Ventil A in Stellung "INJECT" umschalten. 

Valve B 
<Fill> Ventil B in Stellung "FILL" umschalten. 
<Inject> Ventil B in Stellung "INJECT" umschalten. 

 
 

Zeitprogramm 
Auf der Registerkarte Program im Fenster 812 Valve Unit kann ein 
benutzerspezifisches Zeitprogramm eingegeben werden. Dieses 
Programm wird je nach Einstellung im Fenster Start mode (siehe 
Kap. 4.4.3) entweder beim Start der Bestimmung (Start with de-
termination) oder bei der Injektion der Probe (Start with inject) au-
tomatisch gestartet. 
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Zeit (1. Spalte) Zeitpunkt für Ausführung des Befehls. 
Bereich: 0.0 ... 999.9 min 
Wird keine Zeit eingegeben, so wird der Be-
fehl zusammen mit dem letzten Befehl mit 
Zeitangabe ausgeführt. 

Befehl (2. Spalte) Programmbefehl (siehe unten). 
Parameter (3. Spalte) Parameter für Programmbefehl (s.u.). 

ENABLED Programm für Programmstart aktivieren (ein 
nicht aktiviertes Programm wird nicht ge-
startet). 

<Add> Neuen Programmbefehl hinzufügen. 
<Delete> Ausgewählten Programmbefehl löschen. 
<Verify> Zeitprogramm überprüfen (im Fehlerfall er-

scheinen Fehlermeldungen). 

 

 

Liste der Programmbefehle 
Die folgenden Programmbefehle können auf der Registerkarte 
Program in das Zeitprogramm eingefügt werden: 

Befehl  Parametereintrag Bedeutung 

ValveA fill, inject Ventil A in Stellung "inject" oder 
"fill" umschalten. 

ValveB fill, inject Ventil B in Stellung "inject" oder 
"fill" umschalten. 

 

 
Links 

Die Registerkarte Links im Fenster 812 Valve Unit dient zur Wahl 
der Event line(s). 
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6.14 816 IC Eluent Selector 

6.14.1 Allgemeines zum 816 IC Eluent Selector 

Der 816 IC Eluent Selector von Metrohm ist ein Steuergerät mit 
zwei Ventilen, mit deren Hilfe eine von drei Lösungen (Eluenten) 
gewählt werden kann. 

Der 816 IC Eluent Selector, der normalerweise manuell über die 
Gerätetastatur bedient wird, kann vollständig mit dem Programm 
«IC Net» gesteuert werden. Dazu wird der 816 IC Eluent Selector 
mit Hilfe eines Kabels 6.2134.080 oder 6.2134.090 und dem 
Adapter 6.2125.150 am 762 IC Interface angeschlossen. Beispie-
le für Zusammenschaltungen mit dem 816 IC Eluent Selector fin-
den sich in der Gebrauchsanweisung 762. 

Für weitere Informationen zum 816 IC Eluent Selector siehe Ge-
brauchsanweisung 816. 

 

 

6.14.2 Symbol für 816 IC Eluent Selector 

 

Das 816-Gerätesymbol ist im Systemfenster verfügbar, wenn ein 
816 IC Eluent Selector mit Hilfe des Systemassistenten New system 
wizard oder mit der Option Setup/New devices/Install new device in-
stalliert wurde (siehe Kap. 6.1.2). 

Falls das System verbunden ist und das 816-Gerätesymbol mit 
der rechten Maustaste angeklickt wird, erscheint das folgende 
Menü: 

Open Fenster 816 IC Eluent Selector für Parametereinstellun-
gen öffnen (dieses Fenster kann auch durch Doppel-
klick auf das Gerätesymbol geöffnet werden). 

Unlink 816-Gerätesymbol im Systemfenster löschen. 
 
 

 

6.14.3 Fenster "816 IC Eluent Selector" 

816-Gerätesymbol / Open 
Die Wahl dieses Menüpunktes mit der rechten Maustaste oder ein 
Doppelklick auf das 816-Gerätesymbol öffnet das Fenster 816 IC 
Eluent Selector für Parametereinstellungen. Es besteht aus den 
vier Registerkarten Manual, Aliases, Program und Links. 
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Manual 
Die Registerkarte Manual im Fenster 816 IC Eluent Selector ist nur 
bei einem verbundenem System verfügbar. 

 

Current eluent Wahl von Eluent A, Eluent B oder Eluent C. 

<Set> Ventile so umschalten, dass der gewünsch-
te Eluent gefördert wird. 

 
 

Aliases 

 

Flow A Möglichkeit zur Umbenennung von Eluent 
A. 

Flow B Möglichkeit zur Umbenennung von Eluent 
B. 

Flow C Möglichkeit zur Umbenennung von Eluent 
C. 

 
 

Zeitprogramm 
Auf der Registerkarte Program im Fenster 816 IC Eluent Selector 
kann ein benutzerspezifisches Zeitprogramm eingegeben wer-
den. Dieses Programm wird je nach Einstellung im Fenster Start 
mode (siehe Kap. 4.4.3) entweder beim Start der Bestimmung 
(Start with determination) oder bei der Injektion der Probe (Start 
with inject) automatisch gestartet. 
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Zeit (1. Spalte) Zeitpunkt für Ausführung des Befehls. 
Bereich: 0.0 ... 999.9 min 
Wird keine Zeit eingegeben, so wird der Be-
fehl zusammen mit dem letzten Befehl mit 
Zeitangabe ausgeführt. 

Befehl (2. Spalte) Programmbefehl (siehe unten). 
Parameter (3. Spalte) Parameter für Programmbefehl (s.u.). 

ENABLED Programm für Programmstart aktivieren (ein 
nicht aktiviertes Programm wird nicht ge-
startet). 

<Add> Neuen Programmbefehl hinzufügen. 
<Delete> Ausgewählten Programmbefehl löschen. 
<Verify> Zeitprogramm überprüfen (im Fehlerfall er-

scheinen Fehlermeldungen). 

 

Liste der Programmbefehle 
Die folgenden Programmbefehle können auf der Registerkarte 
Program in das Zeitprogramm eingefügt werden: 

Befehl  Parametereintrag Bedeutung 

Eluent A  Ventile so umschalten, dass Elu-
ent A gefördert wird. 

Eluent B  Ventile so umschalten, dass 
Eluent B gefördert wird. 

Eluent C  Ventile so umschalten, dass Elu-
ent C gefördert wird. 

 

Links 
Die Registerkarte Links im Fenster 816 IC Eluent Selector dient zur 
Wahl und Einstellung der COM-Schnittstelle (Details siehe Kap. 
5.2.4 Links). 
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6.15 828 IC Dual Suppressor 

6.15.1 Allgemeines zum 828 IC Dual Suppressor 

Der 828 IC Dual Suppressor ist ein kontinuierlicher, regenerie-
rungsfreier Festphasen-Suppressor, der eingesetzt wird, um die 
Nachweisempfindlichkeit von Anionen in der Ionenchroma-
tographie zu erhöhen. 

Der 828 IC Dual Suppressor, der normalerweise manuell über die 
Schalter des Geräts bedient wird, kann vollständig mit dem Pro-
gramm «IC Net» gesteuert werden. Dazu wird der 828 IC Dual 
Suppressor mit Hilfe eines Kabels 6.2128.180 am 762 IC Interface 
angeschlossen. Beispiele für Zusammenschaltungen mit dem 
828 IC Dual Suppressor finden sich in der Gebrauchsanwei-
sung 828. 

Für weitere Informationen zum 828 IC Dual Suppressor siehe Ge-
brauchsanweisung 828. 

 

 

6.15.2 Symbol für 828 IC Dual Suppressor 

 

Das 828-Gerätesymbol ist im Systemfenster verfügbar, wenn ein 
828 IC Dual Suppressor mit Hilfe des Systemassistenten New sys-
tem wizard oder mit der Option Setup/New devices/Install new device 
installiert wurde (siehe Kap. 6.1.2). 

Falls das System verbunden ist und das 828-Gerätesymbol mit 
der rechten Maustaste angeklickt wird, erscheint das folgende 
Menü: 

Open Fenster 828 IC Dual Suppressor für Parametereinstellun-
gen öffnen (dieses Fenster kann auch durch Doppel-
klick auf das Gerätesymbol geöffnet werden). 

Unlink 828-Gerätesymbol im Systemfenster löschen. 
 
 

 

6.15.3 Fenster "828 IC Dual Suppressor" 

816-Gerätesymbol / Open 
Die Wahl dieses Menüpunktes mit der rechten Maustaste oder ein 
Doppelklick auf das 828-Gerätesymbol öffnet das Fenster 828 IC 
Dual Suppressor für Parametereinstellungen. Es besteht aus den 
vier Registerkarten Manual, Program und Links. 
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Manual 
Die Registerkarte Manual im Fenster 828 IC Dual Suppressor ist nur 
bei einem verbundenem System verfügbar. 

 

Suppressor 

<On> Schaltet den Suppressor ein. 
<Off> Schaltet den Suppressor aus. 

Start with startup hardware 
Schaltet den Suppressor mit den anderen 
Geräten beim Hochfahren des Systems ein. 

 
 
 
 

 
Zeitprogramm 

Auf der Registerkarte Program im Fenster 828 IC Dual Suppressor 
kann ein benutzerspezifisches Zeitprogramm eingegeben wer-
den. Dieses Programm wird je nach Einstellung im Fenster Start 
mode (siehe Kap. 4.4.3) entweder beim Start der Bestimmung 
(Start with determination) oder bei der Injektion der Probe (Start 
with inject) automatisch gestartet. 
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Zeit (1. Spalte) Zeitpunkt für Ausführung des Befehls. 
Bereich: 0.0 ... 999.9 min 
Wird keine Zeit eingegeben, so wird der Be-
fehl zusammen mit dem letzten Befehl mit 
Zeitangabe ausgeführt. 

Befehl (2. Spalte) Programmbefehl (siehe unten). 
Parameter (3. Spalte) Parameter für Programmbefehl (s.u.). 

ENABLED Programm für Programmstart aktivieren (ein 
nicht aktiviertes Programm wird nicht ge-
startet). 

<Add> Neuen Programmbefehl hinzufügen. 
<Delete> Ausgewählten Programmbefehl löschen. 
<Verify> Zeitprogramm überprüfen (im Fehlerfall er-

scheinen Fehlermeldungen). 

 

Liste der Programmbefehle 
Die folgenden Programmbefehle können auf der Registerkarte 
Program in das Zeitprogramm eingefügt werden: 

Befehl  Parametereintrag Bedeutung 

Suppressor on, off Dual Suppressor ein-
/ausschalten. 
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Links 
Die Registerkarte Links im Fenster 828 IC Dual Suppressor dient zur 
Wahl der Event line. 
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6.16 750 Autosampler 

6.16.1 Allgemeines zum 750 Autosampler 

Der 750 Autosampler von Metrohm ist ein Probenwechsler für 
die automatische Probenaufgabe in der Ionenchromatographie 
mit einer Kapazität von bis zu 128 Proben mit einem effektiven 
Volumen von ca. 700 µL.  

Der 750 Autosampler, der normalerweise manuell über die Gerä-
tetastatur bedient wird, kann vollständig mit dem Programm «IC 
Net» gesteuert werden. Dazu wird der 750 Autosampler mit dem 
Kabel 6.2134.000 an das 762 IC Interface und mit dem Kabel 
6.2128.100 an das 733 IC Separation Center angeschlossen. Bei-
spiele für Zusammenschaltungen mit dem 750 Autosampler fin-
den sich in der Gebrauchsanweisung 762. 

 
Ist der 750 Autosampler am 762 IC Interface angeschlossen, 
muss immer zuerst das 762 IC Interface und erst dann der 750 
Autosampler eingeschaltet werden. Um den 750 Autosampler 
mit «IC Net» zu betreiben, muss die Fernsteuerung via RS232 
mit der Taste [ REM/LOC ] eingeschaltet werden. 

 
Für weitere Informationen zum 750 Autosampler siehe Ge-
brauchsanweisung 750. 

 

 

6.16.2 Symbol für 750 Autosampler 

 

Das 750-Gerätesymbol ist im Systemfenster verfügbar, wenn ein 
750 Autosampler mit Hilfe des Systemassistenten New system wi-
zard oder mit der Option Setup/New devices/Install new device instal-
liert wurde (siehe Kap. 6.1.2). 

Falls das System verbunden ist und das 750-Gerätesymbol mit 
der rechten Maustaste angeklickt wird, erscheint das folgende 
Menü: 

Open Fenster 750 Autosampler für Parametereinstellungen 
öffnen (dieses Fenster kann auch durch Doppelklick 
auf das Gerätesymbol geöffnet werden). 

Unlink 750-Gerätesymbol im Systemfenster löschen. 
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6.16.3 Fenster "750 Autosampler" 

750-Gerätesymbol / Open 
Die Wahl dieses Menüpunktes mit der rechten Maustaste oder ein 
Doppelklick auf das 750-Gerätesymbol öffnet das Fenster 750 Au-
tosampler für Parametereinstellungen. Es besteht aus den vier 
Registerkarten Manual, Injection, Diagnostics und Links. 

Manual 
Die Registerkarte Manual im Fenster 750 Autosampler ist nur bei ei-
nem verbundenem System verfügbar. 

 

Current data 
Vial number Live-Anzeige der aktuellen Gefässnummer. 
Needle position Live-Anzeige der aktuellen Nadelposition. 
Valve position Live-Anzeige der aktuellen Ventilposition 

am 733 IC Separation Center. 

Valve position for rinse 
Position des Injektionsventils am 733 IC 
Separation Center während des Spülens. 

Filter stopper for vials are used 
Falls Filterstopfen 6.2743.030 verwendet 
werden, sind nur 3 Injektionen pro Probe 
möglich. 
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Loop size is Grösse der Probenschleife am 733 IC Se-
paration Center. Falls das Schleifenvolu-
men > 20 µL ist, sind nur 3 Injektionen pro 
Probe möglich. 

<Move needle> Transfernadel zur gewünschten Gefässpo-
sition verschieben (1...128 oder Home). 

<Lower needle> Transfernadel in die gewünschte Position 
absenken (1...4). 

<Rinse needle> Manuelles Spülen aus dem gewünschten 
Gefäss starten (1...128). 

<Change valve position> 
Injektionsventil am 733 IC Separation Cen-
ter in die gewünschte Position (FILL oder 
INJECT) umschalten. 

<Disconnect> Manuelle Bedienung des 750 Autosamplers 
via Tastatur einschalten. 

Für weitere Informationen zum 750 Autosampler siehe Ge-
brauchsanweisung 750. 

 
 
 

Injection 
Die Registerkarte Injection im Fenster 750 Autosampler für die Aus-
führung von manuellen Injektionen ist nur bei einem verbunde-
nem System verfügbar. 
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Manual injection 
Sample vial number 

Nummer des Probengefässes, das für die 
manuelle Injektion verwendet wird. 

<Select> Wahl der Gefässnummer (1...128). 
Count of injections per vial 

Anzahl Injektionen pro Gefäss (1...4). 
<Select> Wahl der Injektionsnummer (1...4). 

Needle lowering type 
Injection number Position, an welche die Nadel bei Mehr-

fachinjektionen verschoben wird (1...4). 
Absolute position Position, an welche die Nadel bei Einfachin-

jektionen verschoben wird (1...4). 

Rinse type 
Standard shift Vorhergehendes (previous) oder nächstes 

(next) Gefäss für das Spülen verwenden. 
Nonstandard shift Für jede Probe die angegebene Anzahl Ge-

fässe überspringen und dieses Gefäss für 
das Spülen verwenden.  

No rinse between different sample vials 
Kein Spülen. 

Data acquisition started by software 
Ist diese Option eingeschaltet, wird die Da-
tenaufnahme mit "Inject" gestartet, wobei 
zwischen Injektionsventil und Interface kein 
Kabel benötigt wird. 
Ist diese Option ausgeschaltet, wird das 
Kabel 6.2115.070 für den Start der Daten-
aufnahme benötigt. 

<Inject> Injektion starten. 

Für weitere Informationen zum 750 Autosampler siehe Ge-
brauchsanweisung 750. 

 

 
Links 

Die Registerkarte Links im Fenster 750 Autosampler dient zur Wahl 
und Einstellung der COM-Schnittstelle (Details siehe Kap. 5.2.4 
Links). 



6  Devices 
 

IC Net 2.2 120 

6.17 766 IC Sample Processor 

6.17.1 Allgemeines zum 766 IC Sample Processor 

Der 766 IC Sample Processor von Metrohm ist ein Proben-
wechsler für die automatische Probenaufgabe in der Ionenchro-
matographie mit einer Kapazität von bis zu 127 Proben mit einem 
effektiven Volumen von bis zu 11 mL.  

Der 766 IC Sample Processor, der normalerweise manuell über 
die Gerätetastatur bedient wird, kann vollständig mit dem Pro-
gramm «IC Net» gesteuert werden. Dazu wird der 766 IC Sample 
Processor mit dem Kabel 6.2134.080 oder 6.2134.090 am 762 IC 
Interface angeschlossen. Falls die Injektionsventile am 733 IC 
Separation Center via 766 IC Sample Processor gesteuert werden 
sollen, wird das Kabel 6.2141.110 für den Anschluss des 766 IC 
Sample Processors und des 732 IC Detectors benötigt. Beispiele 
für Zusammenschaltungen mit dem 766 IC Sample Processor 
finden sich in der Gebrauchsanweisung 762. 

 
Um den 766 IC Sample Processor mit «IC Net» zu betreiben, 
müssen mit Hilfe der Taste [ CONFIG ] auf der Tastatur 766 die 
folgenden RS-Einstellungen vorgenommen werden: 
 >RS232 settings

handshake: SWChar
RS control: ON 

 
Für weitere Informationen zum 766 IC Sample Processor siehe 
Gebrauchsanweisung 766. 

 

 

 

6.17.2 Symbol für 766 IC Sample Processor 

 

Das 766-Gerätesymbol ist im Systemfenster verfügbar, wenn ein 
766 IC Sample Processor mit Hilfe des Systemassistenten New sys-
tem wizard oder mit der Option Setup/New devices/Install new device 
installiert wurde (siehe Kap. 6.1.2). 
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Falls das System verbunden ist und das 766-Gerätesymbol mit 
der rechten Maustaste angeklickt wird, erscheint das folgende 
Menü: 

Open Fenster 766 IC Sample Processor für Parametereinstel-
lungen öffnen (dieses Fenster kann auch durch Dop-
pelklick auf das Gerätesymbol geöffnet werden). 

Timeout Fenster öffnen, in dem eine Timeout-Zeit für den Scan-
Befehl (in s) eingegeben werden kann. 

Unlink 766-Gerätesymbol im Systemfenster löschen. 

 

6.17.3 Fenster "766 IC Sample Processor" 

766-Gerätesymbol / Open 
Die Wahl dieses Menüpunktes mit der rechten Maustaste oder ein 
Doppelklick auf das 766-Gerätesymbol öffnet das Fenster 766 IC 
Sample Processor für Parametereinstellungen und manuelle Steue-
rung. Es besteht aus den vier Registerkarten Manual, Program, 
Configuration und Links. 

Manual 
Die manuelle Steuerung des 766 IC Sample Processors kann auf 
der Unterseite Manual der Registerkarte Manual vorgenommen 
werden, die nur bei einem verbundenem System verfügbar ist. 

 

Move 
<Start> Verschieben des Racks starten, um das 

gewünschte Gefäss unter der Nadel zu po-
sitionieren. 
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<Stop> Verschieben des Racks stoppen. 
Position Wahl des Gefässes, das unter der Nadel 

positioniert werden soll. 
Auswahl: sample, sample+1, spec.#, 1...n 

Lift 
<Start> Anheben oder Absenken des Lifts zur ge-

wünschten Position starten. 
<Stop> Anheben oder Absenken des Lifts zur ge-

wünschten Position stoppen. 
Position Wahl der Position. 

Auswahl: shift, work, rinse, special, 0,  
1...125 mm 

Pump 
<Start> Schlauchquetschpumpe am Turm während 

der angegebenen Zeit einschalten. 
<Stop> Schlauchquetschpumpe am Turm aus-

schalten. 
Time Wahl der Pumpzeit. 

Auswahl: on (unendlich), 1...999 s 

Control 
<Set> Spezifiziertes Signal via Fernsteuerleitungen 

des 766 IC Sample Processors senden. 
Control lines Auswahl von speziellen Fernsteuerbefehlen 

oder individuellen Leitungseinstellungen 
(Details siehe Gebrauchsanweisung 
766). 

Program 
<Start> Programm starten. 
<Stop> Programm stoppen. 

Sample 
<Set> Probennummer für manuellen Programm-

start. 
Number Wahl der Rackposition. 

Auswahl: 1...n 

Für weitere Informationen zum 766 IC Sample Processor siehe 
Gebrauchsanweisung 766. 
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Status display 
Der aktuelle Status des 766 IC Sample Processors kann auf der 
Unterseite Current state der Registerkarte Manual angezeigt wer-
den, die nur für ein verbundenes System verfügbar ist. 

 
Sample Anzeige der aktuellen Probenposition. 
Vial position Anzeige der aktuellen Gefässposition. 
Lift position Anzeige der aktuellen Liftposition in mm. 
Pump state Anzeige des aktuellen Pumpenstatus (on, 

off). 

Status of the 8 input lines 
Status der Fernsteuereingangsleitungen. 

Status of the 14 output lines 
Status der Fernsteuerausgangsleitungen. 

<Ask> Aktuelle Werte vom 766 IC Sample Proces-
sor auslesen. 

Für weitere Informationen zum 766 IC Sample Processor siehe 
Gebrauchsanweisung 766. 

Zeitprogramm 
Auf der Registerkarte Program im Fenster 766 IC Sample Processor 
kann ein benutzerspezifisches Zeitprogramm eingegeben wer-
den. Dieses Programm wird je nach Einstellung im Fenster Start 
mode (siehe Kap. 4.4.3) entweder beim Start der Bestimmung 
(Start with determination) oder bei der Injektion der Probe (Start 
with inject) automatisch gestartet. 
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Num Zeilennummer (nur Anzeige). 
Task Programmbefehl (siehe unten). 
Parameter Parameter für Programmbefehl (s. u.). 

Enabled Programm für Programmstart aktivieren (ein 
nicht aktiviertes Programm wird nicht ge-
startet). 

<Add> Neuen Programmbefehl hinzufügen. 
<Delete> Ausgewählten Programmbefehl löschen. 
 

Liste der Programmbefehle 
Die folgenden Programmbefehle können auf der Registerkarte 
Program in das Zeitprogramm eingefügt werden: 

Befehl  Parametereintrag Bedeutung 

Move sample, sample+1, 
spec.#, 1...n 

Rack verschieben, um das ange-
gebene Gefäss unter der Nadel zu 
positionieren. 

Lift shift, work, rinse, 
special,  
0, 1...125 mm 

Lift zur angegebenen Position an-
heben oder absenken. 

Pump on, off, 1...999 s Schlauchquetschpumpe am Turm 
ein-/ausschalten. 

Scan "scan command" Remoteschnittstelle abfragen, bis 
das angegebene Signal empfan-
gen wird. Zusätzlich zu den norma-
len Abfragebefehlen (Details siehe 
Gebrauchsanweisung 766) kön-
nen auch die auf der Registerkarte 
Configuration definierten Befehle 
verwendet werden. 
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Befehl  Parametereintrag Bedeutung 

Ctrl "control  
command" 

Spezifiziertes Fernsteuerausgangs-
signal senden. Zusätzlich zu den 
normalen Abfragebefehlen (Details 
siehe Gebrauchsanweisung 766) 
können auch die auf der Register-
karte Configuration definierten Be-
fehle verwendet werden. 

Wait 1...9999 s Wartezeit. 

StartDA  Datenaufnahme starten. 
 
 

Configuration 
Die Registerkarte Configuration im Fenster 766 IC Sample Processor 
enthält Parametereinstellungen auf den fünf Unterseiten Rack, Vial 
positions, Needle positions, Control und Scan. 

Rack 

 

Rack definitions 
Code Binärer ID-Code zur Rackidentifikation (nur 

Anzeige). 
Type Vordefinierter Racktyp (nur Anzeige). 

Settings 
Maximum lift way Definition der tiefstmöglichen Liftposition in 

mm. 
Bereich: 0...125 mm 

<Apply> Parameter an 766 IC Sample Processor 
senden. 

<Ask> Aktuelle Parameter vom 766 IC Sample 
Processor auslesen. 
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Vial positions 

 
Rack type Aktueller Racktyp (nur Anzeige). 

Parameter Name für spezielle Gefässposition. 
Pattern Nummer der speziellen Gefässposition. 

<Add> Neue spezielle Gefässposition hinzufügen. 
<Delete> Ausgewählte spezielle Gefässposition lö-

schen. 
 

Needle positions 

 
Rack type Aktueller Racktyp (nur Anzeige). 

Parameter Name für spezielle Nadelposition. 
Pattern Liftposition für spezielle Nadelposition in 

mm. 

<Add> Neue spezielle Nadelposition hinzufügen. 
<Delete> Ausgewählte spezielle Nadelposition lö-

schen. 
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Control 

 

Parameter Name für speziellen Steuerbefehl. 
Pattern Fernsteuerleitungs-Einstellungen für spe-

ziellen Steuerbefehl. 

<Add> Neuen speziellen Steuerbefehl hinzufügen. 

<Delete> Ausgewählten speziellen Steuerbefehl lö-
schen. 
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Scan 

 

Parameter Name für speziellen Abfragebefehl. 
Pattern Fernsteuerleitungs-Einstellungen für spe-

ziellen Abfragebefehl. 

<Add> Neuen speziellen Abfragebefehl hinzufü-
gen. 

<Delete> Ausgewählten speziellen Abfragebefehl lö-
schen. 

 
Links 

Die Registerkarte Links im Fenster 766 IC Sample Processor dient 
zur Wahl und Einstellung der COM-Schnittstelle (Details siehe 
Kap. 5.2.4 Links). 
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6.18 788 IC Filtration Sample Processor 

6.18.1 Allgemeines zum 788 IC Filtration Sample 
Processor 

Der 788 IC Filtration Sample Processor von Metrohm ist ein 
Probenwechsler für die automatische Filtration und Probenaufga-
be in der Ionenchromatographie mit einer Kapazität von bis zu 
127 Proben mit einem effektiven Volumen von bis zu 11 mL.  

Der 788 IC Filtration Sample Processor, der normalerweise ma-
nuell über die Gerätetastatur bedient wird, kann vollständig mit 
dem Programm «IC Net» gesteuert werden. Dazu wird der 788 IC 
Filtration Sample Processor mit dem Kabel 6.2134.080 oder 
6.2134.090 am 762 IC Interface angeschlossen. Falls die Injekti-
onsventile am 733 IC Separation Center via 788 IC Filtration Sam-
ple Processor gesteuert werden sollen, wird das Kabel 
6.2141.110 für den Anschluss des 788 IC Filtration Sample Pro-
cessors und des 732 IC Detectors benötigt. Beispiele für Zusam-
menschaltungen mit dem 788 IC Filtration Sample Processor fin-
den sich in der Gebrauchsanweisung 762. 

 
Um den 788 IC Filtration Sample Processor mit «IC Net» zu 
betreiben, müssen mit Hilfe der Taste [ CONFIG ] auf der Tastatur 
788 die folgenden RS-Einstellungen vorgenommen werden: 
 >RS232 settings

handshake: SWChar
RS control: ON 

 
Für weitere Informationen zum 788 IC Filtration Sample Processor 
siehe Gebrauchsanweisung 788. 

 

6.18.2 Symbol für 788 IC Filtration Sample Processor 

 

Das 788-Gerätesymbol ist im Systemfenster verfügbar, wenn ein 
788 IC Filtration Sample Processor mit Hilfe des Systemassistenten 
New system wizard oder mit der Option Setup/New devices/Install 
new device installiert wurde (siehe Kap. 6.1.2). 
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Falls das System verbunden ist und das 788-Gerätesymbol mit 
der rechten Maustaste angeklickt wird, erscheint das folgende 
Menü: 

Open Fenster 788 IC Filtration Sample Processor für Parame-
tereinstellungen öffnen (dieses Fenster kann auch 
durch Doppelklick auf das Gerätesymbol geöffnet 
werden). 

Timeout Fenster öffnen, in dem eine Timeout-Zeit für den Scan-
Befehl (in s) eingegeben werden kann. 

Unlink 788-Gerätesymbol im Systemfenster löschen. 
 

6.18.3 Fenster "788 IC Filtration Sample Processor" 

788-Gerätesymbol / Open 
Die Wahl dieses Menüpunktes mit der rechten Maustaste oder ein 
Doppelklick auf das 788-Gerätesymbol öffnet das Fenster 788 IC 
Filtration Sample Processor für Parametereinstellungen und manu-
elle Steuerung. Es besteht aus den vier Registerkarten Manual, 
Program, Configuration und Links. 

Manual 
Die manuelle Steuerung des 788 IC Filtration Sample Processors 
kann auf der Unterseite Manual der Registerkarte Manual vorge-
nommen werden, die nur bei einem verbundenem System ver-
fügbar ist. 

 

Move 
<Start> Verschieben des Racks starten, um das 

gewünschte Gefäss unter der Nadel zu po-
sitionieren. 
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<Stop> Verschieben des Racks stoppen. 
Position Wahl des Gefässes, das unter der Nadel 

positioniert werden soll. 
Auswahl: sample, sample+1, spec.#, 1...n 

Lift 
<Start> Anheben oder Absenken des Lifts zur ge-

wünschten Position starten. 
<Stop> Anheben oder Absenken des Lifts zur ge-

wünschten Position stoppen. 
Position Wahl der Position. 

Auswahl: shift, work, rinse, special, 0,  
1...125 mm 

Pump 
<Start> Schlauchquetschpumpe am Turm während 

der angegebenen Zeit einschalten. 
<Stop> Schlauchquetschpumpe am Turm aus-

schalten. 
Time Wahl der Pumpzeit. 

Auswahl: on (unendlich), 1...999 s 

Control 
<Set> Spezifiziertes Signal via Fernsteuerleitungen 

des 788 IC Filtration Sample Processors 
senden. 

Control lines Auswahl von speziellen Fernsteuerbefehlen 
oder individuellen Leitungseinstellungen 
(Details siehe Gebrauchsanweisung 
788). 

Program 
<Start> Programm starten. 
<Stop> Programm stoppen. 

Sample 
<Set> Probennummer für manuellen Programm-

start. 
Number Wahl der Rackposition. 

Auswahl: 1...n 

Für weitere Informationen zum 788 IC Filtration Sample Processor 
siehe Gebrauchsanweisung 788. 
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Status display 
Der aktuelle Status des 788 IC Filtration Sample Processors kann 
auf der Unterseite Current state der Registerkarte Manual ange-
zeigt werden, die nur für ein verbundenes System verfügbar ist. 

 
Sample Anzeige der aktuellen Probenposition. 
Vial position Anzeige der aktuellen Gefässposition. 
Lift position Anzeige der aktuellen Liftposition in mm. 
Pump state Anzeige des aktuellen Pumpenstatus (on, 

off). 

Status of the 8 input lines 
Status der Fernsteuereingangsleitungen. 

Status of the 14 output lines 
Status der Fernsteuerausgangsleitungen. 

<Ask> Aktuelle Werte vom 788 IC Filtration Sample 
Processor auslesen. 

Für weitere Informationen zum 788 IC Filtration Sample Processor 
siehe Gebrauchsanweisung 788. 

Zeitprogramm 
Auf der Registerkarte Program im Fenster 788 IC Filtration Sample 
Processor kann ein benutzerspezifisches Zeitprogramm eingege-
ben werden. Dieses Programm wird je nach Einstellung im Fens-
ter Start mode (siehe Kap. 4.4.3) entweder beim Start der Bestim-
mung (Start with determination) oder bei der Injektion der Probe 
(Start with inject) automatisch gestartet. 
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Num Zeilennummer (nur Anzeige). 
Task Programmbefehl (siehe unten). 
Parameter Parameter für Programmbefehl (s. u.). 

Enabled Programm für Programmstart aktivieren (ein 
nicht aktiviertes Programm wird nicht ge-
startet). 

<Add> Neuen Programmbefehl hinzufügen. 
<Delete> Ausgewählten Programmbefehl löschen. 
 

Liste der Programmbefehle 
Die folgenden Programmbefehle können auf der Registerkarte 
Program in das Zeitprogramm eingefügt werden: 

Befehl  Parametereintrag Bedeutung 

Move sample, sample+1, 
spec.#, 1...n 

Rack verschieben, um das ange-
gebene Gefäss unter der Nadel zu 
positionieren. 

Lift shift, work, rinse, 
special,  
0, 1...125 mm 

Lift zur angegebenen Position an-
heben oder absenken. 

Pump on, off, 1...999 s Schlauchquetschpumpe am Turm 
ein-/ausschalten. 

Scan "scan command" Remoteschnittstelle abfragen, bis 
das angegebene Signal empfan-
gen wird. Zusätzlich zu den norma-
len Abfragebefehlen (Details siehe 
Gebrauchsanweisung 788) kön-
nen auch die auf der Registerkarte 
Configuration definierten Befehle 
verwendet werden. 
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Befehl  Parametereintrag Bedeutung 

Ctrl "control  
command" 

Spezifiziertes Fernsteuerausgangs-
signal senden. Zusätzlich zu den 
normalen Abfragebefehlen (Details 
siehe Gebrauchsanweisung 788) 
können auch die auf der Register-
karte Configuration definierten Be-
fehle verwendet werden. 

Wait 1...9999 s Wartezeit. 

StartDA  Datenaufnahme starten. 
 
 

Configuration 
Die Registerkarte Configuration im Fenster 788 IC Filtration Sample 
Processor enthält Parametereinstellungen auf den fünf Unterseiten 
Rack, Vial positions, Needle positions, Control und Scan. 

Rack 

 

Rack definitions 
Code Binärer ID-Code zur Rackidentifikation (nur 

Anzeige). 
Type Vordefinierter Racktyp (nur Anzeige). 

Settings 
Maximum lift way Definition der tiefstmöglichen Liftposition in 

mm. 
Bereich: 0...125 mm 

<Apply> Parameter an 788 IC Filtration Sample 
Processor senden. 

<Ask> Aktuelle Parameter vom 788 IC Filtration 
Sample Processor auslesen. 
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Vial positions 

 
Rack type Aktueller Racktyp (nur Anzeige). 

Parameter Name für spezielle Gefässposition. 
Pattern Nummer der speziellen Gefässposition. 

<Add> Neue spezielle Gefässposition hinzufügen. 
<Delete> Ausgewählte spezielle Gefässposition lö-

schen. 
 

Needle positions 

 
Rack type Aktueller Racktyp (nur Anzeige). 

Parameter Name für spezielle Nadelposition. 
Pattern Liftposition für spezielle Nadelposition in 

mm. 

<Add> Neue spezielle Nadelposition hinzufügen. 
<Delete> Ausgewählte spezielle Nadelposition lö-

schen. 
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Control 

 

Parameter Name für speziellen Steuerbefehl. 
Pattern Fernsteuerleitungs-Einstellungen für spe-

ziellen Steuerbefehl. 

<Add> Neuen speziellen Steuerbefehl hinzufügen. 

<Delete> Ausgewählten speziellen Steuerbefehl lö-
schen. 
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Scan 

 

Parameter Name für speziellen Abfragebefehl. 
Pattern Fernsteuerleitungs-Einstellungen für spe-

ziellen Abfragebefehl. 

<Add> Neuen speziellen Abfragebefehl hinzufü-
gen. 

<Delete> Ausgewählten speziellen Abfragebefehl lö-
schen. 

 
Links 

Die Registerkarte Links im Fenster 788 IC Filtration Sample Proces-
sor dient zur Wahl und Einstellung der COM-Schnittstelle (Details 
siehe Kap. 5.2.4 Links). 
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6.19 Datenaufzeichner 

6.19.1 Symbol für Datenaufzeichner 

 

Das Symbol für den Datenaufzeichner ist eines der Elemente, 
die in einem neuen Systemfenster immer vorhanden sind. Falls 
das System verbunden ist und mit der rechten Maustaste auf die-
ses Symbol geklickt wird, erscheint das folgende Menu: 

Open Prozessmethode laden und leeres Chromato-
grammfenster öffnen (dieses Fenster wird auch 
mit einem Doppelklick auf das Symbol geöffnet). 

Setup Fenster für die Wahl der Prozessmethode und 
Datenquelle öffnen (siehe unten). 

Upload buffer Laden des letzten Chromatogramms, das mit 
dem 762 IC Interface aufgenommen wurde (Up-
load buffer funktioniert nicht bei Datenaufnahme 
mit anderen Interfaces). Das Chromatogramm 
erscheint sofort in einem neuen Fenster und wird 
unter einem neuen Namen gespeichert. 

Unlink Symbol für Datenaufzeichner im Systemfenster 
löschen. 

Sollen gleichzeitig mehrere Ein-Kanal-Chromatogramme auf-
gezeichnet werden, muss für jeden Detektor ein Datenaufzeichner 
installiert werden. Für die Aufzeichnung von Multi-Kanal-Chro-
matogrammen genügt ein Datenaufzeichner, die verschiedenen 
Datenquellen müssen aber alle mit diesem Datenaufzeichner ver-
knüpft werden. 

6.19.2 Prozessmethode und Datenquelle auswählen 

Der Menüpunkt Data recorder icon / Setup öffnet das folgende Fen-
ster: 
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Processing method Name der Methodendatei (*.mtw), die mit 
dem System verknüpft ist. 

<show> Prozessmethode öffnen. 
<choose> Methodendatei (*.mtw) auswählen. 

Connected data source Datenquelle für Hauptmesskanal.  
<choose> Fenster Data source für Wahl der Datenquel-

le öffnen: 
 

 

Connected Verbundene Datenquellen. 

Available Verfügbare Datenquellen: 
762 IC Interface 

# ch1 to ch4 Datenkanäle des 762 IC Interfaces. 
771 Compact Interface 

# ch1 and ch2 Datenkanäle des 771 Compact Interfaces. 
761 Compact IC 

# Cond Leitfähigkeitskanal des 761 Compact IC. 
# Press Druckkeitskanal des 761 Compact IC. 

732 IC Detector 
# Cond Leitfähigkeitskanal des 732 IC Detector. 
# Abs.Cond Absoluter Leitfähigkeitskanal 732 IC Detec-

tor. 
PC Board# 

# ch1 and ch2 Datenkanäle des PC Board 1 oder PC 
Board 2. 

817 Bioscan 
# Cell Zellpotentialkanal des 817 Bioscan. 
# Temp Temperaturkanal des 817 Bioscan. 
# E Potentialkanal des 817 Bioscan. 

709 IC Pump 
# flow Flusskanal der 709 IC Pump. 
# pressure Druckkanal der 709 IC Pump. 

Pump control system (SDU) 
# flow Flusskanal der SDU. 
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# pressure Druckkanal der SDU. 
# % A Kanal mit Prozentanteil von Eluent A der 

SDU. 
# % B Kanal mit Prozentanteil von Eluent B der 

SDU. 
# % C Kanal mit Prozentanteil von Eluent C der 

SDU. 
# % D Kanal mit Prozentanteil von Eluent D der 

SDU. 
 

Show AUX channels Ist diese Option eingeschaltet, werden die 
Hilfsdatenkanäle (gelb) zusätzlich zu den 
Hauptdatenkanälen (grün) angezeigt. 

 

Die Datenquelle kann mit Hilfe der Knöpfe    oder    von ei-
nem Feld ins andere verschoben werden (immer nur eine). 

 



 6.20  System-Zeitschaltuhr 
 

IC Net 2.2 141

6.20 System-Zeitschaltuhr 

6.20.1 Symbol der Zeitschaltuhr 

 

Mit der System-Zeitschaltuhr können Aktionen für ein System 
programmiert werden, die automatisch täglich oder einmalig zur 
gewünschten Zeit gestartet werden. Das Symbol für die System-
Zeitschaltuhr ist im Systemfenster verfügbar, wenn ein Timer mit 
Hilfe des Systemassistenten New system wizard oder mit der Opti-
on Setup/New devices/Install new device installiert wurde (siehe Kap. 
6.1.2). 

 

 

6.20.2 Programm der Zeitschaltuhr 

Die Programmierung der System-Zeitschaltuhr ist identisch zu 
derjenigen der globalen Zeitschaltuhr (siehe Kap. 5.5.2). 
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7 Methoden 
Eine Methode enthält alle Informationen, die zur Datenerfas-
sung, Integration, Peakauswertung und Resultatberech-
nung notwendig sind. Sie kann als Gerüst des Chromato-
gramms, also als Chromatogramm ohne Daten betrachtet wer-
den. Methoden werden als Methodendateien (*.mtw) im Ver-
zeichnis Methods gespeichert 
Jedes System ist mit einer Methode verbunden. Diese Methode 
wird Prozessmethode genannt und beim Start einer neuen Be-
stimmung automatisch geöffnet. 

 
7.1 Methoden verwalten 

Das Öffnen und Speichern von Methoden erfolgt mit den folgen-
den Menüpunkten: 

IC NET / File / Open / Method 

Laden einer bestehenden Methodendatei (*.mtw) aus dem Ver-
zeichnis Methods und Öffnen eines leeren Chromatogrammfen-
sters. 
Der Name der Methode wird in der Titelleiste des Systemfensters 
in Klammern angezeigt. Ein Stern ( * ) am Ende des Namens zeigt 
an, dass die Methode seit der letzten Speicherung verändert wur-
de. 

IC NET / File / Save / Method 

Methode des aktiven Chromatogramms in einer Methodendatei 
(*.mtw) im Verzeichnis Methods speichern. 

7.2 Passport 

 IC NET / Method / Passport 

Mit diesem Menüpunkt wird das Fenster Passport geöffnet. Als 
"Passport" wird jener Bestandteil der Methode bezeichnet, der ei-
ne detaillierte Beschreibung der chromatographischen Bestim-
mung enthält und aus den folgenden Registerkarten besteht: 
General  Allgemeine Informationen zur Bestimmung. 
Sample  Informationen zur Probe. 
Column  Informationen zur Trennsäule. 
Eluent  Informationen zum Eluenten. 
Comment  Kommentar. 
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7.2.1 General 
Registerkarte General des Methoden-Passports mit allgemeinen 
Informationen zur Bestimmung.  

 

Ident Kennzeichnung für das Chromatogramm, 
die in der Titelzeile des Chromatogramm-
fensters und als zusätzliche, kurze Informa-
tion im Fenster Chromatogram open ange-
zeigt wird. 

Duration Dauer des Chromatogramms in Minuten. 
Kann bei laufendem Chromatogramm ver-
ändert werden kann. 

METHOD  Pfad und Dateiname der für die Datenauf-
nahme verwendeten Methode (nur Anzei-
ge). 

DATA Pfad und Dateiname des aktuellen Chro-
matogramms (nur Anzeige). 

Date/time Datum und Zeit des Chromatogramm-
Starts (nur Anzeige). 

Last update Datum und Uhrzeit der letzten Speicherung 
des Chromatogramms (nur Anzeige). 

Calibration level Kalibrierpunkt. Falls ein Chromatogramm 
zur Kalibrierung verwendet wird, wird hier 
eine positive ganze Zahl angegeben, an-
sonsten erhält dieses Feld den Wert Null. 
Der Wert kann während dem laufenden 
Chromatogramm verändert werden. 

User Voller Name des aktuellen Anwenders (nur 
Anzeige). 

Detector Name des Detektors. Dieser kann unter Me-
thod setup / Measure eingegeben werden. 
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Run Laufende Nummer der aktuellen Bestim-
mung (nur Anzeige). Alle Bestimmungen 
werden automatisch durchnumeriert. 

 
Mit [Ctrl] [F8] öffnet sich das Fenster Ana-
lysis number, in dem die laufende Num-
mer Run auf den gewünschten Wert zu-
rückgesetzt werden kann. 

Batch X/Y: Anzahl der gestarteten Probentabellen 
/ aktuelle Analysen-Nummer in der Proben-
tabelle (nur Anzeige). 

7.2.2 Sample 
Registerkarte Sample des Methoden-Passports mit Informationen 
zur Probe.  

 

Info 1 Informationen 1 zur Probe (max. 256 Zei-
chen). 

Info 2 Informationen 2 zur Probe (max. 256 Zei-
chen). 

Volume Injektionsvolumen in µL. 
Dilution Verdünnung der Probe. 
Vial number Position der Probe auf dem Probenwechs-

ler. 

Amount Probenmenge. Ist dieser Wert für Probe (s) 
und Kalibrierlösungen (c) verschieden, so 
werden die Konzentrationen der Kompo-
nenten in der Probe wie folgt berechnet: 
  Cs = Cc • Amounts / Amountc 



 7.2  Passport 
 

IC Net 2.2 145

Internal standard amount 
Konzentration des internen Standards. 

Date/time when... Datum und Zeit der Probenahme (ohne 
Eingabe wird hier automatisch Datum und 
Zeit beim Start der Bestimmung eingefügt). 

7.2.3 Column 
Registerkarte Column des Methoden-Passports mit Informationen 
zur Trennsäule.  

 
Number Serienr. der Säule (max. 256 Zeichen). 
ID Innendurchmesser der Säule in mm. 
Length Länge der Säule in mm. Dieser Parameter 

wird benutzt, um die lineare Strömungsge-
schwindigkeit Linear flow zu berechnen. 

Packing material Packungsmaterial 
Column Bezeichnung der Säule (max. 256 Zeichen). 
Particle size  Teilchengrösse der Trennsäule in µm. Die-

ser Wert wird zur Berechnung der reduzier-
ten theoretischen Bodenhöhe Reduced TP 
height verwendet. 

Void volume  Volumen der leeren Trennsäule in %. Es 
wird zur Berechnung von logarithmischem 
Index Logarithmic index, Kapazitätsfaktor 
Capacity factor und linearer Strömungsge-
schwindigkeit Linear flow verwendet. Der 
Wert wird vom System in Zusammenhang 
mit den Einstellungen unter Method setup / 
Math berechnet. 

Precolumn Vorsäule 
ID Innendurchmesser der Vorsäule in mm. 
Length Länge der Vorsäule in mm (Wert auf 0 set-

zen, wenn keine Vorsäule verwendet wird). 



7  Methoden 
 

IC Net 2.2 146 

7.2.4 Eluent 
Registerkarte Eluent des Methoden-Passports mit Informationen 
zum Eluenten.  

 

Eluent A Beschreibung der Eluentzusammensetzung 
(max. 256 Zeichen). 

Eluent B Beschreibung der Eluentzusammensetzung 
(max. 256 Zeichen). 

Eluent C Beschreibung der Eluentzusammensetzung 
(max. 256 Zeichen). 

Flow Flussrate der Hochdruckpumpe in mL/min 
oder µL/min. Die Flussrate wird verwendet, 
um die Zeitachse in Volumeneinheiten um-
zurechnen. Beim Start einer Bestimmung 
mit Start with inject wird automatisch der 
Systemstartwert in dieses Feld eingetragen. 

Pressure Druck in MPa, psi, bar, oder atm. Beim 
Start einer Bestimmung mit Start with inject 
wird automatisch der gemessene Druck in 
dieses Feld eingetragen. 

Temp. Temperatur in °C. Hier kann die Temperatur 
einer thermostatisierten Säule oder die 
Umgebungstemperatur eingegeben wer-
den. 
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7.2.5 Comment 
Registerkarte Comment des Methoden-Passports mit benutzerde-
finiertem Kommentar für die Beschreibung des Chromato-
gramms. Diese Option kann dazu verwendet werden, beliebige 
Zusatzinformationen zum Chromatogramm einzugeben, welche 
nicht in anderen Teilen der Methode enthalten sind. 
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7.3 Method setup 

 IC NET / Method / Method setup 

Mit diesem Menüpunkt wird das Fenster Method setup geöffnet, 
das die wichtigsten Einstellungen der Methode für die Datenauf-
nahme und Datenverarbeitung enthält und aus den folgenden 
Registerkarten besteht: 
General  Allgemeine Informationen zur Bestimmung. 
Measure  Wichtige Parameter für Datenaufnahme. 
Filters  Parameter zur Filterung des Messignals. 
Processing  Festlegen von Aktionen, welche nach Ab-

schluss des Chromatogramms ablaufen. 
Math  Parameter welche für verschiedene Be-

rechnungen verwendet werden. 
7.3.1 General 

Registerkarte General des Methoden-Passports mit allgemeinen 
Informationen zur Bestimmung. Diese Unterseite ist identisch mit 
General unter Method / Passport (siehe Kap. 7.2.1). 

7.3.2 Measure 
Registerkarte Measure von Method setup mit Parametern für die 
Datenaufnahme.  

 
Status Chromatogrammstatus (nur Anzeige). 

Sampling rate Abfragefrequenz für die Aufnahme des 
Chromatogramms (nur Anzeige; wird nur 
bei laufenden oder aufgenommenen 
Chromatogrammen korrekt angezeigt). 

Frequency divisor Divisor zur Verringerung der Abfragefre-
quenz. Eingabebereich:  1…9999 

Start delay Wartezeit bis zum Start der Datenaufnahme 
in min. 

Detector name Benutzerdefinierter Name des Detektors. 
Data acquisition source  Messkanal (nur Anzeige). 
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7.3.3 Filters 
Registerkarte Filters von Method setup mit Parametern für die Filte-
rung der gemessenen Rohdaten. Zur Verminderung des Rau-
schens und Erhöhung des Signal-Rausch-Verhältnisses stehen 
drei verschiedene Filter-Algorithmen zur Verfügung. 

 

Spikes Spike-Filter. Der Spike-Filter glättet die ersten 
und letzten Punkte des Chromatogramms und 
die Punkte, welche als Spikes identifiziert wer-
den. Der Spike wird durch die halbe Summe 
der beiden benachbarten Punkte ersetzt. 

Slit Median Median-Filter. Wird aktiviert, wenn ein von 
Null abweichender Glättungsgrad eingegeben 
ist. Der Glättungsgrad sollte durch eine natür-
liche Zahl definiert werden. Beim Median-Filter 
werden die Werte innerhalb des Fensters nach 
steigendem Signal sortiert und der Mittelwert 
des Signals in diesem Fenster wird durch den 
Mittelwert einer sortierten Reihe ersetzt. Diese 
Methode beeinflusst chromatographische 
Peaks in geringem Ausmass, verbessert die 
Basislinie und eliminiert sehr effektiv Ein-
Punkt-Spikes. Hierbei wird der Spike mit ei-
nem der Nachbarpunkte ersetzt. 

Slit Gaussian  Gauss-Filter. Wird aktiviert, wenn ein von Null 
abweichender Glättungsgrad eingegeben ist. 
Bei der Glättung nach Gauss wird die Summe 
aller Punkte innerhalb eines Fensters mit Hilfe 
der Gauss-Verteilung berechnet und als neuer 
Rohdaten-Punkt verwendet. Die Peaks werden 
nach der Glättung etwas kleiner und breiter, 
ihre Fläche ändert sich jedoch nicht. 

Raw data points  Anzahl der Datenpunkte des Chromato-
gramms (nur Anzeige). 
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Smallest peak has ... Anzahl Datenpunkte des kleinsten Peaks im 
Chromatogramm (nur Anzeige). Diese Infor-
mation ist wichtig, um die Prozedur Com-
press (Datenverdichtung) durchzuführen. 

7.3.4 Processing 
Registerkarte Processing von Method setup mit der Definition der 
Aktionen, die während oder nach der Aufnahme des Chroma-
togramms ablaufen sollen. Diese Einstellungen sind besonders 
nützlich, wenn mit einem Probenwechsler gearbeitet wird. 

 
Save chromatogram after the run 

Ist diese Option eingeschaltet, wird das 
Chromatogramm nach Beendigung der Da-
tenaufnahme automatisch gespeichert. 

while running every ... min  
Speichert das laufende Chromatogramm 
während der Aufnahme im angegebenen 
Zeitintervall (mit 0 wird das laufende Chro-
matogramm nicht zwischengespeichert). 

Send data to Autodatabase file 
Ist diese Option eingeschaltet, werden die 
Chromatogrammdaten automatisch in die 
Autodatabase-Datei geschrieben, die im 
Fenster Autodatabase options definiert wurde 
(siehe Kap. 8.6.8). 

Show all Ist diese Option eingeschaltet, werden die 
Achsenskalierungen nach der Datenauf-
nahme automatisch so angepasst, dass 
das aufgenommene Chromatogramm ins 
Fenster passt. 

Make report Ist diese Option eingeschaltet, wird der Re-
port nach Beendigung der Datenaufnahme 
automatisch ausgegeben. 
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Close window Ist diese Option eingeschaltet, wird das 
Chromatogrammfenster nach Ende der Da-
tenaufnahme automatisch geschlossen. 

Chromatogram directory 
Verzeichnis, in dem das Chromatogramm 
gespeichert wird. Mit <Browse> kann ein 
neues Verzeichnis ausgewählt werden. 

Program before Verzeichnis und Name des Programms, 
das vor dem Start der Bestimmung auto-
matisch gestartet wird. 

Program after Verzeichnis und Name des Programms, 
das nach dem Ende der Bestimmung auto-
matisch gestartet wird. 

7.3.5 Math 
Registerkarte Math von Method setup mit der Definition von Para-
metern, die für verschiedene Berechnungen verwendet werden. 

 
Parameter Wahl der Berechnungsparameter: 

Formula set Wahl der Formeln durch den Anwender 
(Custom formulae) oder gemäss European 
Pharmacopea oder US Pharmacopea. 

Theoretical plates Wahl der Formel für die Bodenzahl (Anzahl 
theoretischer Trennstufen), falls Formula set 
= Custom formulae gewählt wurde. 

Resolution Wahl der Formel für die Auflösung, falls 
Formula set = Custom formulae gewählt wur-
de. 

Asymmetry Wahl der Formel für den Asymmetriefaktor, 
falls Formula set = Custom formulae gewählt 
wurde. 

Formula Wahl der Berechnungsformel für den un-
ter Parameter ausgewählten Berechnungs-
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parameter. Mit Parameter = Formula set sind 
folgende Einstellungen möglich: 

Custom formulae Wahl der Berechnungsformeln durch den 
Anwender. 

European Pharmacopoeia 
Wahl der Berechnungsformeln gemäss der 
Europäischen Pharmakopöe. 

US Pharmacopoeia Wahl der Berechnungsformeln gemäss der 
US-Amerikanischen Pharmakopöe. 

Void time/volume Berechnung von Totzeit/Totvolumen: 
Calculation method Wahl der Berechnungsmethode: 

None Manuelle Eingabe im Feld Void time. 
1st component Der zur ersten Komponente gehörige Peak 

wird als Totzeitmarke gewählt und dessen 
Retentionszeit ersetzt den vorherigen Wert 
der Totzeit. Wenn die erste Komponente 
nicht identifiziert wurde, wird die erwartete 
Retentionszeit verwendet. 

1st peak Der erste detektierte Peak wird als Totzeit-
marke verwendet und dessen Retentions-
zeit wird im Feld Void time gespeichert. 

From void volume % 
Für die Berechnung der Totzeit wird der un-
ter Void volume eingegebene Prozentwert 
multipliziert mit dem Quotienten des leeren 
Säulenvolumens und der Flussrate des Elu-
enten. 

Void volume Totvolumen in mL und % des Säulenvolu-
mens. Der Prozentwert kann manuell ein-
gegeben werden, falls Calculation method = 
From void volume % gewählt wurde. 

Void time Totzeit in s. Dieser Wert kann manuell ein-
gegeben werden, falls Calculation method = 
None gewählt wurde. 

Index Berechnung des Retentionsindexes: 
Interpolation Wahl eines linearen oder logarithmischen 

Interpolations-Massstabs. 
Internal Der Interpolations-Massstab wird auf der 

Basis des aktuellen Chromatogramms kon-
struiert. Alle Komponenten, die zur Kalibrie-
rung dieses Massstabs verwendet werden, 
sollten in der aktuellen Probe vorhanden 
sein. 

External Der Interpolations-Massstab wird auf der 
Basis eines externen Standard-Chromato-
gramms konstruiert. 
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7.4 Integration 

7.4.1 Allgemeines 

 IC NET / Method / Integration 

Mit diesem Menüpunkt wird das Fenster Integration parameters 
geöffnet, das Parameter und Ereignisse zur Beeinflussung der 
Peakintegration enthält und aus den Registerkarten Setup (siehe 
Kap. 7.4.2) und Events (siehe Kap. 7.4.3) besteht. 

Die Software «IC Net» enthält einen automatischen Integrations-
Algorithmus zur Erkennung von Peaks in der chromatographi-
schen Kurve und deren Auswertung mit Hilfe von berechneten 
Basislinien. Die Integration wird durch die Integrationsparameter 
auf der Seite Setup und die Integrations-Ereignisse Events be-
stimmt, wobei die Integrations-Ereignisse eine höhere Priorität 
haben als die Integrationsparameter. Die Integration kann zudem 
mit dem Peak-Editor manuell beeinflusst werden (siehe Kap. 8.4). 

Für die Peakerkennung wird der Wert der ersten Ableitung (Stei-
gung) der gemessenen Kurve durch das Basislinienrauschen di-
vidiert und das Resultat mit einem Grenzwert, genannt “Slope” 
verglichen. Die Grenzwerte für Beginn und Ende eines Peaks sind 
dabei unterschiedlich. 

Für jeden Peak wird die Basislinie ermittelt und Start- und End-
punkt bestimmt. Für getrennte Peaks besteht die Basislinie aus 
einer geraden Linie zwischen Start- und Endpunkt. Bei benach-
barten Peaks, die sich überlappen, wird normalerweise eine ge-
meinsame Basislinie konstruiert, die den Startpunkt des ersten 
Peaks mit dem Endpunkt des letzten Peaks verbindet. Die Peaks 
werden dann durch Fällen eines Lots vom tiefsten Punkt (Tal-
punkt) zwischen den Peaks auf die gemeinsame Basislinie von-
einander getrennt. Alternativ dazu kann mit dem Ereignis Enable 
valley-to-valley (siehe Integrations-Ereignisse für Basislinie) die 
Basislinie auch direkt zwischen den Talpunkten der Peaks gezo-
gen werden. 
 

 

 

Peakspitze 

Einzelpeak 

Überlappende Peaks 

LotTalpunkt Basislinie Peakende Peakstart 
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7.4.2 Setup 
Registerkarte Setup des Fensters Integration parameters mit den In-
tegrationsparametern. Die beiden wichtigsten dieser Parameter 
für die Peakerkennung sind Width und Slope. 

 
Bei hohem Signal-zu-Rausch-Verhältnis (z.B. 100:1 oder höher) 
ist der Integrationsalgorithmus nicht allzu empfindlich auf Ände-
rungen der Integrationsparameter. Bei hohem Basislinienrau-
schen dagegen ist oft eine optimale Einstellung dieser Parame-
ter unbedingt notwendig. 

 

 

Number of peaks Anzahl gefundener Peaks (nur Anzeige). 

Channel Messkanal für Peakerkennung  
(nur Anzeige) 

Delay  Zeitliche Verzögerung bis zum Start der In-
tegration (in min). 
Eingabebereich:  0…1440 min 

Width Peakbreite (auf der Basislinie, in s).  
Dieser Parameter beeinflusst die Festle-
gung von Start- und Endpunkten für Peaks. 
Wird Width zu klein gewählt, werden sehr 
kleine, überflüssige Peaks aus dem Rau-
schen detektiert. Ist Width zu gross, können 
mehrere benachbarte Peaks oder die Drift 
der Basislinie als ein Einzelpeak ausgewer-
tet werden. Für eine optimale Auswertung 
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wird empfohlen, hier die Breite des schmal-
sten Peaks im Chromatogramm einzuge-
ben (normalerweise 2…10 s). 
Eingabebereich:  0.1…480 s 

Broadening Verbreiterung der Peaks am Ende des 
Chromatogramms verglichen mit Peaks am 
Anfang. Dieser Parameter dient zur auto-
matischen Anpassung von Width auf Grund 
der Peakverbreiterung. 
Eingabebereich:  0.1…100 

Slope Grenzwert für Peakerkennung. 
Der Wert der ersten Ableitung (Steigung) 
der Kurve wird durch das Basislinienrau-
schen (ermittelt durch einen speziellen Al-
gorithmus) dividiert und das Resultat mit 
dem Grenzwert Slope verglichen. Vernünfti-
ge Resultate erhält man je nach Chroma-
togramm mit Werten von 0.5…5. 
Eingabebereich:  0.1…400 

Asymmetry Verhältnis der Steigung am Anfang des 
Peaks zu der am Ende des Peaks. Dieser 
Parameter dient zur automatischen Anpas-
sung von Slope. 
Eingabebereich:  0.2…5 

Min area Min. Fläche, ab der Peaks erkannt werden. 
Min height Min. Höhe, ab der Peaks erkannt werden. 
Rider ratio Verhältnis der Peakhöhen von zwei aufein-

anderliegenden Peaks. Wird der hier ange-
gebene Grenzwert überschritten, so wird 
der kleinere Peak (Rider) vom grösseren 
durch eine Tangente abgegrenzt. Mit der 
Eingabe von 0 ist diese Funktion immer 
ausgeschaltet. 
Eingabebereich:  0…100 

  

Negative peaks Ist diese Option aktiviert, werden auch ne-
gative Peaks erkannt. 

Interpolate baseline start/stop 
Ist diese Option aktiviert, werden die Start- 
und Endpunkte für die Peakbasislinien in-
terpoliert. Diese Einstellung wird für sehr 
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empfindliche Messungen mit hohem Rau-
schen empfohlen. 

<Suggest> Funktion zur automatischen Einstellung ver-
nünftiger Integrationsparameter. Die Para-
meter werden wie folgt gesetzt: 
• Slope wird auf auf einen vernünftigen 

Wert gesetzt. 
• Asymmetry wird auf einen vernünftigen 

Wert gesetzt. 
• Width und Broadening werden berechnet, 

indem Halbwertsbreiten gegen die Re-
tentionszeiten aufgezeichnet werden und 
eine Gerade durch die gemessenen 
Punkte gelegt wird. Width wird bestimmt 
als y-Wert dieser Geraden zur Zeit Delay, 
Broadening wird berechnet als y-Wert am 
Ende des Chromatogramms dividiert 
durch den y-Wert zur Zeit Delay. Falls 
dieses Verfahren keine passenden Er-
gebnisse liefert, so wird 

• Width mit dem minimalen Wert für die 
Peakbreite des Chromatogramms 
gleichgesetzt, 

• Broadening auf einen vernünftigen Wert 
gesetzt. 

7.4.3 Events 
Registerkarte Events des Fensters Integration parameters für die 
Definition von Integrations-Ereignissen. Integrations-Ereignisse 
haben eine höhere Priorität als die Integrationsparameter und 
werden zur Feineinstellung der Integrations-Prozedur verwendet. 
Sie sollten nur dann eingesetzt werden, wenn bei der Integration 
Probleme auftauchen, die nicht durch Ändern der Integrationspa-
rameter allein gelöst werden können. 
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Number of events Anzahl Integrations-Ereignisse  
(nur Anzeige). 

<Add> Ereignis hinzufügen. 
<Modify> Ausgewähltes Ereignis ändern. 
<Delete> Ausgewähltes Ereignis löschen. 

<Apply> Neue Integration mit geänderten Werten 
und Ereignissen starten. 

Wird ein Ereignis hinzugefügt oder geändert, erscheint das Fens-
ter Edit integration event, in dem die folgenden Parameter einge-
geben werden können: 

 

Time Startzeit des Ereignisses in min. 
Event Liste mit den Ereignissen zur Auswahl  

(siehe unten). 
Value Parameter-Wert für Ereignisse, welche die 

Eingabe eines zusätzlichen Parameters er-
fordern. 

Integrations-Ereignisse für Peakdetektion 

Disable detection Stoppt die Detektion neuer Peaks. Wird im 
Moment des Ereignisses ein Peak erfasst, 
wird er entweder beendet (abfallende 
Peaks), oder verworfen (ansteigende 
Peaks). 

Enable detection Schaltet die mit Disable detection ausge-
schaltete Peakdetektion wieder ein. 

Enable negative peaks Aktiviert die Detektion negativer Peaks. In 
einigen Fällen kann dieser Modus zur In-
stabilität des Detektions-Algorithmus füh-
ren. 

Disable negative peaks Deaktiviert die Detektion negativer Peaks. 
Dieses Ereignis wirkt sich nicht auf negative 
Peaks aus, welche schon begonnen haben. 

Disable peak reject Aktivieren Sie diesen Modus, wenn ein 
Peak auf Grund seiner flachen Spitze nicht 
verworfen werden soll.  

Enable peak reject Löschen des Modus Disable peak reject.  
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Integrations-Ereignisse für Peakstart und Peakende 

Set peak start Erzwingt den Anfang eines neuen Peaks. 
Falls im Moment des Ereignisses bereits 
ein Peak erfasst wird, wird dieser entweder 
verworfen (ansteigende Basislinie) oder be-
endet (abfallende Basislinie). 

Set peak end Erzwingt Peakende. Ansteigende Peaks 
werden verworfen (mit Ausnahme derer, die 
mit Set peak start erzeugt wurden), abfallen-
de Peaks werden beendet. 

Stop single peak mode Schaltet die Detektion des Peakendes aus. 
Danach werden alle Peaks einer Gruppe als 
ein Peak behandelt. Das Ende der Peak-
Gruppe wird zum Ende des Peaks.  

Start single peak mode Schaltet zurück auf den normalen Detekti-
onsmodus, bei dem ein Tal zwischen zwei 
Peaks das Fällen eines Lotes auf die Basis-
linie oder eine Trennung durch Ziehen einer 
Basislinie zu Folge hat. 

Split peak Beendet aktuellen Peak und startet neuen.  

Integrations-Ereignisse für Basislinie 

    
Enable valley-to-valley  Disable valley-to-valley 

Enable valley-to-valley Deaktiviert die Peaktrennung durch Lotfäl-
len auf eine gemeinsame Basislinie. Alle 
Peaks werden als basisliniengetrennt be-
trachtet. Die Basislinie wird zwischen den 
tiefsten Punkten der Täler zwischen den 
Peaks gezogen. 

Disable valley-to-valley Aktiviert Peaktrennung durch Fällen eines 
Lotes auf die Basislinie (Grundeinstellung). 

             
Set horizontal Set back hori- Set normal 
baseline zontal base baseline 
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Set horizontal baseline Setzt bei mehreren überlappenden Peaks 
eine horizontale Basislinie für alle Peaks mit 
Ausnahme des letzten Peaks. Die Basislinie 
wird ausgehend vom Startpunkt des ersten 
Peaks vorwärts gezogen. 

Set back horizontal base 
Setzt eine horizontale Basislinie für alle 
Peaks mit Ausnahme des ersten Peak von 
mehreren überlappenden Peaks. Die Basis-
linie wird ausgehend vom Endpunkt des 
letzten Peaks rückwärts gezogen. 

Set normal baseline Aktiviert den normalen Modus zur Basisli-
nienermittlung. 

    
 Set baseline point Ohne 
 bei 4.5, 6, 7.2, 8.9 Set baseline point 
 und 9.8 min 

Set baseline point Setzt definierten Basislinienpunkt zur bes-
seren Auswertung von Peaks auf fallenden 
oder ansteigenden Basislinien. Es können 
mehrere Basislinienpunkte hintereinander 
gesetzt werden. Die Basislinie zwischen 
zwei aufeinanderfolgenden 
Basislinienpunkten wird auf Null gesetzt 
und der Peak so neu integriert. 

   
 Force horizontal Cancel horizontal 
 baseline baseline 

Force horizontal baseline 
Setzt eine horizontale Basislinie für einen 
Einzelpeak. Die Basislinie wird ausgehend 
vom Peak-Startpunkt vorwärts gezogen. 
Der Schnittpunkt der horizontalen Basisline 
mit dem Peak ergibt den Peak-Endpunkt. 
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Cancel horizontal baseline 
Setzt den Modus Force horizontal baseline 
zurück.  

  
 Force horizontal Cancel horizontal 
 base back base back 

Force horizontal base back 
Setzt eine horizontale Basislinie für einen 
Einzelpeak. Die Basislinie wird ausgehend 
vom Peak-Endpunkt rückwärts gezogen. 
Der Schnittpunkt der horizontalen Basisline 
mit dem Peak ergibt den Peak-Startpunkt. 

Cancel horizontal base back 
Setzt den Modus Force horizontal base back 
zurück.  

    
 Enable baseline Disable baseline 
 penetration penetration 

Enable baseline penetration 
Die Basislinie darf das Signal kreuzen. 

Disable baseline penetration 
Setzt den Modus Enable baseline penetration 
zurück. Die Basislinie wird auf den tiefsten 
Punkt des Signals ausgerichtet. 

Integrations-Ereignisse für Parameter 

Set width Setzt einen neuen Wert für Width, der den 
linear ansteigenden, vorgegebenen Wert 
ersetzt. 

Set slope Setzt einen neuen Wert für Slope. 
Set min height Setzt einen neuen Wert für Minimum peak 

height. 
Set rider ratio Setzt einen neuen Wert für Rider ratio. 
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7.5 Kalibrierung und Konzentrationsberechnung 

7.5.1 Allgemeines 

Ziel jeder chromatographischen Analyse ist die Beantwortung der 
Frage: "Welche Komponenten enthält die Probe und wie gross ist 
ihre Konzentration?". Dazu braucht es grundsätzlich zwei Schritte: 
der erste Schritt wird Kalibrierung (Calibration) genannt, der 
zweite umfasst Identifikation (Identification) und Konzentrati-
onsberechnung (Quantification). 

Eine Kalibrierung dient dazu, die Retentionszeiten für alle ge-
wünschten Komponenten zu bestimmen (diese Daten werden in 
der Komponententabelle gespeichert) und den Zusammenhang 
zwischen den eingespritzten Komponentenmengen (gespeichert 
in der Konzentrationstabelle) und dem entsprechenden Detektor-
signal zu ermitteln. Dazu werden ein oder mehrere Chromato-
gramme mit Proben aufgenommen, deren Zusammensetzung 
und Komponentenkonzentration bekannt ist (Standards). Als Re-
sultat der Kalibrierung erhält man für jede Komponente eine Ka-
librierkurve. 

 

Mit «IC Net» können drei unterschiedliche Vorgehensweisen zur 
Konstruktion der Kalibrierkurve verwendet werden. Die weitaus 
wichtigste Methode für die Ionenchromatographie ist die Externe 
Standardkalibrierung (absolute Kalibrierung), die in diesem 
Kapitel ausführlich beschrieben wird. Die weiteren Methoden der 
Internen Standardkalibrierung (relative Kalibrierung) und der 
Tabellierten Kalibrierung (Relativer Steigungsfaktor, eine modi-
fizierte Methode zur externen Standardkalibrierung) sind von un-
tergeordneter Bedeutung und werden hier nicht näher erklärt (De-
tails siehe Online-Hilfe). 

Mit der Identifikation wird entschieden, welche Peaks im Chro-
matogramm welchen Komponenten zugeordnet werden können. 
Die Identifikation basiert auf der bei der Kalibrierung erstellten 
Komponententabelle Component table. 

Bei der Konzentrationsberechnung werden die Konzentratio-
nen der Komponenten aus den bei der Peakdetektion ermittelten 
Auswertegrössen (Höhe oder Fläche) berechnet. Für jede Kom-
ponente wird dazu die zuvor in der Kalibrierung bestimmte Kalib-
rierkurve verwendet. 
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7.5.2 Notationen 
R Steht für den Response-Wert (Signalwert), ab-

hängig von der Einstellung im Fenster Calibration 
graphs entweder als Fläche oder Höhe eines 
Peaks. 

V Injiziertes Probenvolumen Volume. 

D Verdünnungskoeffizient Dilution; gibt an, um wel-
chen Faktor die Urprobe vor der Injektion ver-
dünnt wurde. 

V' = V / D Angepasstes Volumen Adjusted volume der inji-
zierten Probe. Das injizierte Volumen wird um 
den Verdünnungskoeffizient korrigiert. 

C Konzentration der Komponente in der ursprüngli-
chen Probelösung (vor der Verdünnung). 

Q = C • V' Stoffmenge Quantity der Komponente, die zur 
Konstruktion der Kalibrierfunktion verwendet 
wird. 

t Retentionszeit Retention time. Zeit, die eine inji-
zierte Substanz benötigt, bis ihr Konzentrations-
maximum am Ende des Trennsystems erscheint. 

t0 Totzeit Void time. Zeit, welche die mobile Phase 
benötigt, um das Trennsystem zu durchlaufen. 

t' = t – t0 Korrigierte Retentionszeit Corrected retention time, 
auch Nettoretentionszeit genannt. 

L Säulenlänge. 

v = L / t0 Lineare Flussrate Flow rate (Strömungsgeschwin-
digkeit). 

W(R) = k2R2 + k1R + k0 
Kalibrierfunktion (Abhängigkeit der Stoffmenge 
W der Komponente vom Detektorsignal R). Die 
üblichste (lineare) Kalibrierfunktion geht durch 
den Ursprung Q = W(R) = k1R. Die Konzentrati-
on der Komponente in der analysierten Lösung 
wird nach der Formel C = W(R) / V' berechnet. 

RSD(Q, R) Prozedur zur Berechnung der Regressionskoeffi-
zienten (k0, k1 and k2) der Kalibrierfunktion W(R) 
mit Hilfe der RSD-Technik (Residual Standard 
Deviation). Nach der Eingabe einer Reihe von 
Kalibrierpunkten (Stoffmenge Q vs. Detektorsig-
nal R) erhält man mit dieser Rechenprozedur die 
Kalibrierfunktion W(R), mit der die Stoffmenge Qi 
= W(Ri) für eine Komponente bestimmt wird. 

Verwendete Indices: 
j Steht für den j-ten Kalibrationspunkt. 
s Bezeichnet eine Standardkomponente.  
i Nummer der Komponente. 
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7.5.3 Externe Standardkalibrierung 

Die Externe Standardkalibierung ist die grundlegende Kalibrier-
methode. Sie wird auch absolute Kalibrierung genannt. Mit die-
sem Verfahren wird die Abhängigkeit der Menge der injizierten 
Komponente von der Fläche (oder Höhe) des entsprechenden 
Peaks ermittelt und als Kalibrierkurve dargestellt, in der die inji-
zierte Menge auf der Y-Achse und die Peakfläche oder Peakhöhe 
auf der X-Achse aufgetragen sind. Die injizierte Menge Qi wird als 
Produkt der Komponentenkonzentration Ci in der Kalibrierlösung 
mit dem angepassten Volumen V' berechnet: 

Qi = Ci • V' 

Die Kalibrierfunktion Wi(R) wird für jede Komponente mit Hilfe der 
RSD-Methode konstruiert. 

Wi(R) = RSD(Qij , Rij) = RSD((Ci • V'), Rij) 

Bei der anschliessenden Konzentrationsberechnung wird die 
Konzentration Ci (die absolute Konzentration einer Komponente 
in der Probe) aus der mit der Kalibrierfunktion ermittelten Probe-
menge Wi(Ri) und dem angepassten Volumen V' der Probe be-
rechnet: 

Ci = Wi(Ri) / V' 
 

7.5.4 Komponententabelle 

 IC NET / Method / Calibration / Components 

Bei der Wahl dieses Menüpunkts wird das aktive Chromato-
grammfenster in zwei Teile aufgeteilt. Im oberen Teil wird das 
Chromatogramm angezeigt, im unteren Teil erscheint die Kom-
ponententabelle. Bewegt man sich in der Komponententabelle, 
so zeigt ein spezieller Cursor im oberen Teil des Fensters den der 
Komponente zugeordneten Peak an. 
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In der Komponententabelle Components table werden die folgen-
den Informationen über die zu analysierenden Komponenten ge-
speichert: 

Number Zeilennummer (nur Anzeige). 

Peak  Nummer des zur Komponente gehörigen 
Peaks aus dem Chromatogramm. Enthält 
dieses Feld eine 0, so muss die Peaknum-
mer manuell eingegeben werden.  

Time Erwartete Retentionszeit der Komponen-
te. Nach einer Neueingabe der Peaknum-
mer wird die zugehörige Retentionszeit au-
tomatisch eingetragen, sobald mit der 
Maus auf dieses Feld geklickt wird. 

Wind.% Identifikations-Fenster für die Kompo-
nente. Dieser Wert beschreibt die erlaubte 
Differenz der aktuellen Retentionszeit einer 
Komponente und ihrer erwarteten Retenti-
onszeit, angegeben in % der erwarteten Re-
tentionszeit. Die Komponente wird nur in-
nerhalb dieses Zeitfensters identifiziert. 

Ref. Referenzkomponente. Mit dem Eintrag 
Yes werden Komponenten als Referenz-
komponenten definiert, mit denen eine ver-
besserte Peak-Identifikation der übrigen 
Komponenten Ordinary components sicher-
gestellt werden kann (Details siehe Online-
Hilfe). 

Name Bezeichnung der Komponente (darf kei-
ne Leerzeichen enthalten). 

Group Nummer der Gruppe, der die Komponente 
zugeordnet wird. Werden hier Gruppen-
nummern ≥ 1 eingegeben, so kann für jede 
Gruppe ein Gruppenreport ausgegeben 
werden, der auch die Zwischensumme für 
die Gruppe enthält. Dieser Gruppenreport 
folgt im Anschluss an die Hauptreport-
Tabelle. 

Index Retentionsindex für Komponenten mit 
bekanntem Index. Ist der Wert unbekannt, 
sollte die Einstellung 0 gewählt werden. Zur 
Berechnung des Index müssen vom An-
wender mindestens zwei Index-Werte defi-
niert werden. Die übrigen Werte werden von 
der Software über lineare oder logarithmi-
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sche Näherung berechnet (Details siehe 
Online-Hilfe). 

RF Response-Faktor. Dieser Wert entspricht 
der Steigung der Kalibrierkurve, d.h. dem 
Koeffizienten k1 in der Kalibrierfunktion. 

min C (max C) Minimale (maximale) Konzentration der Kom-
ponente. Komponenten, deren Konzen-
trationen ausserhalb des Bereiches min 
C…max C liegen, werden in der Resultatta-
belle mit dem Zeichen " ! " markiert. 

 

Die Komponententabelle Components table enthält zusätzlich die 
folgenden Knöpfe: 

<Add> Fügt eine neue Komponente (neue Zeile) in 
der Komponententabelle hinzu. 

<Del> Löscht die aktuelle Komponente aus der 
Komponententabelle. 

<Identification> Öffnet das Fenster Peak identification (siehe 
Kap. 7.5.5). 

<Concentrations> Öffnet die Konzentrationstabelle Concentra-
tion table (siehe Kap. 7.5.6). 

<Graphs> Öffnet das Komponentenfenster mit der 
Anzeige der Kalibrierkurve und Kalibrierpa-
rameter (siehe Kap. 7.5.7).  

<OK> Übernimmt alle Änderungen und schliesst 
das Fenster Component table. 

<Cancel> Macht aller Änderungen rückgängig und 
schliesst das Fenster Component table. 

Die mit dem Programm «IC Net» mitgelieferten Standardmetho-
den enthalten alle eine Komponententabelle mit bereits vordefi-
nierten Komponenten, für die Name und Retentionszeit eingetra-
gen sind. 

 

 
Wird im Resultatreport eine Ausgabe sämtlicher Peaks ge-
wünscht, so kann für diesen Zweck in der Komponententabelle 
eine sogenannte Universalkomponente definiert werden, die im 
Feld Time den Wert 0 enthält und keinem Peak zugeordnet wird. 
Die unter Name eingetragene Bezeichnung (z.B. unknown) wird 
dann für alle Peaks verwendet, die keiner Komponente zuge-
ordnet werden können. 
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7.5.5 Peakidentifikation 

IC NET / Method / Calibration / Identification 

Bei der Wahl dieses Menüpunkts oder beim Klicken auf <Identifi-
cation> bei geöffneter Komponententabelle erscheint das Fenster 
Peak identification mit Parametern für die Identifikation von Peaks. 

 

Number of components 
Anzahl definierter Komponenten in der 
Komponententabelle (nur Anzeige). 

Scheme Wahl der Identifikationsparameter. 
Standard Standardeinstellung für Identifikationspa-

rameter: Height für Referenzkomponenten, 
Time für alle anderen Komponenten. 

Nonstandard Ermöglicht die benutzerdefinierte Einstel-
lung der Identifikationsparameter. 

Identification Identifikationsparameter. 
Reference peaks Identifikationsparameter für Referenzkom-

ponenten. Grundeinstellung ist Height. 
Other peaks Identifikationsparameter für gewöhnliche 

Komponenten. Grundeinstellung ist Time. 

Retention units Wahl der Retentions-Einheit. Grundeinstel-
lung ist min. 

Retention time Retentionszeit. 
<Update> Aktualisiert die erwarteten Retentionszeiten 

der Komponenten anhand des aktuellen 
Chromatogramms. 



 7.5  Kalibrierung und Konzentrationsberechnung 
 

IC Net 2.2 167

Worst case... Information über die Komponente mit der 
schlechtesten (grössten) Abweichung von 
aktueller und erwarteter Retentionszeit. Der 
angegebene Wert zeigt an, wie gross die 
Abweichung in Bezug auf das Identifikati-
ons-Fenster der Komponente ist. 

Average relative deviation 
Durchschnittliche relative Abweichung für 
alle Komponenten. 

7.5.6 Konzentrationstabelle 

IC NET / Method / Calibration / Concentrations 

Bei der Wahl dieses Menüpunkts oder beim Klicken auf <Concen-
trations> bei geöffneter Komponententabelle erscheint das Fen-
ster Concentrations mit der Konzentrationstabelle, welche die Kon-
zentrationen aller Komponenten für alle Kalibrierpunkte Calibration 
levels enthält. Jeder Punkt entspricht einer Probe, die zur Kalibrie-
rung verwendet wurde und einem Punkt auf der Kalibrierkurve. 

 
Concentration units Benutzerdefinierte Konzentrationseinheiten, 

die im Report erscheinen. Die Eingabe 
neuer Einheiten hat keine erneute Berech-
nung der Konzentrationen zur Folge. 

Data type Wahl des Datentyps für die Konzentrations-
tabelle: Konzentration concentrations 
(Grundeinstellung), Peakhöhe heights, 
Peakfläche areas, Volumen volumes. 

Number Nummer der Komponente (nur Anzeige). 

Name Name der Komponente, entnommen aus 
der Komponententabelle (nur Anzeige). 

This run Enthält die Konzentrationen (oder andere 
gewählte Grössen) die in der aktuellen Be-
stimmung erhalten wurden (nur Anzeige, 
ausser für die Universalkomponente). 
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Level 1...Level N  Enthält die Konzentrationen (oder andere 
ausgewählte Grössen) der Komponenten 
zum entsprechenden Kalibrierpunkt. 

<Add> Fügt einen neuen Kalibrierpunkt Calibration 
level zur Konzentrationstabelle hinzu. Dabei 
erscheint das folgende Fenster: 

 
Create calibration level  

Nummer des Kalibrierpunktes, der hinzuge-
fügt werden soll. 

Fill level with concentration 
Konzentration, die für alle Komponenten 
des Kalibrierpunktes eingetragen werden 
soll. 

Copy concentrations from level 
Nummer des Kalibrierpunktes, aus dem die 
Konzentrationen kopiert werden sollen. 

Calibrate immediately 
Neue Kalibrierung mit dem neu eingegebe-
nen Kalibrierpunkt durchführen. 

<Delete> Löscht den aktuellen Kalibrierpunkt (an der 
Position des Cursors) aus der Konzentrati-
onstabelle. 

<Calibrate> Kalibriert das aktuelle Chromatogramm mit 
dem gewählten Kalibrierpunkt. Dabei er-
scheint das folgende Fenster: 

 
Level Kalibrierpunkt, der zur Neukalibrierung ver-

wendet werden soll. 
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7.5.7 Kalibrierkurve 

IC NET / Method / Calibration / Graphs 

Bei der Wahl dieses Menüpunkts oder beim Klicken auf <Graphs> 
bei geöffneter Komponententabelle erscheint das Fenster Com-
ponent. 

 
In diesem Fenster werden die Resultate der Kalibrierung samt Ka-
librierkurve für jede Komponente angezeigt. Hier können auch die 
Parameter zur Berechnung der Kalibrierkurve eingegeben werden. 

Resultate der Kalibrierung und Kalibrierkurve 
Analytical expression Der analytische Ausdruck wird in der Form 

Q = k3 A3 + k2 A2 + k1 A + k0 angezeigt. 
Diese Formel wird zur approximativen Be-
rechnung der Kalibrierkurve verwendet. 

RSD  Relative Standardabweichung RSD (Resi-
dual Standard Deviation) zur Abschätzung 
des Fehlers bei der Berechnung der Kalib-
rierkurve. 

Corr. Für den Korrelationskoeffizienten ergibt sich 
nur bei linearen Kalibrierungen ohne Ge-
wichtung der Datenpunkte ein Wert. 

Calibration curve Graphische Darstellung der gemessenen 
Kalibrierpunkte und der berechneten Kalib-
rierkurve. 

k0, k1, k2, k3  Kalibrationskoeffizienten k0, k1, k2 und k3 
(Koeffizienten der Kalibrierfunktion). 
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Tabelle der Kalibrierpunkte 
Diese Tabelle enthält die Grundinformationen, welche zur Kon-
struktion der Kalibrierfunktion verwendet werden: 
Level  Nummer des Kalibrierpunktes. 
Conc.  Konzentration der Komponente in der Ka-

librierlösung. Dieser Wert wird aus der Kon-
zentrationstabelle entnommen. 

Area (or Height) Peakhöhe oder Peakfläche der Komponen-
te je nach der Art der Auswertung. 

File Dateiname des Standardchromatogramms, 
in welchem die Daten zu diesem Kalibrier-
punkt gespeichert sind. 

Used Information, ob dieser Kalibrierpunkt für die 
Berechnung der Kalibrierkurve verwendet 
wird oder nicht. 

<Exclude point>  Schliesst den ausgewählten Kalibrierpunkt 
von der Liste aus und berechnet die Kali-
brationskoeffizienten der aktuellen Kompo-
nente neu. Ein nochmaliges Betätigen die-
ser Schaltfläche zieht den Punkt wieder mit 
in die Berechnung ein. Durch Beurteilung 
des angezeigten RSD-Wertes können auf 
diese Weise “Ausreisser” eliminiert werden. 

Informationen zur Komponente 
Component  Ermöglicht die Auswahl der Komponente 

aus der Liste. Mit Hilfe der entsprechenden 
Pfeile auf der rechten Seite kann in der 
Komponentenliste geblättert werden. 

Retention time Retentionszeit der ausgewählten Kompo-
nente (nur Anzeige). 

Concentration Konzentration der ausgewählten Kompo-
nente (nur Anzeige). 

Kalibrierparameter 
Calibration method Methode, die zur Kalibrierung verwendet 

wird. Möglich sind folgende Methoden: 
External standard calibration 

Externe Standardkalibrierung (absolute Ka-
librierung). Gebräuchlichste Art der Kalibrie-
rung in der Ionenchromatographie. 

Internal standard calibration 
Interne Standardkalibrierung (relative Kali-
brierung). 

Tabulated calibration 
Tabellierte Kalibrierung (Kalibrierung mit re-
lativen Steigungsfaktoren). Vereinfachte 
Methode der ext. Standardkalibrierung. 
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Local Ist diese Schaltfläche aktiviert, so gilt der 
entsprechende Parameter nur für die ak-
tuelle Komponente. Ansonsten gilt der Pa-
rameter global (d.h. für alle Komponenten). 

Base  Basisgrösse (Fläche Area oder Höhe 
Height) für die Konzentrationsberechnung 
und Kalibrierung. Zeigt an, welcher Para-
meter als Peaksignal zur Auswertung ver-
wendet wird. 

Reference channel Messkanal (nur Anzeige). 

Formula Formel für Kalibrierfunktion. Es sind sechs 
verschiedene Formeln für lineare und nicht-
lineare Kurven verfügbar. 

Statistical weight Parameter zur Gewichtung der Abweichung 
der Kalibrierpunkte für die Berechnung der 
Koeffizienten der Kalibrierfunktion. Neben 
der gleichmässigen Gewichtung 1 sind 
auch 1/x, 1/x2, 1/y und 1/y2 möglich. 

Standard component Name der Standardkomponente für Interne 
Standardkalibrierung oder Tabellierte Kalib-
rierung (Details siehe Online-Hilfe). 

Concentration of standard 
Konzentration der Standardkomponete für 
Interne Standardkalibrierung oder Tabellier-
te Kalibrierung (Details siehe Online-Hilfe). 

7.5.8 Kalibrierung aktualisieren 
IC NET / Method / Calibration / Update 

Bei der Wahl dieses Menüpunkts erscheint das Fenster Update 
zur Auswahl der Parameter, die aktualisiert werden sollen. 

 
Retention time  Ersetzt die erwarteten Retentionszeiten der 

Komponenten durch die im aktuellen Chro-
matogramm gemessenen Retentionszeiten. 

Indexes Füllt das Index-Feld für Komponenten mit 
dem Index Null. 

Coefficients  Berechnet die Kalibrations-Koeffizienten al-
ler Komponenten neu (Neukalibrierung). 
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Coef. (balance)  Berechnet den Koeffizienten der Universal-
komponente (universal component) neu. 
Ziel dieser Berechnung ist es, den Stei-
gungs-Faktor dieser Komponente so einzu-
stellen, dass die Gesamtsumme der injizier-
ten Komponenten gleich dem angegebe-
nen Wert wird. Dieser Wert wird im Feld 
Concentration der Universalkomponente in 
der Spalte This run eingetragen. 

7.5.9 Kalibrierdaten verwalten 

Kalibrierdaten laden und speichern 
IC NET / Method / Calibration / Load from method 

Laden der Kalibrierdaten aus der zur Datenaufnahme verwende-
ten Methode. Diese Option wird dazu verwendet, die Kalibrierung 
des aktuellen Chromatogramms durch die in der Methode ge-
speicherte Kalibrierung zu ersetzen. 

IC NET / Method / Calibration / Save to method 

Speichert die aktuelle Kalibrierung in der zur Datenaufnahme ver-
wendeten Methode. Mit dieser Option wird die aktualisierte Kalib-
rierung vom Chromatogramm in der Methode gespeichert. 

Kalibrierdaten importieren und exportieren 
IC NET / Method / Calibration / Import calibration 

Mit dieser Option wird eine Kalibrierung von einer Kalibrierdatei 
*.cal in die aktuelle Methode oder ein Chromatogramm importiert. 
Damit können Kalibrierungen von einem Chromatogramm zum 
anderen oder von einer Methode zur anderen übertragen werden. 
Auf diese Weise können auch verschiedene Methoden mit der 
gleichen Kalibrierung versehen werden. 

IC NET / Method / Calibration / Export calibration 

Mit dieser Option wird eine Kalibrierung in einer Kalibrierdatei *.cal 
gespeichert. Damit kann eine Kalibrierung von einem Chromato-
gramm zum anderen übertragen werden, welche beide mit unter-
schiedlichen Methoden aufgenommen wurden. 

Kalibrierkurven ausgeben 
COMPONENT / Copy to clipboard 

Kopieren der Kalibrierkurve der ausgewählten Komponente in die 
Zwischenablage, von wo sie in andere Windowsprogramme wie 
Winword, Excel, etc. kopiert werden kann. 

COMPONENT / Print/Preview / Preview this 

Voransicht der Kalibrierkurve der ausgewählten Komponente. 
COMPONENT / Print/Preview / Preview all 

Voransicht der Kalibrierkurven aller Komponenten. 
COMPONENT / Print/Preview / Print this 

Drucken der Kalibrierkurve der ausgewählten Komponente. 
COMPONENT / Print/Preview / Print all 

Drucken der Kalibrierkurven aller Komponenten. 
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7.6 Reportausgabe 

7.6.1 Report options 

 IC NET / Method / Report options 
 IC NET / Process / Make report 

Die Einstellungen für die Ausgabe eines Reports sind im Fenster 
Report options definiert, in dem die Parameter nach ihrer Funktio-
nalität in verschiedene Bereiche aufgeteilt sind. Die Ausgabe ei-
nes Reports wird durch Klicken auf <Report> ausgelöst. 
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7.6.2 Items to report 

Unter diesem Titel können die folgenden, wichtigsten Bestandtei-
le des Reports ausgewählt werden: 

General Allgemeine Informationen zur Analyse aus 
der Registerkarte General des Passports. 
Zusätzlich wird das Datum des Ausdrucks 
Report date und der eingeloggte Anwender 
Printed by ausgegeben. 

Report date: 07/12/1999 15:59:10
Printed by: Roland Dörig

Ident: Tap water
Analysis from: 10/11/1999 16:17:02
File: jb101617.chw Last save:
16/11/1999 15:02:14
Modified!
Method: Multicalibration.mtw
Last save: 10/11/1999 08:34:40
Run operator: Metrohm
Analysis number: 1248

 

Sample  Informationen zur Probe aus der Register-
karte Sample des Passports. 

SAMPLE: Tap water from Application Laboratory
: Herisau, Switzerland

Vial number: 13
Volume: 20.0 µl
Dilution: 1.00
Amount: 1.0000

 

Column  Informationen zur Trennsäule aus der Re-
gisterkarte Column des Passports. 

COLUMN: METROSEP Anion Dual 2 (6.1006.100)
Size: 4.6 x 75 mm
Number: B0083
Part.size: 6.0 µm

 

Eluent  Informationen zum Eluenten aus der Regis-
terkarte Eluent des Passports. 

ELUENT: 2 mmol/L NaHCO / 1.3 mmol/L Na2CO3

Flow: 0.80 mL/min
Temperature: 20.0°C
Pressure: 5.2 MPa
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Chromatogram plot  Chromatogrammkurve (gilt nur für Ausga-
beziel Printer oder File). 

 

Peak table  Peaktabelle mit Auswerteresultaten. Der In-
halt der Peaktabelle hängt von der Einstel-
lung des Parameters Quantification method 
ab. Standardmässig erscheint der folgende 
Report: 

Quantitation method: Custom

No Retention Height Area Conc. Name
min mV mV*sec mg/L

1 3.04 1.85 21.062 0.079 fluoride
2 5.91 82.44 1703.350 7.173 chloride
3 6.83 3.58 97.495 0.000
4 14.29 29.27 969.705 7.561 nitrate
5 21.21 19.34 935.179 5.571 sulphate

_____________________________________________
5 25.01 136.48 3726.790 20.383

Comment  Benutzerdefinierter Kommentar aus der 
Registerkarte Comment des Passports. 

Method example for tap water determination.
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7.6.3 More items to report 

Unter diesem Titel können die folgenden, selten benutzten Be-
standteile des Reports ausgewählt werden: 

Acquisition Parameter für die Datenaufnahme aus den 
Registerkarten General, Measure und Filters 
des Fensters Method setup. 

ACQUISITION PARAMETERS
Channels: 1
Method duration: 25.00min
Run duration: 25.01min
Measurements (method): 15006
Measurements (run): 15006
Freq.divisor: 1
Sampling: 10.00 pts/sec
Start delay: sec
Device:
Program before:
Program after:
Spikes filter: Yes
Median filter: No

slit: 0
Gauss filter: No

slit: 0

Integration Integrationsparameter und Integrations-
Ereignisse. 

INTEGRATION DEFAULTS
Channel: ch1
Delay: 2.50 min
Width: 15.00 sec
Broadening: 2.00
Slope: 10.00
Asymmetry: 2.00
MinArea: 0.00
MinHeight: 1.00
Rider ratio: 0.00
No. min
1 5.00 Force horizontal base = 0.00
2 7.50 Cancel horizontal base = 0.00

Calibration defaults Parameter für die Kalibrierung, die im Kom-
ponentenfenster und auf der Seite Math des 
Fensters Method setup definiert sind. 

CALIBRATION
Channel: ch1
Method: External standard
Response: Area
Standard: No
IDENTIFICATION
Reference peaks: Height
Other peaks: Time
Retention units: min

Component table Komponententabelle. 

No Retention Window% RF Conc. Index Type Group Name

1 3.05 5.0 2.623e-03 0.08 0.000 0 fluoride
2 5.92 5.0 4.356e-03 7.17 0.000 0 chloride
3 8.70 5.0 6.691e-03 0.00 0.000 0 nitrite
4 11.19 5.0 9.933e-03 0.00 0.000 0 bromide
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5 14.60 5.0 7.912e-03 7.56 0.000 S 0 nitrate
6 16.80 5.0 1.556e-02 0.00 0.000 0 phosphate
7 21.26 5.0 6.021e-03 5.57 0.000 0 sulphate

Calibration results Ergebnisse der Kalibrierung aus dem Kom-
ponentenfenster. Für jede Komponente 
wird eine neue Seite mit Kalibrierresultaten 
und Kalibrierkurve ausgegeben.  

CALIBRATION OF COMPONENT fluoride

Method: Multicalibration.mtw
Equation: Q = - 7.48163·A^2 + 0.00262326·A + 0.0233088
RSD: 0.691 %
Correlation coefficient: 0.999277

K3 = 0 K2 = -7.48163e-08 K1 = 0.00262326 K0 = 0.0233088
Base: Area
Ref.channel: ch1
ISTD:
Formula: Y=K2·X^2+K1·X+K0
Weight: 1

Level Height Area Conc. Volume Retention Used File

1 6.46 173 2 1 10.8 Yes g8140800.chw
2 34 897 10 1 10.8 Yes g8140823.chw
3 90.9 2.36e+03 25 1 10.8 Yes g8140858.chw
4 198 5.04e+03 50 1 10.8 Yes g8140929.chw

Channel table Parameter für Analog-Digital-Konverter des 
Messkanals. 

CHANNELS TABLE
ch1
No Name Units Input Minimum Zero Maximum Range Coefficient Noise Shift

1 ch1 mV 1 -8388607 0 8388607 2.500e+03 2.980e-04 4.15 0

# Name/Units Noise RMS PeakToPeak Drift/hour
1 ch1 4.2 29976.5 330509.6 3585.801

mV 0.00124 8.93 98.5 1.07

 
Name  Bezeichnung des Kanals. Dieser Text er-

scheint als Channel label im Chromato-
gramm. 

Units  Benutzerdefinierte Einheiten des Detektor-
Signals. 

Input  Nummer des Messkanals. 



7  Methoden 
 

IC Net 2.2 178 

Minimum Minimaler Wert des linearen Bereiches des 
AD-Wandlers (in Einheiten des AD-Wand-
lers). Dieser Wert wird verwendet, um ein 
Austreten des Signal aus dem Messbereich 
nach unten zu registrieren (Underflow). 

Zero  Der Signalstand in Höhe der Basislinie (in 
Einheiten des AD-Wandlers). Dieser Wert 
resultiert aus der Kalibrierung der AD-
Wandlung. 

Maximum  Maximaler Wert des linearen Bereiches des 
AD-Wandlers (in Einheiten des AD-Wand-
lers). Dieser Wert wird verwendet, um ein 
Austreten des Signal aus dem Messbereich 
nach oben zu registrieren (Overflow). 

Range  Der maximale Eingangssignal-Wert in be-
nutzerdefinierten Einheiten.  
Range = (Maximum - Zero) • Coef 

Coefficient  ADC-Empfindlichkeits-Koeffizient (Wertung 
der ADC-Bits in benutzerdefinierten Einhei-
ten). 

Noise  Schätzwert des Grundrausches der Basisli-
nie des Kanals in Einheiten des AD-Wand-
lers (Bits). 

Shift Zeitversatz für aktuellen Kanal. Dieser Pa-
rameter ist hilfreich im Falle von Multikanal-
Chromatogrammen. 

(multi)Channel ratio Spektrales Verhältnis. Dieser Parameter ist 
hilfreich im Falle von Multikanal-Chromato-
grammen. 
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7.6.4 Report destination 

Als Ziel für die Reportausgabe können die folgenden Ausgabezie-
le einzeln oder in beliebiger Kombination gewählt werden: 

Screen Ausgabe des Reports auf dem Bildschirm 
(ohne Kurven). 

Printer Ausgabe des Reports auf dem Drucker. 
File Ausgabe des Reports in eine Datei (siehe 

Kap. 7.6.7). 
 
 

7.6.5 Peak table 

Für die Ausgabe der Peaktabelle mit den Resultaten der Bestim-
mung können die folgenden Parameter gewählt werden: 

Quantification method Wahl der Methode, mit der die Konzentrati-
onen der Komponenten berechnet werden: 

Response normalization 
Diese Methode normiert die Summe der 
Signale aller Peaks auf den im Feld Total % 
for normalization eingegeben Wert NORM: 

Ri% = NORM • Ri / ∑ Ri. 
Alle Peaks werden berechnet und im Report 
aufgeführt, egal ob sie erkannt (zugeord-
net) wurden oder nicht. 
Die Peaktabelle enthält folgende Spalten: 
Peak number, Retention time, Area + Area% or 
Height + Height%, Name 

Normalized concentration 
Diese Methode normiert die Summe der 
absoluten Konzentrationen aller Peaks auf 
den im Feld Total % for normalization einge-
geben Wert NORM: 

Ci% = NORM • Wi(Ri) / ∑ Wi(Ri) 
Falls keine Universalkomponente definiert 
ist, werden nur Komponenten mit einer von 
Null abweichenden Konzentration in den 
Report aufgenommen. 
Die Peaktabelle enthält folgende Spalten: 
Peak number, Retention time, Height, Area, 
Response factor, Concentration%, Name 

Absolute concentration 
Mit dieser Methode werden die absoluten 
Konzentrationen der Komponenten im Re-
port ausgegeben, welche direkt nach der 
Kalibrierformel berechnet werden: 

Qi = Wi(Ri) / V' 
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Falls keine Universalkomponente definiert 
ist, werden nur Komponenten mit einer von 
Null abweichenden Konzentration in den 
Report aufgenommen. 
Die Peaktabelle enthält folgende Spalten: 
Peak number, Retention time, Height, Area, 
Response factor, Concentration, Concentrati-
on%, Name 

Relative concentration 
Diese Methode benutzt die interne Stan-
dardkalibrierung zur Berechnung der relati-
ven Konzentrationen der Komponenten. 
Dazu muss unter Standard component eine 
Komponente als interner Standard ausge-
wählt und unter Concentration of std deren 
Konzentration eingetragen werden. 
Falls keine Universalkomponente definiert 
ist, werden nur Komponenten mit einer von 
Null abweichenden Konzentration in den 
Report aufgenommen. 
Die Peaktabelle enthält folgende Spalten: 
Peak number, Retention time, Height, Area, 
Response factor, Relative concentration,  
Relative concentration%, Name 

Index Mit dieser Methode wird der Retentionsin-
dex der identifizierten Komponenten be-
rechnet. 
Die Peaktabelle enthält folgende Spalten: 
Peak number, Retention time, Width/2, Height, 
Index, Name 

Column test Mit dieser Methode kann die Qualität der 
Trennsäule getestet werden. 
Die Peaktabelle enthält folgende Spalten: 
Peak number, Retention time, K' (Kapazitäts-
faktor), TP (Effektive Trennstufenzahl), TP/m 
(Effektive Trennstufenzahl per m), HETP/dp 
(Höhe der Theoretischen Trennstufen geteilt 
durch die Partikelgrösse), Asym. (Asymmet-
rie), Name 

Custom Diese Methode ermöglicht es dem Anwen-
der, mit Hilfe von <Customize> die Peakta-
belle frei zusammenzustellen.  
Die Peaktabelle der mitgelieferten Metho-
den enthält standardmässig folgende Spal-
ten: Peak number, Retention time, Height, 
Area, Conc., Name 
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Standard component Komponente, die als interner Standard 
verwendet wird.  

Concentration of std Konzentration des internen Standards zur 
Berechnung von relativen Konzentrationen. 
Dieser Wert wird in der Spalte This run in 
der Konzentrationstabelle gespeichert. 

Total % for normalization 
Wert, auf den die Summe der Konzentratio-
nen normalisiert wird. Dieser wird für die 
Methoden Response normalization und Nor-
malized concentrations benötigt. Der Stan-
dardwert ist 100. 

Printing order Bestimmt die Reihenfolge der Komponen-
ten in der Peaktabelle. 

By peaks  Listet die Ergebnisse der Bestimmung für 
alle Peaks auf. Nicht identifizierte Peaks 
(die sich auf die Universalkomponente be-
ziehen) werden aufgeführt, fehlende Kom-
ponenten jedoch nicht. 

By components Nicht gefundene Komponenten werden 
immer in den Report aufgenommen, auch 
jene, deren Konzentration gleich Null ist. Ist 
eine Universalkomponente vorhanden, so 
wird die Summe aller nicht identifizierter 
Peaks in einer getrennten Zeile aufgeführt. 

<Customize> Öffnet die Liste mit sämtlichen verfügbaren 
Parametern, die in den Report übernom-
men werden können (siehe Kap. 7.6.8). 
Diese Funktion ist nur verfügbar, wenn 
Quantification method = Custom gewählt 
wurde. 

Report all peaks Ist diese Option eingeschaltet, so werden 
auch Peaks mit der Konzentration Null in 
den Report aufgenommen. Dies gilt nur, 
wenn Quantification method = Custom ge-
wählt wurde. 

Groups Ist diese Option eingeschaltet, so wird für 
jede in der Komponententabelle definierte 
Gruppe ein separater Report ausgegeben. 
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7.6.6 Template options 

Für die Ausgabe des Reports anhand einer Reportvorlage können 
die folgenden Parameter gewählt werden: 

Template Wahl der vordefinierten Reportvorlage *.rtt. 
Es stehen Vorlagen für verschiedenen 
Sprachen oder spezielle Anwendungsbe-
reiche zur Verfügung. 

Separator Wahl des Trennzeichens für die Spalten in 
den Tabellen. Eine vom Leerzeichen Space 
abweichende Einstellung ist dann sinnvoll, 
wenn der Report in eine Datei geschrieben 
wird, welche in eine andere Software impor-
tiert werden soll. 

Tab size Setzt Werte für den Tabulatorstopp. Dies ist 
nur notwendig, wenn Separator = Tabulation 
gewählt wurde oder wenn Tabulatorzeichen 
in der Vorlage *.rtt vorkommen. 

7.6.7 File output options  

Falls als Ausgabeziel File gewählt wurde, können die folgenden 
Parameter gewählt werden: 

Directory Verzeichnis, in das der Report abgelegt 
wird. Ein neues Verzeichnis kann mit 
<Browse> ausgewählt werden. 

Name Dateiname, unter dem der Report gespei-
chert werden soll. Der Textteil des Reports 
wird im ANSI- oder ASCII-Format gespei-
chert. Fügen Sie deshalb eine Erweiterung 
wie z.B. *.txt zum Namen hinzu. Enthält der 
Report auch die Chromatogrammkurve, so 
wird diese unter dem selben Namen in ei-
ner separaten Datei *.wmf im WMF-Format 
gespeichert. 

Mode Möglich sind die beiden Optionen Overwrite 
(Überschreiben der Datei) oder Append 
(Anhängen an die bestehende Datei). 

Character set Zeichensatz: Windows (ANSI) oder DOS 
(ASCII). Diese Einstellungen sind für die 
Ausgabe von nicht-englischen Zeichen 
wichtig (z. B. ö, ä, ü). 

Custom program Pfad und Name eines Programms, das 
nach der Ausgabe des Reports gestartet 
werden soll. Damit kann der Report zu einer 
Datenbank, Tabellenkalkulation oder einer 
anderen Anwendung transferiert werden. 
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7.6.8 Reportelemente 

Wird Quantification method = Custom gewählt, so kann die Peakta-
belle frei zusammengestellt werden. Nach dem Klicken auf 
<Customize> öffnet sich die Liste mit den folgenden Parametern, 
die alle in den Report übernommen werden können. 

number Peaknummer. 

retention time Retentionszeit der Komponente (in min, 
ohne Rücksicht auf die für die Achse der 
Chromatogrammdarstellung gewählte Ein-
heit). Der Gesamtwert in dieser Spalte ent-
spricht der Chromatographie-Dauer. 

halfwidth Breite des Peaks auf halber Höhe (in min). 

height Höhe des Peaks (in mV). Der Gesamtwert 
der Spalte ist die Summe der Höhen aller 
identifizierter Peaks. 

height% Normierung der Peakhöhen für alle Peaks 
mit dem im Feld Total % for normalization 
eingegeben Wert NORM (Grundeinstellung 
100%): 

Hi% = NORM • Hi / ∑ Hi 

area Peakfläche. Bezieht sich auf die Einheiten 
der X- und Y-Achsen im Chromatogramm. 
Der Gesamtwert dieser Spalte stellt die 
Summe der Peakflächen aller identifizierter 
Peaks (inklusive Universalkomponente) dar. 

area% Normierung der Peakflächen für alle Peaks 
mit dem im Feld Total % for normalization 
eingegeben Wert NORM (Grundeinstellung 
100%): 

Ai% = NORM • Ai / ∑ Ai 

capacity factor Der Kapazitätsfaktor k'i der Komponente ist 
gleich dem Quotienten der korrigierten Re-
tentionszeit (t - t0) zur Totzeit t0: 

k'i = (ti - t0) / t0 

Als Totalwert dieser Spalte gilt der Kapazi-
tätsfaktor des letzten Peaks im Chroma-
togramm. 

resolution Die Auflösung R für zwei benachbarte 
Peaks wird nach folgender Formel berech-
net: 

R = (ti+1 - ti) / (w0.607i + w0.607(i+1)) 

Die Indices i und i+1 beziehen sich auf die 
benachbarten Peaks und w0.607 steht für die 
Peakbreite in 60.7% der Peakhöhe.  
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effectivity, TP Effektive Trennstufenzahl des Peaks. Die 
Anzahl der theoretischen Trennstufen Ni pro 
Säule für einen bestimmten Peak wird über 
eine von zwei Formeln berechnet: 

Ni = 2 PI (ti • Hi / Ai)2, 

wobei PI = 3.1415926..., ti = Retentions-
zeit, Hi = Höhe, Ai = Fläche des Peaks 
sind. Die gebräuchlichere Formel ist: 

Ni = 5.54 (ti / wi)2, 

wobei wi die Breite in der halben Peakhöhe 
ist. Die erste Formel liefert passendere Er-
gebnisse für zusammenhängende oder 
schlecht aufgelöste Peaks, da hier die Feh-
ler für wi viel grösser sind als die Fehler bei 
der Ermittlung der Höhe oder Fläche. 
Der Totalwert dieser Spalte stellt den 
Durchschnittswert für die aufgeführten 
Peaks dar.  

effectivity, TP/m Effektive Trennstufenzahl des Peaks pro 
Meter. Die Zahl der theoretischen Trennstu-
fen pro Meter N' für die gegebene Kompo-
nente wird nach der Formel 

N' = Ni • 1000 / L, 

berechnet, wobei L die Länge der Säule in 
mm und Ni die Trennstufenzahl bezogen 
auf die Trennsäule darstellt.  
Der Totalwert dieser Spalte stellt den 
Durchschnittswert für die aufgeführten 
Peaks dar. 

reduced TP height, HETP/dp 
Die Höhe der theoretischen Trennstufen ge-
teilt durch die Partikelgrösse, auch als re-
duzierte Bodenhöhe bezeichnet, wird nach 
der Formel: 

Hi = 1000 • L / (Ni dp). 

berechnet, wobei L die Länge der Trenn-
säule in mm und dp den Partikeldurchmes-
ser in µm darstellt. 

gaussian factor Der Peak Gauss-Faktor PGF ist das Ver-
hältnis der Peakbreite bei halber Signalhö-
he w1/2 zu der Peakbreite bei einem zehntel 
der Signalhöhe w1/10, multipliziert mit dem 
Kehrwert dieses Verhältnisses für einen 
Peak mit idealem Gaussprofil. 

PGF = 1.83 • w1/2 / w1/10 
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PGF = 1 für einen idealen Peak mit Gauss-
profil. 

asymmetry Die Peakasymmetrie As wird in 1/10 der 
Peakhöhe als Verhältnis der Breite nach der 
Peakspitze w2 zur Breite vor der Peakspitze 
w1 berechnet. 

As = w2 / w1 

response factor Koeffizient k1 der Kalibrierkurve. 

raw concentration Absolute Konzentrationen der Komponen-
ten, berechnet nach der Formel 

Ci = Wi(Ri) / V' 

Der Totalwert dieser Spalte ist gleich der 
Summe der Konzentrationen aller Kompo-
nenten. 

concentration% Normierung der Konzentrationen für alle 
Peaks mit dem im Feld Total % for normaliza-
tion eingegeben Wert NORM 
(Grundeinstellung 100%): 

Ci% = NORM • Wi(Ri) / ∑ Wi(Ri) 

In der Haupttabelle ist der Totalwert dieser 
Spalte gleich dem Koeffizienten NORM. 
Bei Gruppentabellen ist der Totalwert dieser 
Spalte gleich der Summe der Konzentratio-
nen in der entsprechenden Gruppe. 

rel. concentration Relative Konzentration bezogen auf die 
Standardkomponente (Interner Standard), 
von der die Komponente im voraus bekannt 
ist. Die Konzentration der Komponente wird 
nach der Formel 

C'i = Wi(Ri) / V' = Wi(Ri) • Cs / Ws(Rs), 

berechnet, wobei V' = Ws(Rs) / Cs das ef-
fektive Volumen der injizierten Probe dar-
stellt. Die Konzentration der Standardkom-
ponente Cs wird vom Anwender eingege-
ben. Im Totalwert dieser Spalte ist die Kon-
zentration der Standardkomponente nicht 
enthalten. 

rel. concentration% Unterscheidet sich von der normierten Kon-
zentration concentration% durch den Aus-
schluss der Standardkomponente(n) von 
der Summierung, so dass die Summe aller 
Konzentrationen ohne Standard gleich 
NORM ist. In der Haupttabelle ist der To-
talwert dieser Spalte gleich dem Koeffizien-
ten NORM, bei Gruppentabellen gleich der 
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Summe der Konzentrationen in der entspre-
chenden Gruppe. 

peak amount Absolute Substanzmenge die im Volumen 
der Probenschleife enthalten ist, sie ist das 
Produkt aus der absoluten Konzentration 
C(i) und dem Volumen der Probenschleife. 

 
Der peak amount wird im Report ohne 
Einheit aufgeführt, achten Sie deshalb auf 
die Grössenordnung des aufgeführten 
Wertes! 

index Linearer oder logarithmischer Retentionsin-
dex für die identifizierten Komponenten. Der 
Gesamtwert dieser Spalte ist ein nach der 
absoluten Konzentration gewichteter Index-
Durchschnitt. 

I = ∑{ (Ii Ci) / ∑ Ci }. 

type Die Eigenschaften der Komponenten werden 
mit einem Ein-Buchstaben-Code angezeigt: 

R  Referenzkomponente (verwendet zur Peak-
identifikation). 

S  Standardkomponente. 

C  Kalibrierstandard, falls dieser vom Quantifica-
tion-Standard abweicht. 

?  Punkte des entsprechenden Peaks sind aus-
serhalb des Arbeitsbereiches von AD-Wandler 
oder Detektor, unsicheres Ergebnis.  

!  Die Konzentration der Komponente ist ausser-
halb des Arbeitsbereiches, der in der Kompo-
nententabelle mit minimaler (min C) und maxi-
maler Konzentration (max C) festgelegt wurde.  

p Spezielle Komponente. Für diese Komponen-
te wurden spezielle (individuelle) Eigenschaf-
ten im Fenster COMPONENT ausgewählt. 

N Das Signal für die Komponente befindet sich 
ausserhalb des kalibrierten Bereiches. 

 Im Fall von Peaks gehen der Information über 
die Eigenschaften der Komponenten zusätzli-
che Buchstaben voraus, die anzeigen, wie die 
Peaks von anderen getrennt sind, z.B.: 

BD_ Der Peak beginnt an der Basislinie (B) und 
endet am Lot (drop line, D), welches ihn von 
einem anderen Peak trennt. 

BBR Spezialfall eines Aufsetzer-Peaks (rider, R), 
welcher durch eine Tangente vom Hauptpeak 
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getrennt ist. Der Hauptpeak wird in diesem 
Fall durch einen dritten Buchstaben H (horse) 
gekennzeichnet. 

 Beispiel für eine komplette Komponentenbe-
schreibung: BBD : !R. 

group Nummer der Gruppe, der die Komponente 
zugeordnet ist. 

spectral ratio Verhältnis der Signale auf verschiedenen Ka-
nälen für Mulitkanal-Chromatogramme. 

name Bezeichnung der Komponente. 

file name Dateiname des Chromatogramms. Diese 
Spalte ist zur Bearbeitung exportierter Daten 
nützlich. 

ident Titel (identificator) des Chromatogramms. Die-
se Spalte ist zu Bearbeitung exportierter Daten 
nützlich. 
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8 Chromatogramme 

8.1 Chromatogrammfenster 

Das Fenster CHROMATOGRAM dient zur Anzeige des Chroma-
togramms während der Datenerfassung und -bearbeitung.  
 

 

In der Titelleiste des Chromatogrammfensters befinden sich die 
Knöpfe zum Verkleinern, Vergrössern und Schliessen des Fens-
ters. Der Name des Fensters besteht aus den Elementen "Ident 
(method name) chromatogram name". Ein Stern ( * ) am Ende des 
Namens zeigt an, dass das Chromatogramm seit der letzten 
Speicherung verändert wurde. 

Die Statusleiste enthält zwei Felder. Im ersten Feld wird der ak-
tuelle Mess-Status angezeigt. Möglich sind die folgenden Anzei-
gen: 

Ready Bereit zum Start des Chromatogramms. 

Waiting Chromatogramm wartet auf erste Mess-
punkte. 

Measure Chromatogramm wird gerade aufgenom-
men. 

Measure(Baseline) Aufzeichnung der Basislinie. 

Finished Messung abgeschlossen, aber das Chro-
matogramm wurde noch nicht ausgewertet. 

Processing Chromatogramm wird nach Ende der 
Aufnahme gerade ausgewertet. 

Titelleiste

Statusleiste 

Chromatogramm 
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Failure Fehler, z.B. unerwartetes Abschalten der 
Pumpe, etc. 

COM error Fehler an der COM-Schnittstelle. 

Im zweiten Feld der Statusleiste werden bei einer laufenden Da-
tenaufnahme die abgelaufene Zeit, die Dauer des Chromato-
gramms oder Programms und die aktuellen X- und Y-Messwerte 
angezeigt. Ist der Peak-Editor eingeschaltet, wird die Position des 
Cursors angezeigt. 

Das Chromatogramm kann mit Hilfe von Tastatur und Maus oder 
über die Dialog-Box IC NET / View / Appearance / Chromatogram 
axes skaliert werden. Einige der Funktionen zur Kontrolle der 
Fenster sind im Menü Window zusammengefasst.  

 

 

 

8.2 Chromatogramme verwalten 

8.2.1 Chromatogramme öffnen 

 IC NET / File / Open / Chromatogram 

Laden einer bestehenden Chromatogrammdatei (*.chw) aus dem 
Verzeichnis Data und Öffnen des entsprechenden Chromato-
grammfensters. Dabei öffnet sich das folgende Fenster: 
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Filename Dateiname (übliche Platzhalter wie * und ? 
sind möglich). 

Selected Anzahl der ausgewählten Chromatogramm-
dateien und deren Grösse. 

Directory Pfadname des Arbeitsverzeichnisses. 

File window Fenster mit der nach der Zeit sortierten Lis-
te der Dateien im Arbeitsverzeichnis (das 
zuletzt aufgenommene Chromatogramm 
erscheint am Anfang der Liste). Zusätzlich 
werden hier auch die Parameter Ident und 
Method angezeigt. Die Dateien können 
durch Bewegen des Auswahlbalkens und 
Drücken der Leertaste oder durch einen 
Mausklick auf das gewünschte Chromato-
gramm ausgewählt werden. 

 Durch gleichzeitiges Drücken von [ Shift ] 
und der linken Maustaste werden alle Chro-
matogramme bis zur ausgewählten Datei 
selektiert, mit [ Ctrl ] und der linken Maus-
taste können einzelne Chromatogramme 
zur Auswahl hinzugefügt werden. Alle aus-
gewählten Chromatogramme sind farbig 
unterlegt.  

Directories Fenster mit Liste der Verzeichnisse. Falls 
erwünscht, kann hier das in der Methode 
definierte Arbeitsverzeichnis gewechselt 
werden. 

Chromatogram description 
Hier werden einige Felder aus dem Pass-
port für das ausgewählte Chromatogramm 
aufgelistet. 

<OK> Laden der ausgewählten Chromatogramm-
dateien (*.chw) und Öffnen der entspre-
chenden Chromatogrammfenster. 

<Cancel> Schliessen des Fensters ohne weitere Akti-
onen. 

<To Batch> Ausgewählte Chromatogramme zur spezifi-
zierten Nachbearbeitungstabelle hinzufü-
gen. 

<Copy> Ausgewählte Chromatogramme in ge-
wünschtes Verzeichnis kopieren. 

<Move> Ausgewählte Chromatogramme in ge-
wünschtes Verzeichnis übertragen. 

<Delete> Ausgewählte Chromatogramme löschen 
und in den Windows-Papierkorb übertra-
gen. 
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8.2.2 Chromatogramme speichern 

 IC NET / File / Save / Chromatogram 

Ausgewähltes Chromatogramm in einer Chromatogrammdatei 
(*.chw) im Arbeitsverzeichnis speichern. Wurde dieses Chroma-
togramm bereits abgespeichert, so erscheint die Meldung File ... 
exists. Overwrite? Mit <OK> wird die vorherige Version ersetzt, mit 
<No> wird das Chromatogramm als neue Datei abgespeichert 
(eine Kopie des Chromatogramms wird erstellt). 

 

8.2.3 Chromatogramme schliessen 

IC NET / File / Close 

Ausgewähltes Chromatogrammfenster schliessen. Falls die Daten 
noch nicht gesichert wurden oder die Methode geändert wurde, 
erscheint eine entsprechende Warnung. Das Fenster kann auch 
mit dem Knopf    in der rechten oberen Fensterecke geschlos-
sen werden. 

 

8.2.4 Chromatogramme löschen 

IC NET / File / Delete 

Ausgewähltes Chromatogramm löschen. Dabei erscheint in je-
dem Fall eine entsprechende Warnung. 

 

8.2.5 Chromatogramme exportieren 

 IC NET / File / Export / AIA file 

Chromatogramm im Format AIA (Analytical Instrument Associati-
on) als CDF-Datei (*.cdf) exportieren. 

 

 IC NET / File / Export / Raw data to txt 

Chromatogramm in einer ASCII-Datei (*.txt) exportieren. Vor dem 
Export öffnet sich das folgende Fenster: 
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Represent raw data as Ausgabe der Rohdaten: 
Default units (float) Die Y-Werte werden in der Standardeinheit 

für den Kanal exportiert. 
ADC response (integer) 

Die Y-Werte werden in Bits exportiert. 

Include retention time Retentionszeit einschliessen: 
In seconds (float) Die X-Werte werden in Sekunden exportiert. 
As point number Die X-Werte werden als Zahlenwert expor-

tiert. 
 

8.2.6 Chromatogramme importieren 

 IC NET / File / Import / Chromatogram 

Chromatogramm in einem der folgenden Formate importieren: 
*.chm Chromatogramme des Programms 

«Chrom&Spec» (DOS-Version). 
*._rd Chromatogramme des Programms «714 IC 

Metrodata» (DOS-Version). Nach der Wahl 
der Datei muss eine entsprechende Methode 
geladen werden. 

*.chr Chromatogramme des Programms «Envi-
roChrom». 

*.dar Chromatogramme des Programms  
«AtomChrom». 

LongInteger (*.*) Chromatogramm im Format Long Integer. 

 

 IC NET / File / Import / AIA file 

Chromatogramm im Format AIA (Analytical Instrument Associati-
on) als CDF-Datei (*.cdf) importieren. 

 

 IC NET / File / Import / Raw data from txt 

Chromatogramm von einer ASCII-Datei (*.txt) exportieren. Dazu 
muss eine entsprechende Methode geladen werden. 
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8.3 Grafische Darstellung 

8.3.1 Appearance 

 IC NET / View / Appearance 

Mit diesem Menüpunkt wird das Fenster Appearance geöffnet, in 
dem das Aussehen des Chromatogramms definiert ist und das 
aus den folgenden Registerkarten besteht: 
Chromatogram axes Skalierung der Chromatogrammachsen. 
Labels Beschriftung der Peaks und Anzeige der 

Basislinie. 
Select channel Kanäle auswählen, die angezeigt werden 

sollen (nur für Mehrkanal-Chromatogramme 
verfügbar). 

Colors Farbeinstellungen für Chromatogramm.  

 
Die Einstellungen im Fenster Appearance für ein Chromatogramm 
werden beim Schliessen des Chromatogramms nicht automa-
tisch gespeichert. Falls die geänderten Einstellungen beim er-
neuten Öffnen des Chromatogramms erhalten bleiben sollen, 
muss das Chromatogramm immer mit IC NET / File / Save / Chro-
matogram gespeichert werden. 

 

Chromatogram axes 
Registerkarte Chromatogram axes des Fensters Appearance mit 
den Parametern zur Skalierung der Chromatogrammachsen. 

 
Time axis  Zeitachse. 

X from Beginn des Fensters in X-Richtung. 
X to Ende des Fensters in X-Richtung. 
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X units Wahl der Einheit (Retention unit) für die X-
Achse. 

Response axis  Achse für Detektorsignal 
Y from Beginn des Fensters in Y-Richtung. 
Y to  Ende des Fensters in Y-Richtung. 
Tic marks  Achseneinteilung und Skalabeschriftung 

der Y-Achse: keine Skalierung (no), relative 
Skalierung (relative), absolute Skalierung 
(absolute). 

View all Setzt die Skalierung von X- und Y-Achse so, 
dass das ganze Chromatogramm im Fens-
ter sichtbar ist. 

Drift compensation Das Chromatogramm wird so gedreht, 
dass der letzte und erste Punkt auf der sel-
ben Höhe liegen. Diese Option ist zur Auf-
nahme von Chromatogrammen mit Gra-
diententechnik nützlich. Sie hat keine Wir-
kung während der Aufnahme eines Chro-
matogramms. 

Grid Im Chromatogramm werden gestrichelte 
Gitterlinien eingezeichnet. 

Set all Setzt die Achseneinstellungen aller geöffne-
ter Chromatogrammfenster automatisch auf 
die Einstellungen im Fenster. 

Labels 
Registerkarte Labels des Fensters Appearance mit den Parametern 
zur Beschriftung der Peaks und Anzeige der Basislinie. 
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Peak labels Peakbeschriftungen. 
None  Keine Peakbeschriftungen. 
Peak number  Nummer des Peaks. 
Retention time  Retentionszeit. 
Component name  Name der Komponente. 
Component name + Quantity 

Name und Menge der Komponente. 

Channel labels Beschriftung für Messkanal. 
At start Beschriftung am Anfang des Chromato-

gramms. 
In corner Beschriftung in der oberen, rechten Ecke 

des Chromatogrammfensters. 

Show baseline and peaks 
Basislinien werden angezeigt. 

Baseline marker Start und Ende von Basislinien werden mar-
kiert. 

Label always visible Die Peakbeschriftung wird auch beim Zoo-
men immer angezeigt. 

Set all Setzt die Einstellungen zur Peakbeschrif-
tung und Basislinienanzeige aller geöffneter 
Chromatogrammfenster automatisch auf 
die Einstellungen im ausgewählten Fenster. 

Draw every chromatogram point 
Im Chromatogramm werden sämtliche 
Messpunkte angezeigt (die Glättung wird 
ausgeschaltet). 

Select channel 
Registerkarte Select channel des Fensters Appearance für die Aus-
wahl von Kanälen bei Mehrkanalchromatogrammen. 

 

Selection window In diesem Fenster sind alle Chroma-
togramme der Nachbearbeitungstabelle 
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aufgeführt, die für die Anzeige ein- und 
ausgeschaltet werden können. Wird total 
ausgewählt, so werden alle Chromato-
grammkurven addiert und die resultierende 
Kurve angezeigt. 

<Show all> Alle Chromatogramme anzeigen. 

<Hide all> Kein Chromatogramm anzeigen. 

Colors 
Registerkarte Colors des Fensters Appearance mit den Parametern 
für die Farbeinstellungen der Chromatogramme. 

 

this color is default Setzt die Farbe für das gewählte Element 
auf die Grundeinstellung zurück. 

<Choose> Wahl einer neuen Farbe für das gewählte 
Element. Die ausgewählte Farbe wird ne-
ben diesem Knopf angezeigt. 

Hair Farbe des Cursors. 
Background Farbe des Hintergrundes. 
Axes Farbe der Achsen und Achsenbeschriftun-

gen. 
Baseline Farbe der Basislinie. 
AlterGround Alternative Farbe des Hintergrundes beim 

Messen der Basislinie mit Measure baseline. 
Channel 1...8 Farbe des gewählten Kanals. Jeder Kanal 

kann in einer eigenen Farbe dargestellt wer-
den. 

Line width Linienstärke für das gewählte Element 
(Axes oder Channel 1...8) in % der Schrifthö-
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he der gewählten Schrift.  
Bereich: 0 ... 232 

Set all Setzt die Farbeinstellungen aller geöffneter 
Chromatogrammfenster automatisch auf 
die Einstellungen im ausgewählten Fenster. 

<Load defaults> Setzt die Farben im ausgewählten Chroma-
togrammfenster auf die gespeicherten 
Grundeinstellungen zurück. 

<Save defaults> Speichert die Farben im ausgewählten 
Chromatogramm als Grundeinstellung. 

8.3.2 Weitere grafische Funktionen 

 IC NET / View / X full scale 

Mit diesem Menüpunkt oder durch Drücken der Tasten [ Ctrl ] + 
[ Home ] wird die Skalierung der X-Achse so gesetzt, dass das 
Chromatogramm auf der ganzen Breite im Fenster sichtbar ist.  

 IC NET / View / Y full scale 

Mit diesem Menüpunkt oder durch Drücken der Tasten [ Ctrl ] + 
[ End ] wird die Skalierung der Y-Achse so gesetzt, dass das 
Chromatogramm auf der ganzen Höhe im Fenster sichtbar ist. 

 IC NET / View / View all 

Mit diesem Menüpunkt oder durch Drücken der Tasten [ Alt ] + 
[ V ] wird die Skalierung von X- und Y-Achsen so gesetzt, dass 
das ganze Chromatogramm im Fenster sichtbar ist.  

 IC NET / View / Recorder autoscale 

Diese Option erlaubt es, das Chromatogramm so zu betrachten, 
dass der letzte Punkt während der Datenaufnahme immer auf 
dem Bildschirm sichtbar bleibt.  

Ist die Option Recorder autoscale eingeschaltet, so gelten die fol-
genden Regeln: 
• Verschwindet der letzte Punkt nach unten aus dem Fenster, 

wird ein Autozero ausgeführt.  
• Ist der letzte Punkt zu hoch, wird die Y-Skala verkleinert, bis der 

Punkt wieder auf dem Bildschirm zu sehen ist.  
• Tritt der letzte Punkt nach rechts aus dem Bildschirm, wird das 

Fenster um den halben Bildschirm nach rechts verschoben.  

Ist die Option Recorder autoscale ausgeschaltet, ändert sich die 
Fensterskalierung während der Datenaufnahme nicht automa-
tisch.  
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8.4 Peak-Editor 

8.4.1 Ein-/Ausschalten des Peak-Editors 

 IC NET / Process / Peak editor 

Der Peak-Editor wird zur nachträglichen, manuellen Korrektur der 
gemäss Methode automatisch durchgeführten Integration (siehe 
Kap. 7.4) verwendet. Mit ihm können die wichtigsten Punkte für 
die Peakauswertung (Start, Ende und Spitze des Peaks, Tal zwi-
schen Peaks) ausgewählt und an die gewünschte Stelle verscho-
ben werden. 
Ist der Peak-Editor-Modus eingeschaltet, so erscheint der vertika-
le Cursor (Linie) im Fenster des Chromatogramms. Gleichzeitig 
erscheinen der Menupunkt Peak in der Menüleiste und die Sym-
bole für die Peak-Editor-Funktionen in der Symbolleiste. 

Der Peak-Editor-Modus wird durch Klicken auf    oder über die 
Tastenkombination [ Alt ] + [ C ] ein- und ausgeschaltet. Es ist 
auch möglich, irgendwo innerhalb des Chromatogrammfensters 
die rechte Maustaste zu drücken und den Menüpunkt Peak editor 
zu wählen. 
Der Peak-Editor kann nicht aktiviert werden, wenn die Komponen-
tentabelle eingeschaltet ist, und ebenso ist bei aktiviertem Peak-
Editor das Öffnen der Komponententabelle nicht möglich. 

8.4.2 Funktionen des Peak-Editors 

Die Funktionen des Peak-Editors können mit den Menüpunkten 
des Menüs Peak, mit den Peak-Editor-Symbolen in der Symbol-
leiste oder mit Tastaturkombinationen ausgelöst werden. 

 IC NET / Peak / Undo  

Letzte Änderung zurücksetzen. 

 IC NET / Peak / Insert peak [ Insert ] 
Fügt einen Peak im Chromatogramm ein. 

 IC NET / Peak / Delete peak [ Delete ] 
Löscht den gewählten Peak im Chromatogramm. 

 IC NET / Peak / Select nearest point  

Bewegt den Cursor zum nächsten Fixpunkt (Start, Spitze, Ende, 
Tal) des Peaks im Chromatogramm und wählt diesen aus. 

 IC NET / Peak / Select start point 

Bewegt den Cursor zum Anfang des nächsten Peaks und wählt 
diesen aus. 

 IC NET / Peak / Select top point 

Bewegt den Cursor zur Spitze des nächsten Peaks und wählt die-
sen aus. 
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 IC NET / Peak / Select end point 
Bewegt den Cursor ans Ende des nächsten Peaks und wählt die-
sen aus. 

 IC NET / Peak / Select valley point 

Bewegt den Cursor ins Tal zwischen den zwei nächsten Peaks. 

 IC NET / Peak / Unselect peak 

Löscht die Auswahl. 

 IC NET / Peak / Move selected point [ – ] 
Verschiebt einen gewählten Punkt des Peaks (Start, Spitze, Ende, 
Tal) zur Position des Cursors. 

 IC NET / Peak / Merge peaks [ + ] 
Vereinigt zwei benachbarte Peaks in einem einzigen Peak. 

 IC NET / Peak / Fuse peaks [ * ] 
Verbindet das Ende des vorausgehenden Peaks mit dem Anfang 
des nächsten Peaks an der Position des Cursors. 

 IC NET / Peak / Split peaks [ / ] 
Trennt einen Peak an der Position des Cursors in zwei einzelne 
Peaks auf. 

 IC NET / Peak / Delete all left 

Löscht alle Peaks links von der gewählten Position. 

 IC NET / Peak / Delete all right 

Löscht alle Peaks rechts von der gewählten Position. 

 
 

8.4.3 Verschieben des Cursors 

Der Cursor kann mit der Maus bewegt werden, wenn die rechte 
Maustaste gedrückt ist. Durch Loslassen der Taste bleibt der 
Cursor an der neuen Position. Die Position des Cursors wird in 
der Statuszeile des Chromatogrammfensters angezeigt. 

Der Cursor kann auch mit der Tastatur bewegt werden: 

[ ← ] Bewegt den Cursor nach links. 

[ Shift ] + [ ← ] Bewegt den Cursor schnell nach links. 

[ → ] Bewegt den Cursor nach rechts. 

[ Shift ] + [ → ] Bewegt den Cursor schnell nach rechts. 

[ / ] Bewegt den Cursor an den Anfang 
des Fensters. 

[ / ] Bewegt den Cursor an das Ende des Fens-
ters. 
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8.5 Drucken 

8.5.1 Seiteneinstellungen für den Druck 

IC NET / File / Page layout 

Bei der Wahl dieses Menüpunkts oder beim Klicken auf <Page...> 
im Fenster Report options erscheint das Fenster Page layout zur 
Eingabe der Seiteneinstellungen. 

 

Length units Wahl der Längeneinheit. 
inches Inches. 
centimeters Zentimeter. 

Page margins Wahl der Seitenränder. 
Left Linker Seitenrand. 
Right Rechter Seitenrand. 
Top Oberer Seitenrand. 
Bottom Unterer Seitenrand. 

Chromatogram plot size 
Wahl des Druckbereichs für Chroma-
togramme. 

Width  Breite des Druckbereichs. 
Height  Höhe des Druckbereichs. 

Calibration graph size Wahl des Druckbereichs für Kalibrierkurven. 
Width  Breite des Druckbereichs. 
Height  Höhe des Druckbereichs. 
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<Load default> Standardwerte für Seiteneinstellungen la-
den. 

<Save as default> Gesetzte Seiteneinstellungen als Standard-
werte speichern. 

 
8.5.2 Druckereinstellungen 

IC NET / File / Printer setup 

Bei der Wahl dieses Menüpunkts erscheint das Standard-Win-
dows-Fenster Drucker einrichten, in dem der gewünschte Drucker 
ausgewählt und Papiergrösse und Format ausgewählt werden 
können. 

 
8.5.3 Druckvorschau 

 IC NET / File / Preview 

Bei der Wahl dieses Menüpunkts erscheint das Fenster Preview, 
in dem eine Vorschau des unter Report options definierten Reports 
für den ausgewählten Drucker angezeigt wird. 

 
8.5.4 Drucken 

 IC NET / File / Print 

Bei der Wahl dieses Menüpunkts erscheint das Fenster Drucken, 
in dem Drucker, Druckbereich und Anzahl Kopien eingegeben 
werden können. Für den anschliessenden Ausdruck gelten die im 
Fenster Report options definierten Einstellungen mit Ausnahme 
des Ausgabeziels (der Report wird immer auf den Drucker aus-
gegeben). 

Damit das Chromatogramm ausgedruckt wird, muss im Fenster 
Report options unter Items to report die Option Chromatogram plot 
eingeschaltet sein. 

 IC NET / Process / Make report 

Bei der Wahl dieses Menüpunkts erscheint das Fenster Report op-
tions, mit dem ein Report auf den Bildschirm, auf den Drucker 
oder in eine Datei ausgegeben werden können (Details siehe 
Kap. 7.6). 
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8.6 Diverse Funktionen 

8.6.1 Neuintegration 

 IC NET / Process / Reintegrate 

Bei der Wahl dieses Menüpunkts erscheint das Fenster Integration 
parameters, in dem eine Neuintegration des Chromatogramms 
gestartet werden kann (Details siehe Kap. 7.4). 

 

 

8.6.2 Neukalibrierung 

 IC NET / Process / Calibrate 

Bei der Wahl dieses Menüpunkts erscheint das Fenster Recalibra-
tion, in dem der Kalibrierpunkt eingegeben werden kann, mit dem 
das Chromatogramm neu kalibriert werden soll (Details siehe 
Kap. 7.5). 

 

 

8.6.3 Elektronische Unterschrift 

 IC NET / Process / Electronic signature 

Bei der Wahl dieses Menüpunkts erscheint das Fenster Electronic 
signature, es erlaubt das Chromatogramm in dem aktiven Fens-
ter zu unterschreiben, oder dessen Unterschrift zu ändern. Wenn 
ein Chromatogramm einmal unterschrieben ist, kann es nicht 
mehr geändert werden. Um ein unterschriebenes Chroma-
togramm zu ändern, muss die Unterschrift widerrufen werden. 

 
Das Chromatogramm das unterschrieben werden soll muss sich 
im aktiven Fenster befinden. 

 

Die erste Zeile des Fensters zeigt den Pfad und den Dateina-
men des Chromatogramms, das unterschrieben werden soll. Der 
Benutzer muss das Chromatogramm mit seinem Benutzernamen, 
Passwort und einer Angabe der Bedeutung der Unterschrift un-
terschreiben. 
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New data 

User name Benutzername des Unterschreibenden. 
Password Passwort des Unterschreibenden. 
Meaning Bedeutung der Unterschrift, wird aus der 

Pop-up Liste ausgewählt, die im Meaning set 
Fenster vordefiniert werden kann. 

Actions 
<Sign-off> Chromatogramm unterschreiben. 
<Revoke> Unterschrift widerrufen. 

 
Wenn ein Chromatogramm einmal unterschrieben ist, kann es 
nicht mehr geändert werden. Um ein unterschriebenes Chroma-
togramm zu ändern, muss die Unterschrift widerrufen werden. 

<Close> Schliesst das Fenster Electronic signature. 
<Modifiy meaning set> Öffnet das Fenster Meaning set. 
<Info> Öffnet die Tabelle Signatures, die Unter-

schriftsstatus, Benutzer, Datum, Zeit und 
Bedeutung der Unterschriften eines Chro-
matogramms auflistet. 

 
Meaning set 

Dieses Fenster enthält die Auswahlliste von Bedeutungen für die 
Elektronische Unterschrift, diese Liste ist editierbar. 

 
Meaning Standardeinträge sind: 

Approval (Genehmigung), 
Review (Nachprüfung), 
Rejection (Verwerfung), 
Responsibility (Verantwortlichkeit), 
Authorship (Urheberschaft). 
Die Liste der Bedeutungen kann durch kli-
cken auf den Titel alphabetisch sortiert wer-
den. Ein Stern ( * ) am Ende des Titels zeigt 
die Sortierung an. 

<Add> Eine Unterschriftsbedeutung zur Liste hin-
zufügen, das Eingabefenster öffnet sich. 
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<Delete> Unterschriftsbedeutung löschen. 
<Modifiy> Eine Unterschriftsbedeutung ändern, das 

Eingabefenster öffnet sich. 
 
 

Info 
 IC NET / Process / Electronic signature 

Dieses Fenster zeigt die Unterschriften des Chromatogramms im 
aktiven Fenster. 

 

Die Unterschriftentabelle kann durch klicken auf den Titel nach ei-
ner der fünf Spalten sortiert werden. Ein Stern ( * ) am Ende des 
Titels zeigt die Sortierung an. 

 
 

8.6.4 Subtraktion eines Chromatogramms 

 IC NET / Process / More / Subtract 

Bei der Wahl dieses Menüpunkts erscheint das Fenster Subtract 
chromatogram, welches das Subtrahieren jedes geöffneten Chro-
matogramms vom aktiven, ausgewählten Chromatogramm er-
möglicht.  

 

Wählen Sie das Chromatogramm aus, das subtrahiert werden 
soll, klicken sie auf <Subtract> und anschliessend auf IC NET / View 
/ View all. Als Ergebnis erhält man ein neues Chromatogramm, 
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welches unter einem neuen Namen gespeichert wird, um ein 
Überschreiben alter Daten zu verhindern. 

 

8.6.5 Chromatogramm vergleichen 

 IC NET / Process / More / Compare 

Bei der Wahl dieses Menüpunkts erscheint das Fenster Compare 
with, welches das Vergleichen des aktiven geöffneten Chroma-
togramms mit jedem anderen geöffneten Chromatogramm oder 
Methode ermöglicht. 

 
Das Chromatogramm (oder die Methode)das verglichen werden 
soll muss sich im aktiven Fenster befinden. 

 

<Compare> Vergleicht die ausgewählte Datei mit dem 
Chromatogramm (oder der Methode) des 
aktiven Fensters und zeigt das Ergebnis im 
Fenster Differences. 

 
Differences 

Dieses Fenster zeigt die Unterschiede der beiden Dateien, die 
verglichen wurden. 
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File 
Close Schliesst das Fenster und kehrt zum Fesnter 

Compare with zurück. 

Edit 
Copy Kopiert die Daten des Vergleichs in die Zwi-

schenablage. 

Linker Frame Übersicht über die gefundenen Unterschiede, 
in einer Baumstruktur angeordnet. Klicken auf 
den entsprechenden Eintrag zeigt dessen Ei-
genschaften im rechten Frame. Der angezeigte 
Eintrag ist hervorgehoben. 

Rechter Frame Tabelle der Eigenschaften des ausgewählten 
Eintrags. Die Tabelle kann nach einer der drei 
Spalten Description, file1 oder file2 durch kli-
cken auf den Titel sortiert werden. Ein Stern ( * 
) am Ende des Titels zeigt das Sortierkriterium 
an. 

 

 

8.6.6 Datenkomprimierung 

 IC NET / Process / More / Compress 

Bei der Wahl dieses Menüpunkts erscheint das Fenster Raw data 
compression für die Datenkompression des geöffneten Chroma-
togramms durch Aufsummieren benachbarter Messpunkte.  

 

Divisor Komprimierungsgrad (die Anzahl Mess-
punkte wird um diesen Faktor reduziert). 
Der in diesem Feld standardmässig einge-
tragene Wert wird so berechnet, dass die 
Halbwertsbreite des schmalsten Peaks 
mindestens 30 Messpunkte beträgt. Wird 
hier ein grösserer Wert eingegeben, so 
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kann die Genauigkeit der Integration verrin-
gert werden. 

 

8.6.7 Chromatogramm invertieren 

 IC NET / Process / More / Invert! 

Bei der Wahl dieses Menüpunkts werden die Kurven aller Kanäle 
des Chromatogramms invertiert, so dass negative Peaks zu posi-
tiven werden und umgekehrt (sinnvoll bei Chromatogrammen, die 
mit falscher Polarität aufgenommen wurden). 

 

8.6.8 Autodatabase 

 IC NET / Method / Autodatabase 

Mit diesem Menüpunkt öffnet sich das Fenster Autodatabase opti-
ons, in dem Einstellungen für das Programm Autodatabase vorge-
nommen werden können. 

 

Database file Definition der Datenbankdatei (*.adb), in die 
Chromatogramme manuell oder automa-
tisch mit <Send to Autodatabase> gesendet 
werden, falls die Option Send data to Autoda-
tabase file auf der Registerkarte Processing 
im Fenster Method setup eingeschaltet ist. 
Benutzen Sie <Browse> für die Wahl der Da-
tenbankdatei. 

Print autodatabase report immediately after sending 
Ist diese Option eingeschaltet, wird 
automatisch ein Report ausgedruckt, der 
die definierte Report-Vorlage (*.rt) benutzt. 
Benutzen Sie <Browse> für die Wahl der 
Vorlage. 

<Send to Autodatabase> 
Daten des ausgewählten Chromatogramms 
zur spezifizierten Autodatabase-Datei sen-
den. 
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<Accept> Änderungem im Fenster Autodatabase opti-
ons bestätigen. 

<Cancel> Fenster schliessen, ohne dass die Ände-
rungen wirksam werden. 

 
Detaillierte Informationen zu «Autodatabase 1.0» finden Sie in 
der Online-Hilfe zu diesem Programm. 

 
IC NET / Options / Indicate AutoDB server 

Mit diesem Menüpunkt erscheint die Schaltfläche für das Pro-
gramm Autodatabase auf der Taskleiste, falls es durch Senden 
von Daten bereits im Hintergrund gestartet wurde. 
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9 Probentabellen 
Eine Probentabelle (Sample queue) dient zur automatischen 
Abarbeitung von Probeserien, insbesondere in Verbindung mit ei-
nem Probenwechsler. Die Anzahl Zeilen der Probentabelle ent-
spricht der Anzahl Bestimmungen, die automatisch ablaufen. Die 
probenspezifischen Daten werden der Reihe nach für die laufen-
de Bestimmung benutzt und überschreiben die entsprechenden 
Parameter in der Methode. 

Die Probentabellen werden als Probentabellendateien *.que in ei-
nem Unterordner des Verzeichnisses Methods gespeichert. 
 

9.1 Probentabellen verwalten 

9.1.1 Probentabelle öffnen 

 IC NET / File / Open / Sample queue 
 SYSTEM / System / Sample queue 

Mit diesen beiden Menüpunkten wird das Fenster OPEN geöffnet, 
mit dem entweder eine bestehende Probentabellendatei *.que 
ausgewählt oder, nach Eingabe eines neuen Namens, eine neue 
Probentabellendatei *.que angelegt werden kann. Nach Bestäti-
gung mit <OK> wird das Übersichtsfenster für die Probentabelle 
geöffnet (siehe Kap. 9.2). 

9.1.2 Probentabelle speichern 

 QUEUE EDITOR / File / Save 

Probentabelle in einer Probentabellendatei (*.que) im Arbeitsver-
zeichnis speichern. Das Editorfenster für die Probentabelle bleibt 
geöffnet. 

 QUEUE EDITOR / File / Save & exit 

Probentabelle in einer Probentabellendatei (*.que) im Arbeitsver-
zeichnis speichern und Editorfenster für die Probentabelle 
schliessen. 

 SAMPLE QUEUE OVERVIEW / File / Save as 

Kopie der Probentabelle in einer neuen Probentabellendatei 
(*.que) im Arbeitsverzeichnis speichern. 

9.1.3 Probentabelle löschen 

 SAMPLE QUEUE OVERVIEW / File / Delete 

Übersichtsfenster für Probentabelle schliessen und Probentabel-
lendatei (*.que) löschen. 
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9.2 Probentabellen verwenden 

9.2.1 Übersichtsfenster für Probentabelle 

 IC NET / File / Open / Sample queue 
 SYSTEM / System / Sample queue 

Mit diesen beiden Menüpunkten wird das Fenster OPEN geöffnet, 
mit dem entweder eine bestehende Probentabellendatei *.que 
ausgewählt oder, nach Eingabe eines neuen Namens, eine neue 
Probentabellendatei *.que angelegt werden kann. Nach Bestäti-
gung mit <OK> wird das Übersichtsfenster für die Probentabelle 
geöffnet, in dem der aktuelle Status bei der Probenabarbeitung 
angezeigt wird: 

 

No Zeilennummer. 
System Systemdatei, die für die Bestimmung ver-

wendet wird. 
Ident Benutzerspezifischer Titel des Chroma-

togramms. Wird beim Start des Chroma-
togramms in das entsprechende Feld im 
Passport eingefügt. 

Vial Position der Probe auf dem Probenwechs-
ler. 

Inj-s Anzahl Injektionen für dieselbe Probenposi-
tion (für Level ≥ 1 ist nur 1 Injektion zuläs-
sig). 

Started Anzeige, ob die Probe gestartet wurde oder 
nicht: 
 0 Probe nicht gestartet 
 1 Probe gestartet 
 2…n Anzahl ausgeführter Injektionen 

Level Kalibrierpunkt (siehe Kap. 7.5) für die Pro-
be: 0 steht für normale Proben, ≥1 steht für 
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Kalibrierproben. Damit können automatisch 
Kalibrierungen durchgeführt werden.  

Volume Injektionsvolumen in µL. 
Amount Probenmenge. Ist dieser Wert für Probe (s) 

und Kalibrierlösungen (c) verschieden, so 
werden die Konzentrationen der Kompo-
nenten in der Probe wie folgt berechnet: 

Cs = Cc • Amounts / Amountc 

Shut down system after the queue finishes 
Ist diese Option eingeschaltet, wird die 
Hardware nach Beendigung der Probenab-
arbeitung automatisch gestoppt (die beiden 
Pumpen werden ausgeschaltet), das Sys-
tem bleibt aber angeschlossen. 

<Start> Start der Abarbeitung der Probentabelle ab 
der ersten Zeile mit Started = 0. 

<Pause> Stopp der Abarbeitung der Probentabelle 
nach Beendigung der laufenden Bestim-
mung. 

<Edit> Öffnen des Editorprogramms für die Ände-
rung von Probentabellen (siehe Kap. 9.3). 

<Close> Schliessen des Übersichtsfensters für die 
Probentabelle. 

 

9.2.2 Probentabelle starten 

 SAMPLE QUEUE OVERVIEW / Control / Start 
Die Abarbeitung der Probentabelle wird ab der ersten Zeile mit 
Started = 0 gestartet. Bei jeder Zeile werden die probenspezifi-
schen Daten zur Methode der aktuellen Bestimmung übertragen 
und der Parameter Started auf 1 gesetzt. 

Eine mit <Pause> unterbrochene Abarbeitung der Probentabelle 
kann mit <Start> wieder fortgesetzt werden (bei laufendem Chro-
matogramm erst nach Schluss der Datenaufnahme). 

 

9.2.3 Probentabelle anhalten 

 SAMPLE QUEUE OVERVIEW / Control / Pause 
Die Abarbeitung der Probentabelle wird nach Beendigung der 
laufenden Bestimmung unterbrochen. 

Wenn die laufende Bestimmung beendet ist, kann die Abarbei-
tung der Probentabelle entweder mit <Start> wieder fortgesetzt 
oder mit Control / Stop determination im Systemfenster abgebro-
chen werden. 



9  Probentabellen 
 

IC Net 2.2 212 

9.2.4 Letzte Bestimmung widerrufen 

SAMPLE QUEUE OVERVIEW / Control / Cancel last run 
Die letzte Bestimmung wird widerrufen (für diese Zeile wird wieder 
Started = 0 gesetzt). Falls die Probentabelle neu gestartet wird, 
wird diese Zeile wieder ausgeführt. 
Diese Funktion ist nur verfügbar, wenn die Abarbeitung der Pro-
bentabelle mit <Pause> unterbrochen wurde. 

 
9.2.5 Probentabelle zurücksetzen 

SAMPLE QUEUE OVERVIEW / Control / Reset 
Die Probentabelle wird wieder auf den ursprünglichen Zustand 
zurückgesetzt (für alle Zeilen wird Started = 0 gesetzt). 
Diese Funktion ist nur verfügbar, wenn die Abarbeitung der Pro-
bentabelle mit <Pause> unterbrochen wurde. 
 

9.3 Probentabellen bearbeiten 

9.3.1 Editorfenster öffnen 

 SAMPLE QUEUE OVERVIEW / Control / Edit 
Mit diesem Menüpunkt öffnet sich das Editorfenster für die Bear-
beitung von Probentabellen. 

 
No Zeilennummer. 
System Systemdatei, die für die Bestimmung ver-

wendet wird. Das System wird automatisch 
geöffnet und verbunden. 

 
Alle Systemdateien der Probentabelle 
müssen im gleichen Systemunterordner 
gespeichert sein. 

 
Ident Benutzerspezifischer Titel des Chromato-

gramms. Wird beim Start des Chromato-
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gramms in das entsprechende Feld im 
Passport eingefügt. 

Vial Position der Probe auf dem Probenwechs-
ler. 

Volume Injektionsvolumen in µL. 
Dilution Verdünnung der Probe vor der Injektion. 
Amount Probenmenge. Ist dieser Wert für Probe (s) 

und Kalibrierlösungen (c) verschieden, so 
werden die Konzentrationen der Kompo-
nenten in der Probe wie folgt berechnet: 

 Cs = Cc • Amounts / Amountc 
Internal standard amount 

Konzentration des internen Standards. 
Level Kalibrierpunkt (siehe Kap. 7.5) für die Pro-

be: 0 steht für normale Proben, ≥1 steht für 
Kalibrierproben. Damit können automatisch 
Kalibrierungen durchgeführt werden.  

Injections Anzahl Injektionen für dieselbe Probenposi-
tion (für Level ≥ 1 ist nur 1 Injektion zuläs-
sig). 

Done Anzeige, ob die Bestimmung bzw. Injektion 
beendet ist oder nicht: 
0 Bestimmung noch nicht beendet 
1…n Bestimmung bzw. Injektion beendet 

Sample Info 1 Information 1 zur Probe. 
Sample Info 2 Information 2 zur Probe. 
 
 

9.3.2 Funktionen im Editorfenster 

Die Funktionen im Editorfenster für Probentabellen können mit 
den entsprechenden Menüpunkten des Menüs Edit oder mit den 
entsprechenden Symbolen in der Symbolleiste ausgelöst werden. 

 QUEUE EDITOR / Edit / Undo 
Letzte Änderung in der Probentabelle zurücksetzen. 

 QUEUE EDITOR / Edit / Cut row(s) 
Ausgewählte Zeilen in der Probentabelle ausschneiden und in 
Zwischenablage kopieren. 

 QUEUE EDITOR / Edit / Copy row(s) 
Ausgewählte Zeilen in der Probentabelle in Zwischenablage ko-
pieren. 

 QUEUE EDITOR / Edit / Paste row(s) 
Zeilen aus der Zwischenablage in der Probentabelle einfügen. 
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 QUEUE EDITOR / Edit / Delete row(s) 
Ausgewählte Zeilen in der Probentabelle löschen. 

 QUEUE EDITOR / Edit / Duplicate row(s) 
Ausgewählte Zeilen in der Probentabelle duplizieren. 

 QUEUE EDITOR / Edit / Increment 
Ausgewählte Felder in einer Spalte mit Werten füllen, die automa-
tisch um 1 erhöht werden. Das letzte Zeichen des ersten Feldes 
muss dabei eine Zahl sein. Diese Funktion ist für die Spalten 
Ident, Vial, Level, Sample Info 1 und Sample Info 2 verfügbar.  

 QUEUE EDITOR / Edit / Propagate 
Ausgewählte Felder in einer Spalte mit demselben Wert füllen, der 
im ersten Feld enthalten ist.  

 QUEUE EDITOR / Edit / Reset 
Probentabelle zurücksetzen (Done = 0 für alle Zeilen). 

 QUEUE EDITOR / Edit / Change system 
Systemdatei (*.smt) für die ausgewählten Zeilen ändern. 

 

 

9.3.3 Probentabelle ausdrucken 

 QUEUE EDITOR / File / Print 
Die Probentabelle wird im Format A4quer ausgedruckt. 

 

 

9.3.4 Editorfenster schliessen 

 QUEUE EDITOR / File / Save & Exit 
Probentabelle speichern und Editorfenster schliessen. 

 QUEUE EDITOR / File / Exit 
Editorfenster schliessen. Es erscheint die Abfrage, ob die Proben-
tabelle gespeichert werden soll oder nicht. 
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10 Nachbearbeitung 
Unter Nachbearbeitung (Reprocessing) versteht man die nach-
trägliche Überarbeitung einer Serie von Chromatogrammen, die 
in eine Nachbearbeitungstabelle (Batch reprocessing 
queue) geladen wurden. Für die Überarbeitung anhand einer 
ausgewählten Methode können die Einstellungen für Kalibrierung, 
Integration, Passport, Aussehen und Report beliebig verändert 
werden. 

Die Nachbearbeitungstabellen werden als Nachbearbeitungsta-
bellendateien *.bar im Verzeichnis Data gespeichert. 

 

10.1 Nachbearbeitungstabellen verwalten 

10.1.1 Nachbearbeitungstabelle öffnen 

 IC NET / File / Open / Batch reprocessing 

Bestehende Nachbearbeitungstabellendatei *.bar aus dem Ver-
zeichnis Data laden und Fenster Reprocess öffnen. 

 

 IC NET / File / Open / Last batch 

Die zuletzt geladene Nachbearbeitungstabellendatei *.bar aus 
dem Verzeichnis Data laden und Fenster Reprocess öffnen. 

 

 

10.1.2 Neue Nachbearbeitungstabelle erstellen 

 IC NET / File / Open / Chromatogram 

Für das Erstellen einer neuen Nachbearbeitungstabelle muss zu-
erst das Fenster Chromatogram open geöffnet werden. Wählen sie 
dann die gewünschten Chromatogrammdateien (*.chw) aus und 
klicken Sie auf <To Batch>. Geben Sie einen Namen für die neue 
Nachbearbeitungstabelle ein und klicken Sie auf <OK>. Die aus-
gewählten Chromatogramme werden dann in die Tabelle gela-
den. 

 
Falls die Nachbearbeitung eine Neuintegration und/oder Neu-
kalibrierung einschliesst, dürfen nur Chromatogramme in die 
Nachbearbeitungstabelle geladen werden, die mit derselben 
Methode aufgenommen wurden. 
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10.1.3 Nachbearbeitungstabelle speichern 

 QUEUE EDITOR / File / Save 

Nachbearbeitungstabelle in einer Nachbearbeitungstabellendatei 
(*.bar) im Arbeitsverzeichnis speichern. Das Editorfenster für die 
Nachbearbeitungstabelle bleibt geöffnet. 

 QUEUE EDITOR / File / Save & exit 

Nachbearbeitungstabelle in einer Nachbearbeitungstabellendatei 
(*.bar) im Arbeitsverzeichnis speichern und Editorfenster für die 
Nachbearbeitungstabelle schliessen. 

 

10.2 Nachbearbeitung durchführen 

10.2.1 Übersichtsfenster für Nachbearbeitungstabelle 

 IC NET / File / Open / Batch reprocessing 
 IC NET / File / Open / Last batch 

Mit diesen beiden Menüpunkten wird das Fenster Reprocess ge-
öffnet, in dem die verschiedenen Optionen für die Nachbearbei-
tung eingestellt und diese ausgelöst werden können. 

Use method from file for reprocessing 
Auswahl des gewünschten Chromato-
gramms, dessen Methode für die Nachbe-
arbeitung verwendet werden soll. 

 
Falls die Nachbearbeitung eine Neuinteg-
ration und/oder Neukalibrierung ein-
schliesst, dürfen nur Chromatogramme in 
die Nachbearbeitungstabelle geladen 
werden, die mit derselben Methode auf-
genommen wurden. 

 

<Open example> Öffnen des im Feld Use method... ausge-
wählten Chromatogramms. 

<Open all files> Öffnen von allen in der Nachbearbeitungs-
tabelle enthaltenen Chromatogrammen. 

<Edit sample table> Öffnen des Editorfensters für die Änderung 
von Nachbearbeitungstabellen (siehe Kap. 
10.3). 

Reprocess sample runs 
Alle Probenchromatogramme überarbeiten 
(Kalibrierpunkt calibration level = 0). 
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Reprocess calibration runs 
Alle Kalibrierchromatogramme überarbeiten 
(Kalibrierpunkt calibration level > 0). 

Update method file in <METHODS> directory after reprocessing 
Falls die Methode geändert wurde, wird die 
Methodendatei *.mtw nach der Nachbear-
beitung gespeichert. 

Reintegrate Neuintegration des Chromatogramms ge-
mäss den aktuellen Einstellungen der Integ-
rationsparameter und Integrationsereignis-
se. 

<Edit integration parameters> 
Öffnet das Fenster Integration parameters 
zum Ändern von Integrationsparametern 
und Integrationsereignissen. 

Recalibrate Überarbeitet alle Chromatogramme der Ka-
librierung (falls Reprocess calibration runs 
eingeschaltet ist), aktualisiert die Konzen-
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trationstabelle und wendet die neue Kalib-
rierung auf alle Probenchromatogramme an 
(falls Reprocess sample runs eingeschaltet 
ist). 

Default scheme Grundeinstellung für Neukalibrierung. Die 
zwei Optionen Apply final calibration... und 
Forget calibration points... werden einge-
schaltet. Mit den Kalibrierchromatogram-
men wird eine Neukalibrierung durchge-
führt. Die neue Kalibrierung (Komponenten-
tabelle, Konzentrationstabelle und Kalibrier-
kurve) wird anschliessend auf alle Proben-
chromatogramme angewendet. 

Apply final calibration to all reprocessed files 
Wendet die überarbeitete Kalibrierung auf 
alle Probenchromatogramme an. Falls die-
se Option ausgeschaltet ist, wird die im ers-
ten Chromatogramm gespeicherte Kalibrie-
rung für alle anderen Chromato-gramme 
verwendet. 

Forget calibration points before reprocessing 
Löscht die alten Kalibrierpunkte der Kalib-
rierkurve und führt eine Neu-kalibrierung mit 
den in der Nachbe-arbeitungstabelle ent-
haltenen Kalibrier-chromatogrammen 
durch. Mit jedem Kalibrierchromatogramm 
wird ein neuer Punkt zur Kalibrierkurve hin-
zugefügt. Falls diese Option ausgeschaltet 
ist, bleibt die im ersten Chromatogramm 
gespeicherte Kalibrierung aktiv. Jedes wei-
tere Kalibrierchromatogramm fügt einen 
neuen Punkt zu dieser Kalibrierkurve hinzu. 

Recalculate only Führt eine Neuberechnung der Chromato-
gramme mit den in der Nachbearbeitungs-
tabelle eingetragenen Werten für Volume, 
Dilution, Amount und Internal standard 
amount durch.  

 
Falls die Optionen Reintegrate und/oder 
Recalculate eingeschaltet sind, wird auto-
matisch eine Neuberechnung durchge-
führt. Falls die Option Recalculate only ein-
geschaltet wird, werden die Optionen 
Reintegrate und Recalculate automatisch 
ausgeschaltet. 

 

Change passport Falls diese Option eingeschaltet ist, werden 
diejenigen Parameter des Passports, die 
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mit <Edit passport> geändert wurden, auf al-
le Chromatogramme angewendet. 

<Edit passport> Öffnet das Fenster Passport zum Ändern 
der Passportparameter. 

 
Es können nicht alle Passportparameter 
geändert werden. Die in der Nachbearbei-
tungstabelle eingegebenen Parameter 
Ident, Sample Info 1 und Sample Info 2 wer-
den überschrieben, falls diese Werte im 
Fenster Passport geändert wurden. 

Modify chromatogram appearance 
Falls diese Option eingeschaltet ist, werden 
diejenigen Parameter des Fensters Appea-
rance, die mit <Edit appearance> geändert 
wurden, auf alle Chromatogramme ange-
wendet. 

<Edit appearance> 
Öffnet das Fenster Appearance zum Ändern 
von Achsen, Beschriftungen und Farben. 

Make report Druckt für jedes Chromatogramm einen 
Report aus. Dabei werden die Reportein-
stellungen des im Feld Use method... aus-
gewählten Chromatogramms verwendet. 

<Edit report options> 
Öffnet das Fenster Report options zum Än-
dern der Reporteinstellungen, siehe Kap. 
7.6.1. 

Statistics Ausgabe eines Statistikreports für die aus-
gewählten Chromatogramme. 

<Edit statistics options> 
Öffnet das Fenster Statistics options um die 
Einstellungen für die statistische Auswer-
tung und die Ausgabe zu ändern. 

Send to Autodatabase Daten der ausgewählten Chromatogramme 
in der ausgewählten Autodatabase-Datei 
speichern. 

<Edit Autodatabase options> 
Öffnen des Fensters Autodatabase options 
zum Ändern der Autodatabase-Einstellun-
gen, siehe Kap. 8.6.8. 

<Reprocess> Startet die Nachbearbeitung 

<Merge> Kombiniert alle Chromatogramme der 
Nachbearbeitungstabelle in einem Mehr-
Kanal-Chromatogramm. 

<Close> Schliesst das Fenster Reprocess. 
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Statistics Options 
REPROCESS / <Edit statistics options> 

Im Fenster Statistics options werden die Parameter für die statisti-
sche Auswertung der Chromatogramme der geladenen Nachbe-
arbeitungstabelle festgelegt. 

 
Property Legt die Eigenschaft fest die statistisch 

ausgewertet werden soll, diese kann durch 
klicken auf das Pop-up Menü ausgewählt 
werden. 
retention time 
halfwidth 
height 
height% 
area 
area% 
capacity factor 
resolution 
effectivity, TP 
effectivity, TP/m 
reduced TP height 
gaussian factor 
asymmetry 
response factor 
raw concentration (Standardwert) 
concentration 
concentration% 
rel. concentration 
rel. concentration% 
peak amount 

Statistics  
Component Legt den Bestandteil der Probe fest der sta-

tistisch ausgewertet werden soll, er kann 
durch klicken auf das Pop-up Menü aus-
gewählt werden. 
Standardwert: All 

Group Legt die Gruppe der Bestandteile der Probe 
fest der statistisch ausgewertet werden soll, 
sie kann durch klicken auf das Pop-up Me-
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nü ausgewählt werden. 
Standardwert: All 

<Advanced> Open the Advanced window for export set-
tings of the statistics. 

 

Advanced 
REPROCESS / <Edit statistics options> / <Advanced> 

Im Fenster Advanced werden der Pfad (Path)und der Dateiname 
(File name)der Ausgabedatei festgelegt. Falls ein Viewer Pro-
gramm für die Ausgabedatei angegeben ist, wird die Ausgabeda-
tei mit diesem Programm geöffnet sobald sie erzeugt wurde. Das 
kann dazu genutzt werden, um die erzeugten statistischen Daten 
weiterzubearbeiten. 

 
Path Verzeichnispfad für die Ausgabedatei der 

Statistik direkt eingeben oder mit <Browse> 
auswählen. 

<Browse> Öffnet das Fenster Ordner suchen um das 
Verzeichnis für die Ausgabedatei der Statis-
tik im MS Windows Explorer auszuwäh-
len. 

File name Dateinamen für die Ausgabedatei der Sta-
tistik. 
Standardname:  result.xls 
empfohlene Dateitypen: *.xls, *.txt 

 Einstellung für das Speichern der Reportda-
tei. 
Overwrite old report  
Write in new file (Standardwert) 
Ask before writing  

Path to viewer Verzeichnispfad des Viewer Programms für 
die Ausgabedatei der Statistik direkt einge-
ben oder mit <Browse> auswählen. 

<Browse> Öffnet das Fenster Öffnen um das Viewer 
Programm für die Ausgabedatei der Statis-
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tik im MS Windows Explorer auszuwäh-
len. 
Empfohlene Programme: MS Excel, jeder 
ASCII Editor z.B. MS Notepad 

 
Die Ausgabedatei der Statistik ist eine ASCII Datei. Sie kann mit 
jedem Texteditor editiert werden, der Aufbau der Datei erlaubt 
jedoch auch eine Bearbeitung mit MS Excel. Dies bietet die 
Möglichkeit die umfangreichen Funktionen dieser Tabellenkalku-
lation zu nutzen und damit einen einfachen Weg um aus Ihren 
statistischen Daten aussagekräftige Diagramme zu erzeugen. 

 

 
Die Ausgabedatei der Statistik ist eine ASCII Datei, auch wenn 
sie mit der Dateierweiterung *.xls abgespeichert wurde. Dies 
wird von Excel beim Speichern der Datei erkannt. In diesem 
Fall öffnet sich das Fenster Speichern unter von MS Win-
dows. Es wird der Dateiname “Dateiname.xls” (hervorgehoben 
und in Anführungszeichen) mit dem Dateityp *.txt angezeigt. Um 
die Datei im Excel -Dateiformat zu speichern, geben Sie einen 
Dateinamen ein und wählen Sie die Dateierweiterung *.xls aus. 

 

10.2.2 Chromatogramme kombinieren 

REPROCESS / <Merge> 
Kombiniert alle in der Nachbearbeitungstabelle geladenen Chro-
matogramme in einem Mehr-Kanal-Chromatogramm. 
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Die Chromatogramme werden von oben nach unten in der glei-
chen Reihenfolge angezeigt, in der sie in der Nachbearbeitungs-
tabelle geladen sind. Die Distanz zwischen den Kurven kann mit 
[ Shift ] + [ ↑ ] vergrössert und mit [ Shift ] + [ ↓ ] verkleinert wer-
den. 

Die Chromatogrammachsen, Beschriftungen und Farben für das 
Multi-Kanal-Chromatogramm können im Fenster Appearance ein-
gestellt werden. 

Das Multi-Kanal-Chromatogramm kann mit File / Save / Chroma-
togram gespeichert werden. 

 

10.3 Nachbearbeitungstabellen bearbeiten 

10.3.1 Editorfenster öffnen 

REPROCESS / <Edit sample table> 
Mit diesem Menüpunkt öffnet sich das Editorfenster für die Bear-
beitung von Nachbearbeitungstabellen.  

 
No Zeilennummer. 
File name Name der Chromatogrammdatei (nur An-

zeige). 
Method Methodendatei, die für die Bestimmung 

verwendet wurde (nur Anzeige). 
Ident Benutzerspezifischer Titel des Chromato-

gramms. Überschreibt das entsprechende 
Feld im Passport. 

Vial Position der Probe auf dem Probenwechs-
ler. Überschreibt das entsprechende Feld 
im Passport. 

Volume Injektionsvolumen in µL. Überschreibt das 
entsprechende Feld im Passport. 

Dilution Verdünnung der Probe vor der Injektion. 
Überschreibt das entsprechende Feld im 
Passport. 

Amount Probenmenge. Ist dieser Wert für Probe (s) 
und Kalibrierlösungen (c) verschieden, so 
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werden die Konzentrationen der Kompo-
nenten in der Probe wie folgt berechnet: 
  Cs = Cc • Amounts / Amountc 

Überschreibt das entsprechende Feld im 
Passport. 

Internal standard amount 
Konzentration des internen Standards. 
Überschreibt das entsprechende Feld im 
Passport. 

Calibration level Kalibrierpunkt (siehe Kap. 7.5) für die Pro-
be: 0 steht für normale Proben, ≥1 steht für 
Kalibrierproben. Damit können automatisch 
Kalibrierungen durchgeführt werden.  

Sample Info 1 Information 1 zur Probe. Überschreibt das 
entsprechende Feld im Passport. 

Sample Info 2 Information 2 zur Probe. Überschreibt das 
entsprechende Feld im Passport. 

 

10.3.2 Funktionen im Editorfenster 

Die Funktionen im Editorfenster für Nachbearbeitungstabellen 
können mit den entsprechenden Menüpunkten des Menüs Edit 
oder mit den entsprechenden Symbolen in der Symbolleiste aus-
gelöst werden. 

 QUEUE EDITOR / Edit / Undo 
Letzte Änderung in der Nachbearbeitungstabelle zurücksetzen. 

 QUEUE EDITOR / Edit / Delete row(s) 
Ausgewählte Zeilen in der Nachbearbeitungstabelle löschen. 

 QUEUE EDITOR / Edit / Increment 
Ausgewählte Felder in einer Spalte mit Werten füllen, die automa-
tisch um 1 erhöht werden. Das letzte Zeichen des ersten Feldes 
muss dabei eine Zahl sein. Diese Funktion ist für die Spalten 
Ident, Vial, Calibration level, Sample Info 1 und Sample Info 2 verfüg-
bar.  

 QUEUE EDITOR / Edit / Propagate 
Ausgewählte Felder in einer Spalte mit demselben Wert füllen, der 
im ersten Feld enthalten ist.  

 QUEUE EDITOR / Edit / Rotate rows 
Ausgewählte Zeilen um eine Position rotieren (die unterste Zeile 
kommt an die erste Position, alle anderen Zeilen werden um eine 
Position nach unten verschoben). 
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10.3.3 Nachbearbeitungstabelle ausdrucken 

 QUEUE EDITOR / File / Print 
Die Nachbearbeitungstabelle wird im Format A4quer ausge-
druckt. 

10.3.4 Editorfenster schliessen 

 QUEUE EDITOR / File / Save & Exit 
Nachbearbeitungstabelle speichern und Editorfenster schliessen. 

 QUEUE EDITOR / File / Exit 
Editorfenster schliessen ohne Nachbearbeitungstabelle neu zu 
speichern. 
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11 Anhang 

11.1 Softwarelizenzvereinbarung 

Die Nutzung dieser Software unterliegt der nachfolgend aufge-
führten Lizenzvereinbarung zwischen Ihnen und Metrohm AG. 
Diese Lizenzvereinbarung haben Sie bereits mit der Offerte erhal-
ten und zur Kenntnis genommen und mit Erteilung Ihres Auftrags 
an die Metrohm AG oder an eine ihrer Vertriebsgesellschaften 
bzw. mit der Auftragsbestätigung durch Metrohm oder eine ihrer 
Vertriebsgesellschaften akzeptiert. Spätestens mit der Benutzung 
der Software zeigen Sie an, dass Sie die Lizenzvereinbarung ken-
nen und mit deren Bestimmungen einverstanden sind. 

1. Metrohm gewährt Ihnen das nicht übertragbare und nicht 
ausschliessliche Recht, die Software in Verbindung mit 
Metrohm-Analysengeräten einzusetzen. 

2. Die Urheberrechte an der Software verbleiben bei Metrohm 
oder einem Lizenzgeber von Metrohm. Hinweise auf vertrauli-
che Behandlung, Eigentumsvermerke oder Urheberrechts-
vermerke dürfen von Ihnen weder verändert noch entfernt 
werden. Sie dürfen die Software weder verkaufen, noch ver-
mieten oder an Dritte sonst wie weitergeben, es sei denn für 
den Gebrauch mit Analysengeräten der Metrohm-Gruppe 
und falls der Dritte die Bestimmungen dieser Lizenzverein-
barung ausdrücklich akzeptiert. Nicht gestattet ist sodann 
das Verändern und das Kopieren der Software als Ganzes 
und in Teilen. Zulässig ist nur die Erstellung einer Kopie zu 
Back-up-Zwecken. 

3. Die Lizenzgebühr für die beschriebene Nutzung ist im Kauf-
preis des Analysengeräts inbegriffen oder wird bei separater 
Abgabe der Software mit dieser in Rechnung gestellt. Sollten 
Sie den Kaufpreis oder die Lizenzgebühr aus irgendeinem 
Grunde bei Fälligkeit nicht vollumfänglich bezahlen, erlischt 
das Nutzungsrecht an der Software und Metrohm kann deren 
Rückgabe oder deren Löschung in Ihrem System verlangen. 

4. Metrohm bietet Ihnen Gewähr dafür, dass sich die Software 
beim ordnungsgemässen Betrieb zum angebotenen Einsatz 
mit Analysengeräten der Metrohm-Gruppe eignet und dass 
die Software ordnungsgemäss auf dem Datenträger gespei-
chert ist. Trifft dies nicht zu, können Sie von Metrohm und/ 
oder ihrer Vertriebsgesellschaft verlangen, dass Ihnen gegen 
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Rückgabe der beanstandeten eine neue einwandfreie Soft-
ware zur Verfügung gestellt wird. Diese Gewährleistung rich-
tet sich ausschliesslich an den Erstbetreiber der Software. 

5. Jede weitergehende Gewährleistung und Haftung wird von 
Metrohm und ihrer Vertriebsgesellschaft ausgeschlossen. 
Metrohm und ihre Vertriebsgesellschaft haften insbesondere 
weder für Drittschäden oder Folgeschäden, Datenverluste, 
entgangenen Gewinn, Betriebsunterbruch etc. 

6. Diese Vereinbarung gilt bis sie beendet wird. Sie können die-
se Vereinbarung beenden, indem Sie die Software sowie jede 
Kopie davon vernichten. Die Vereinbarung wird ausserdem 
beendet, wenn Sie gegen eine ihrer Bestimmungen verstos-
sen. Auch in diesem Fall müssen Sie die Software sowie jede 
Kopie vernichten, wobei Metrohm zudem das Recht hat, dies 
von Ihnen ausdrücklich zu verlangen. 

7. Änderungen und Ergänzungen dieser Vereinbarung bedürfen 
der Schriftform. Das Schrifterfordernis gilt auch für eine Ände-
rung dieser Bestimmung. Sollten Teile dieser Vereinbarung 
nichtig oder rechtsunwirksam sein oder werden, gilt der Rest 
der Vereinbarung weiter. Die Vereinbarung ist dann so auszu-
legen und anzuwenden, dass der mit dem unwirksamen Teil 
angestrebte Zweck dennoch so weit als möglich erreicht wird. 

8. Gerichtsstand: Für die Beurteilung allfälliger Streitigkeiten aus 
dieser Vereinbarung sind die Gerichte am Sitz der Metrohm 
AG zuständig. Metrohm kann auch den Gerichtsstand am 
Sitz des Beklagten beanspruchen. 

 



11  Anhang 
 

IC Net 2.2 228 

11.2 Konformitätserklärung – Softwarevali-
dierung 

Die Software "Metrodata IC Net 2.2" wurde in Bezug auf Design, 
Test und Unterhalt gemäss den Anforderungen des Qualitätssys-
tems ISO 9001 entwickelt. Die Vorgehensweise bei der Pro-
grammentwicklung ist im Dokument "Project procedure for crea-
ting Metrodata software" (in Englisch) beschrieben, das bei 
Metrohm auf Anfrage erhältlich ist. 

Die Software wurde in Bezug auf Funktionalität sowie Richtigkeit 
und Genauigkeit der Resultate validiert. Die technischen Spezifi-
kationen und die Softwarefunktionen sind in der Gebrauchsan-
weisung beschrieben. 

Herisau, 24. Februar 2003 

      
 

Dr. J. Frank Ch. Buchmann 
 
Leiter Entwicklung Leiter Produktion und 
 Beauftragter Qualitätssicherung 
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US Pharmacopoeia ................................................152 
Use method from file for reprocessing .....................216 
Use peristaltic pump ................................................68 
Used ....................................................................170 
User ................................................................17,143 
User comments .......................................................22 
User List .................................................................16 
User Name ........................................................7,15 
<User name> .......................................................203 

V 
Value....................................................................157 
Valve ............................................................63,66,75 
Valve A ............................................................83,107 
Valve B .....................................................83,107,110 
Valve position........................................................117 
Valve position for rinse...........................................117 
ValveA ........................................................59,85,108 
ValveB ........................................................59,85,108 
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Verdünnung ............................. 30,144,162,213,223 
Verify sample .......................................................... 29 
<Verify> .....................................43,58,66,85,96,99, 

.......................................... 102,105,108,111,114 
Verzeichnis......................................................... 190 
Vial ........................................................ 210,213,223 
Vial number .............................................. 30,117,144 
Vial position................................................... 123,132 
View all ......................................................... 194,197 
Void time ....................................................... 152,162 
Void time/volume .................................................. 152 
Void volume................................................... 145,152 
Volume................................30,144,162,211,213,223 
Volumen ............................................................. 167 
Volumen der leeren Trennsäule......................... 145 

W 
Wahl des Druckers ............................................ 201 
Wait .............................................................. 125,134 
Waiting................................................................. 188 
Waiting for INJECT .................................................. 34 
Warnung................................................................. 3 
Wartezeit ............................................................ 148 
Watch window 

Anzeige........................................................... 52 
Einstellungen .................................................. 52 
Farbeinstellungen........................................... 53 
Symbol............................................................ 52 

WATCH WINDOW .................................................... 31 
while running every ... min...................................... 150 
Width ............................................................ 154,160 
Will be executed by ................................................. 58 
Wind.%................................................................. 164 
Worst case............................................................ 167 
Write in new file .................................................... 221 

X 
X from .................................................................. 193 
X full scale............................................................ 197 
X to...................................................................... 193 
X units.................................................................. 194 

Y 
Y from .................................................................. 194 
Y full scale............................................................ 197 
Y to...................................................................... 194 

Z 
Zeichensatz........................................................ 182 
Zeilennummer ............................... 164,210,212,223 

Zeit ......................................................... 30,143,145 
Zeitachse ........................................................... 193 
Zeitprogramm 

Report ............................................................. 32 
Zeitschaltuhr 

Globale Zeitschaltuhr ..................................... 48 
System-Zeitschaltuhr.................................... 141 

Zellkonstante........................................................ 70 
Zero................................................................ 59,178 
Zero <OFF> ........................................................... 56 
Zero <ON> ............................................................ 56 
Zoom.................................................................... 13 
Zugriffsstufe .................................................... 16,17 
Zugriffsstufen ....................................................... 15 


	Inhaltsverzeichnis
	1 Einleitung
	1.1 Programmbeschreibung
	1.2 Angaben zur Gebrauchsanweisung
	1.3 Notation und Piktogramme
	1.4 Installation
	1.4.1 Hardware-Voraussetzungen für den PC
	1.4.2 Software-Installation
	1.4.3 Software-Update
	1.4.4 Software-Deinstallation
	1.4.5 Demoversion
	1.4.6 Registrierung


	2 Grundlagen der Bedienung
	2.1 Programm starten und beenden
	2.1.1 Programm «IC Net» starten
	2.1.2 Programm «IC Net» beenden

	2.2 Begriffe
	2.3 Übersicht über die Programmfenster
	2.4 Elemente des Hauptfensters
	2.5 Symbole des Hauptfensters
	2.6 Übersicht über die Dateitypen
	2.7 Kontext-sensitive Menüs
	2.8 Funktionen von Tastatur und Maus
	2.9 Hilfe

	3 Softwareeinstellungen
	3.1 Schriften
	3.2 Sicherheitssystem
	3.2.1 Fenster Security Options

	3.3 Audit Trail
	3.4 Globale Einstellungen

	4 Systeme
	4.1 Systemerstellung
	4.1.1 Assistent zur Systemerstellung
	4.1.2 Systemfenster
	4.1.3 Geräte zu einem bestehenden Fenster hinzufügen

	4.2 Systemverwaltung
	4.3 Systemfunktionen
	4.3.1 System verbinden und trennen
	4.3.2 Hardware starten/stoppen und Basislinie aufzeichnen
	4.3.3 Bestimmungen starten/stoppen
	4.3.4 Optionen für Bestimmungen

	4.4 Systemeinstellungen
	4.4.1 Systemfenster verändern
	4.4.2 Messwertanzeige einschalten
	4.4.3 Startmodus festlegen
	4.4.4 Neue Geräte installieren
	4.4.5 Bestehende Geräte installieren
	4.4.6 Systemparameter ausdrucken
	4.4.7 Systemparameter anzeigen
	4.4.8 Links

	4.5 Systemstatusfenster
	4.5.1 Statusmeldungen
	4.5.2 Fehlermeldungen
	4.5.3 Fehlermeldungen für 761 Compact IC


	5 Interfaces
	5.1 Interface-Installation
	5.1.1 Interfaces mit Systemassistent hinzufügen
	5.1.2 Interfaces im Fenster "Workplace" hinzufügen
	5.1.3 Interfaces löschen

	5.2 762 IC Interface
	5.2.1 Allgemeines zum 762 IC Interface
	5.2.2 762-Gerätesymbol auf der Symbolleiste
	5.2.3 762-Gerätesymbole im Systemfenster
	5.2.4 Fenster "762 IC Interface"
	5.2.5 762 Ereignisausgangsleitungen

	5.3 771 Compact Interface
	5.3.1 Allgemeines zum 771 Compact Interface
	5.3.2 771 Gerätesymbol auf der Symbolleiste
	5.3.3 Fenster "771 Compact Interface"

	5.4 Metrohm PC Board
	5.5 Globale Zeitschaltuhr
	5.5.1 Zeitschaltuhrsymbol
	5.5.2 Zeitschaltuhrprogramm


	6 Geräte
	6.1 Geräteinstallation
	6.1.1 Geräte bei der Systemerstellung hinzufügen
	6.1.2 Neue Geräte im Systemfenster hinzufügen
	6.1.3 Bereits vorhandene Geräte im Systemfenster hinzufügen
	6.1.4 Geräte löschen

	6.2 Messwertanzeige (Watch window)
	6.2.1 Symbol für Watch window
	6.2.2 Einstellungen für Watch window

	6.3 732 IC Detector
	6.3.1 Allgemeines zum 732 IC Detector
	6.3.2 Symbol für 732 IC Detector
	6.3.3 Fenster "732 IC Detector"

	6.4 761 Compact IC
	6.4.1 Allgemeines zum 761 Compact IC
	6.4.2 761-Gerätesymbol
	6.4.3 Fenster "761 Compact IC"
	6.4.4 Hardwareeinstellungen

	6.5 817 Bioscan
	6.5.1 Allgemeines zum 817 Bioscan
	6.5.2 817-Gerätesymbol
	6.5.3 Fenster "817 Bioscan"

	6.6 733 IC Separation Center
	6.6.1 Allgemeines zum 733 IC Separation Center
	6.6.2 Symbol für 733 IC Separation Center
	6.6.3 Fenster "733 IC Separation Center"

	6.7 709 IC Pump
	6.7.1 Allgemeines zur 709 IC Pump
	6.7.2 Symbol für 709 IC Pump
	6.7.3 Fenster "709 IC Pump"

	6.8 Metrohm solvent delivery unit
	6.8.1 Allgemeines zur Metrohm SDU
	6.8.2 Symbol für Metrohm SDU
	6.8.3 Fenster "Metrohm SDU"

	6.9 752 Pump Unit
	6.9.1 Allgemeines zur 752 Pump Unit
	6.9.2 Symbol für 752 Pump Unit
	6.9.3 Fenster "752 Pump Unit"

	6.10 753 Suppressor Module
	6.10.1 Allgemeines zum 753 Suppressor Module
	6.10.2 Symbol für 753 Suppressor Module
	6.10.3 Fenster "753 Suppressor Module"

	6.11 754 Dialysis Unit
	6.11.1 Allgemeines zur 754 Dialysis Unit
	6.11.2 Symbol für 754 Dialysis Unit
	6.11.3 Fenster "754 Dialysis Unit"

	6.12 793 Sample Prep Module
	6.12.1 Allgemeines zum 793 Sample Prep Module
	6.12.2 Symbol für 793 Sample Prep Module
	6.12.3 Fenster "793 Sample Prep Module"

	6.13 812 Valve Unit
	6.13.1 Allgemeines zur 812 Valve Unit
	6.13.2 Symbol für 812 Valve Unit
	6.13.3 Fenster "812 Valve Unit"

	6.14 816 IC Eluent Selector
	6.14.1 Allgemeines zum 816 IC Eluent Selector
	6.14.2 Symbol für 816 IC Eluent Selector
	6.14.3 Fenster "816 IC Eluent Selector"

	6.15 828 IC Dual Suppressor
	6.15.1 Allgemeines zum 828 IC Dual Suppressor
	6.15.2 Symbol für 828 IC Dual Suppressor
	6.15.3 Fenster "828 IC Dual Suppressor"

	6.16 750 Autosampler
	6.16.1 Allgemeines zum 750 Autosampler
	6.16.2 Symbol für 750 Autosampler
	6.16.3 Fenster "750 Autosampler"

	6.17 766 IC Sample Processor
	6.17.1 Allgemeines zum 766 IC Sample Processor
	6.17.2 Symbol für 766 IC Sample Processor
	6.17.3 Fenster "766 IC Sample Processor"

	6.18 788 IC Filtration Sample Processor
	6.18.1 Allgemeines zum 788 IC Filtration Sample Processor
	6.18.2 Symbol für 788 IC Filtration Sample Processor
	6.18.3 Fenster "788 IC Filtration Sample Processor"

	6.19 Datenaufzeichner
	6.19.1 Symbol für Datenaufzeichner
	6.19.2 Prozessmethode und Datenquelle auswählen

	6.20 System-Zeitschaltuhr
	6.20.1 Symbol der Zeitschaltuhr
	6.20.2 Programm der Zeitschaltuhr


	7 Methoden
	7.1 Methoden verwalten
	7.2 Passport
	7.2.1 General
	7.2.2 Sample
	7.2.3 Column
	7.2.4 Eluent
	7.2.5 Comment

	7.3 Method setup
	7.3.1 General
	7.3.2 Measure
	7.3.3 Filters
	7.3.4 Processing
	7.3.5 Math

	7.4 Integration
	7.4.1 Allgemeines
	7.4.2 Setup
	7.4.3 Events

	7.5 Kalibrierung und Konzentrationsberechnung
	7.5.1 Allgemeines
	7.5.2 Notationen
	7.5.3 Externe Standardkalibrierung
	7.5.4 Komponententabelle
	7.5.5 Peakidentifikation
	7.5.6 Konzentrationstabelle
	7.5.7 Kalibrierkurve
	7.5.8 Kalibrierung aktualisieren
	7.5.9 Kalibrierdaten verwalten

	7.6 Reportausgabe
	7.6.1 Report options
	7.6.2 Items to report
	7.6.3 More items to report
	7.6.4 Report destination
	7.6.5 Peak table
	7.6.6 Template options
	7.6.7 File output options
	7.6.8 Reportelemente


	8 Chromatogramme
	8.1 Chromatogrammfenster
	8.2 Chromatogramme verwalten
	8.2.1 Chromatogramme öffnen
	8.2.2 Chromatogramme speichern
	8.2.3 Chromatogramme schliessen
	8.2.4 Chromatogramme löschen
	8.2.5 Chromatogramme exportieren
	8.2.6 Chromatogramme importieren

	8.3 Grafische Darstellung
	8.3.1 Appearance
	8.3.2 Weitere grafische Funktionen

	8.4 Peak-Editor
	8.4.1 Ein-/Ausschalten des Peak-Editors
	8.4.2 Funktionen des Peak-Editors
	8.4.3 Verschieben des Cursors

	8.5 Drucken
	8.5.1 Seiteneinstellungen für den Druck
	8.5.2 Druckereinstellungen
	8.5.3 Druckvorschau
	8.5.4 Drucken

	8.6 Diverse Funktionen
	8.6.1 Neuintegration
	8.6.2 Neukalibrierung
	8.6.3 Elektronische Unterschrift
	8.6.4 Subtraktion eines Chromatogramms
	8.6.5 Chromatogramm vergleichen
	8.6.6 Datenkomprimierung
	8.6.7 Chromatogramm invertieren
	8.6.8 Autodatabase


	9 Probentabellen
	9.1 Probentabellen verwalten
	9.1.1 Probentabelle öffnen
	9.1.2 Probentabelle speichern
	9.1.3 Probentabelle löschen

	9.2 Probentabellen verwenden
	9.2.1 Übersichtsfenster für Probentabelle
	9.2.2 Probentabelle starten
	9.2.3 Probentabelle anhalten
	9.2.4 Letzte Bestimmung widerrufen
	9.2.5 Probentabelle zurücksetzen

	9.3 Probentabellen bearbeiten
	9.3.1 Editorfenster öffnen
	9.3.2 Funktionen im Editorfenster
	9.3.3 Probentabelle ausdrucken
	9.3.4 Editorfenster schliessen


	10 Nachbearbeitung
	10.1 Nachbearbeitungstabellen verwalten
	10.1.1 Nachbearbeitungstabelle öffnen
	10.1.2 Neue Nachbearbeitungstabelle erstellen
	10.1.3 Nachbearbeitungstabelle speichern

	10.2 Nachbearbeitung durchführen
	10.2.1 Übersichtsfenster für Nachbearbeitungstabelle
	10.2.2 Chromatogramme kombinieren

	10.3 Nachbearbeitungstabellen bearbeiten
	10.3.1 Editorfenster öffnen
	10.3.2 Funktionen im Editorfenster
	10.3.3 Nachbearbeitungstabelle ausdrucken
	10.3.4 Editorfenster schliessen


	11 Anhang
	11.1 Softwarelizenzvereinbarung
	11.2 Konformitätserklärung – Softwarevalidierung
	11.3 Lieferumfang
	11.3 Index




